vCenter Server and Host Management

Update 1
ESXi 5.0
vCenter Server 5.0

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
Contents

About VMware vCenter Server™ and Host Management 7

Updated Information 9

1 vSphere Concepts and Features 11
   Virtualization Basics 11
   Physical Topology of vSphere Datacenter 12
   vSphere Software Components 13
   vSphere Managed Inventory Objects 15
   Optional vCenter Server Components 17
   vCenter Server Plug-Ins 18

2 vSphere Client Interfaces 19
   Start the vSphere Client and Log In 20
   Stop the vSphere Client and Log Out 20
   Register a vCenter Server System with the vSphere Web Client 20
   Log in to vCenter Server using the vSphere Web Client 21
   Log Out of vCenter Server Using the vSphere Web Client 22

3 Using the vSphere Client 23
   Getting Started Tabs 23
   Status Bar, Recent Tasks, and Triggered Alarms 24
   Panel Sections 24
   View Virtual Machine Console 25
   Searching the vSphere Inventory 25
   Using Lists 26
   Custom Attributes 27
   Select Objects 28
   Manage vCenter Server Plug-Ins 29
   Save vSphere Client Data 30
   Working with Active Sessions 30

4 Configuring Hosts and vCenter Server 33
   Host Configuration 33
   Configuring vCenter Server 33
   Configuring the VMware vCenter Server Appliance 43
   Configuring Communication Among ESXi, vCenter Server, and the vSphere Client 50

5 Using vCenter Server in Linked Mode 51
   Linked Mode Prerequisites for vCenter Server 51
   Linked Mode Considerations for vCenter Server 52
Join a Linked Mode Group After Installation 53
Reconciling Roles When Connecting vCenter Server to a Linked Mode Group 54
Isolate a vCenter Server Instance from a Linked Mode Group 54
Change the Domain of a vCenter Server System in a Linked Mode Group 54
Configure the URLs on a Linked Mode vCenter Server System 55
Monitor vCenter Server Services 55

6 Organizing Your Inventory 57
Create Datacenters 58
Add Hosts 58
Create Clusters 59
Create Resource Pools 60
Create a Resource Pool in the vSphere Web Client 60
Create a Folder in the vSphere Web Client 61
Create Datastores 61
Create Host-Wide Networks 62
Create Datacenter-Wide Networks 63

7 License Management and Reporting 67
Licensing Terminology and Definitions 68
Licensing for ESXi 5.0 Hosts 69
Licensing for vCenter Server 5.0 72
Solution Licensing 72
Licensing ESXi Hosts and vCenter Server After Upgrade 73
vCenter Server License Inventory 73
License Management Permissions 74
About the License Portal 74
Managing Licenses 75
Viewing License Use 81

8 System Log Files 89
View System Log Entries 89
View System Logs on an ESXi Host 89
External System Logs 90
Export System Log Files 90
Configure Syslog on ESXi Hosts 91
Collecting Log Files 92

9 Working with Tasks and Events 95
Managing Tasks 95
Managing Events 101
Report Errors to VMware 104

10 Starting and Stopping the vSphere Components 105
Start an ESXi Host 105
Reboot or Shut Down an ESXi Host 105
Starting vCenter Server 106
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Managing Hosts in vCenter Server</td>
</tr>
<tr>
<td></td>
<td>Disconnecting and Reconnecting a Host</td>
</tr>
<tr>
<td></td>
<td>Remove a Host from a Cluster</td>
</tr>
<tr>
<td></td>
<td>Understanding Managed Host Removal</td>
</tr>
<tr>
<td></td>
<td>Remove a Managed Host from vCenter Server</td>
</tr>
<tr>
<td>12</td>
<td>Migrating Virtual Machines</td>
</tr>
<tr>
<td></td>
<td>Cold Migration</td>
</tr>
<tr>
<td></td>
<td>Migrating a Suspended Virtual Machine</td>
</tr>
<tr>
<td></td>
<td>Migration with vMotion</td>
</tr>
<tr>
<td></td>
<td>Migration with Storage vMotion</td>
</tr>
<tr>
<td></td>
<td>CPU Compatibility and EVC</td>
</tr>
<tr>
<td></td>
<td>About Migration Compatibility Checks</td>
</tr>
<tr>
<td></td>
<td>Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Client</td>
</tr>
<tr>
<td></td>
<td>Migrate a Powered-On Virtual Machine with vMotion in the vSphere Client</td>
</tr>
<tr>
<td></td>
<td>Migrate a Virtual Machine with Storage vMotion in the vSphere Client</td>
</tr>
<tr>
<td></td>
<td>Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Web Client</td>
</tr>
<tr>
<td></td>
<td>Migrate a Powered-On Virtual Machine with vMotion in the vSphere Web Client</td>
</tr>
<tr>
<td></td>
<td>Migrate a Virtual Machine with Storage vMotion in the vSphere Web Client</td>
</tr>
<tr>
<td></td>
<td>Storage vMotion Command-Line Syntax</td>
</tr>
<tr>
<td></td>
<td>Limits on Simultaneous Migrations</td>
</tr>
<tr>
<td>13</td>
<td>Using vCenter Maps</td>
</tr>
<tr>
<td></td>
<td>Set the Maximum Number of Map Objects</td>
</tr>
<tr>
<td></td>
<td>vCenter vMotion Maps</td>
</tr>
<tr>
<td></td>
<td>vCenter Map Icons and Interface Controls</td>
</tr>
<tr>
<td></td>
<td>View vCenter Maps</td>
</tr>
<tr>
<td></td>
<td>Print vCenter Maps</td>
</tr>
<tr>
<td></td>
<td>Export vCenter Maps</td>
</tr>
<tr>
<td></td>
<td>Index</td>
</tr>
</tbody>
</table>
About VMware vCenter Server™ and Host Management

vCenter Server and Host Management describes how to start and stop the VMware® vSphere Client components, build your vSphere environment, monitor and manage the information generated about the components, and set up roles and permissions for users and groups using the vSphere environment.

In addition, vCenter Server and Host Management provides brief introductions to the various tasks you can perform within the system as well as cross-references to the documentation that describes all the tasks in detail.

vCenter Server and Host Management covers ESXi and vCenter Server.

Intended Audience

vCenter Server and Host Management is intended for system administrators who are experienced Windows or Linux system administrators and who are familiar with virtual machine technology and datacenter operations.
Updated Information

This vCenter Server and Host Management documentation is updated with each release of the product or when necessary.

This table provides the update history of the vCenter Server and Host Management documentation.

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000775-01</td>
<td>Removed obsolete options for import and export of virtual machines in “Schedule Tasks,” on page 97.</td>
</tr>
<tr>
<td>000775-00</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>
VMware vSphere™ leverages the power of virtualization to transform datacenters into simplified cloud computing infrastructures and enables IT organizations to deliver flexible and reliable IT services.

The two core components of vSphere are VMware ESXi™ and VMware vCenter Server™. ESXi is the virtualization platform on which you create and run virtual machines. vCenter Server is a service that acts as a central administrator for ESXi hosts that are connected on a network. vCenter Server allows you to pool and manage the resources of multiple hosts. vCenter Server provides many features that allow you to monitor and manage your physical and virtual infrastructure.

Additional vSphere components are available as plugins that extend the functionality of the vSphere product.

This chapter includes the following topics:

- “Virtualization Basics,” on page 11
- “Physical Topology of vSphere Datacenter,” on page 12
- “vSphere Software Components,” on page 13
- “vSphere Managed Inventory Objects,” on page 15
- “Optional vCenter Server Components,” on page 17
- “vCenter Server Plug-Ins,” on page 18

**Virtualization Basics**

A virtual machine is a software computer that, like a physical computer, runs an operating system and applications. The hypervisor serves as a platform for running virtual machines and allows for the consolidation of computing resources.

Each virtual machine contains its own virtual, or software-based, hardware, including a virtual CPU, memory, hard disk, and network interface card.

Software called the hypervisor is installed on the physical hardware in a virtualized datacenter, and acts as a platform for virtual machines. ESXi is the hypervisor in a vSphere environment. The hypervisor provides physical hardware resources dynamically to virtual machines as needed to support the operation of the virtual machines. The hypervisor allows virtual machines to operate with a degree of independence from the underlying physical hardware. For example, a virtual machine can be moved from one physical host to another, or its virtual disks can be moved from one type of storage to another, without affecting the functioning of the virtual machine.
Because virtual machines are decoupled from specific underlying physical hardware, virtualization allows you to consolidate physical computing resources such as CPUs, memory, storage, and networking into pools of resources that can be dynamically and flexibly made available to virtual machines. With appropriate management software, such as vCenter Server, you can also use a number of features that increase the availability and security of your virtual infrastructure.

Physical Topology of vSphere Datacenter

A typical VMware vSphere datacenter consists of basic physical building blocks such as x86 virtualization servers, storage networks and arrays, IP networks, a management server, and desktop clients.

The vSphere datacenter topology includes the following components.

Compute servers

Industry standard x86 servers that run ESXi on the bare metal. ESXi software provides resources for and runs the virtual machines. Each computing server is referred to as a standalone host in the virtual environment. You can group a number of similarly configured x86 servers with connections to the same network and storage subsystems to provide an aggregate set of resources in the virtual environment, called a cluster.

Storage networks and arrays

Fibre Channel SAN arrays, iSCSI SAN arrays, and NAS arrays are widely used storage technologies supported by VMware vSphere to meet different datacenter storage needs. The storage arrays are connected to and shared between groups of servers through storage area networks. This arrangement allows aggregation of the storage resources and provides more flexibility in provisioning them to virtual machines.

IP networks

Each compute server can have multiple physical network adapters to provide high bandwidth and reliable networking to the entire VMware vSphere datacenter.

vCenter Server

vCenter Server provides a single point of control to the datacenter. It provides essential datacenter services such as access control, performance monitoring, and configuration. It unifies the resources from the individual computing servers to be shared among virtual machines in the entire datacenter. It does this by managing the assignment of virtual machines to the computing servers and the assignment of resources to the virtual machines within a given computing server based on the policies that the system administrator sets.

Computing servers continue to function even in the unlikely event that vCenter Server becomes unreachable (for example, if the network is severed). Servers can be managed separately and continue to run the virtual machines assigned to them based on the resource assignment that was last set. After connection to vCenter Server is restored, it can manage the datacenter as a whole again.

Management clients

VMware vSphere provides several interfaces for datacenter management and virtual machine access. These interfaces include VMware vSphere Client (vSphere Client), vSphere Web Client for access through a web browser, or vSphere Command-Line Interface (vSphere CLI).
vSphere Software Components

VMware vSphere is a suite of software components for virtualization. These include ESXi, vCenter Server, and other software components that fulfill a number of different functions in the vSphere environment.

vSphere includes the following software components:

**ESXi**

A virtualization platform that you use to create the virtual machines as a set of configuration and disk files that together perform all the functions of a physical machine.

Through ESXi, you run the virtual machines, install operating systems, run applications, and configure the virtual machines. Configuration includes identifying the virtual machine’s resources, such as storage devices.

The server provides bootstrapping, management, and other services that manage your virtual machines.

Each ESXi host has a vSphere Client available for your management use. If your ESXi host is registered with vCenter Server, a vSphere Client that accommodates vCenter Server features is available.

**vCenter Server**

A service that acts as a central administrator for VMware ESXi hosts that are connected on a network. vCenter Server directs actions on the virtual machines and the virtual machine hosts (the ESXi hosts).
vCenter Server is a single Windows Service and is installed to run automatically. vCenter Server runs continuously in the background. It performs its monitoring and managing activities even when no vSphere Clients are connected and when no one is logged on to the computer where it resides. It must have network access to all the hosts it manages and be available for network access from any machine where the vSphere Client is run.

You can install vCenter Server in a Windows virtual machine on an ESXi host, allowing it to take advantage of the high-availability that is provided by VMware HA. See the vSphere Installation and Setup documentation for details about setting up this configuration.

You can join multiple vCenter Server systems using Linked Mode to allow them to be managed using a single vSphere Client connection.

vCenter Server plug-ins
Applications that provide additional features and functionality to vCenter Server. Typically, plug-ins consist of a server component and a client component. After the plug-in server is installed, it is registered with vCenter Server and the plug-in client is available to vSphere clients for download. After a plug-in is installed on a vSphere client, it might alter the interface by adding views, tabs, toolbar buttons, or menu options related to the added functionality.

Plug-ins leverage core vCenter Server capabilities, such as authentication and permission management, but can have their own types of events, tasks, metadata, and privileges.

Some vCenter Server features are implemented as plug-ins, and can be managed using the vSphere Client Plug-in Manager. These features include vCenter Storage Monitoring, vCenter Hardware Status, and vCenter Service Status.

vCenter Server database
A persistent storage area for maintaining the status of each virtual machine, host, and user managed in the vCenter Server environment. The vCenter Server database can be remote or local to the vCenter Server system.

The database is installed and configured during vCenter Server installation.

If you are accessing your ESXi host directly through a vSphere Client, and not through a vCenter Server system and associated vSphere Client, you do not use a vCenter Server database.

Tomcat Web server
Many vCenter Server functions are implemented as Web services that require the Tomcat Web server. The Tomcat Web server is installed on the vCenter Server machine as part of the vCenter Server installation.

Features that require the Tomcat Web server to be running include: Linked Mode, CIM/Hardware Status tab, Performance charts, WebAccess, vCenter Storage Monitoring/Storage Views tab, and vCenter Service status.

vCenter Server agent
On each managed host, the software that collects, communicates, and executes the actions received from vCenter Server. The vCenter Server agent is installed the first time any host is added to the vCenter Server inventory.
Host agent
On each managed host, the software that collects, communicates, and executes the actions received through the vSphere Client. It is installed as part of the ESXi installation.

LDAP
vCenter Server uses LDAP (Lightweight Directory Access Protocol) to synchronize data such as license and role information across vCenter Server systems joined in Linked Mode.

vSphere Managed Inventory Objects
In vSphere, the inventory is a collection of virtual and physical objects on which you can place permissions, monitor tasks and events, and set alarms. You can group most inventory objects by using folders to more easily manage them.

All inventory objects, with the exception of hosts, can be renamed to represent their purposes. For example, they can be named after company departments or locations or functions. vCenter Server monitors and manages the following components of your virtual and physical infrastructure:

Clusters
A collection of ESXi hosts and associated virtual machines intended to work together as a unit. When you add a host to a cluster, the host’s resources become part of the cluster’s resources. The cluster manages the resources of all hosts.

If you enable VMware EVC on a cluster, you can ensure that migrations with vMotion do not fail because of CPU compatibility errors. If you enable vSphere DRS on a cluster, the resources of the hosts in the cluster are merged to allow resource balancing for the hosts in the cluster. If you enable vSphere HA on a cluster, the resources of the cluster are managed as a pool of capacity to allow rapid recovery from host hardware failures.

Datacenters
Unlike a folder, which is used to organize a specific object type, a datacenter is an aggregation of all the different types of objects needed to do work in virtual infrastructure: hosts, virtual machines, networks, and datastores.

Within a datacenter there are four separate hierarchies:
- Virtual machines (and templates)
- Hosts (and clusters)
- Networks
- Datastores

The datacenter defines the namespace for networks and datastores. The names for these objects must be unique within a datacenter. For example, you cannot have two datastores with the same name within a single datacenter, but you can have two datastores with the same name in two different datacenters.

Virtual machines, templates, and clusters need not be unique within the datacenter, but must be unique within their folder.

Objects with the same name in two different datacenters are not necessarily the same object. Because of this, moving objects between datacenters can create unpredictable results. For example, a network named networkA in datacenterA might not be the same network as a network named networkA in datacenterB. Moving a virtual machine connected to networkA from datacenterA to datacenterB results in the virtual machine changing the network it is connected to.
**Datastores**

A virtual representation of underlying physical storage resources in the datacenter. A datastore is the storage location for virtual machine files. These physical storage resources can come from the local SCSI disk of the ESXi host, the Fibre Channel SAN disk arrays, the iSCSI SAN disk arrays, or Network Attached Storage (NAS) arrays. Datastores hide the idiosyncrasies of the underlying physical storage and present a uniform model for the storage resources required by virtual machines.

**Folders**

Folders allow you to group objects of the same type so you can easily manage them. For example, you can use folders to set permissions across objects, to set alarms across objects, and to organize objects in a meaningful way.

A folder can contain other folders, or a group of objects of the same type: datacenters, clusters, datastores, networks, virtual machines, templates, or hosts. For example, one folder can contain hosts and a folder containing hosts, but it cannot contain hosts and a folder containing virtual machines.

Datacenter folders form a hierarchy directly under the root vCenter Server and allow users to group their datacenters in any convenient way. Within each datacenter is one hierarchy of folders with virtual machines and templates, one with hosts and clusters, one with datastores, and one with networks.

**Hosts**

The physical computer on which ESXi is installed. All virtual machines run on hosts. If the vSphere Client is connected directly to an ESXi host, only that host is available for management.

**Networks**

A set of virtual network interface cards (virtual NICs), distributed switches or vSphere Distributed Switches, and port groups or distributed port groups that connect virtual machines to each other or to the physical network outside of the virtual datacenter. All virtual machines that connect to the same port group belong to the same network in the virtual environment, even if they are on different physical servers. You can monitor networks and set permissions and alarms on port groups and distributed port groups.

**Resource pools**

Resource pools are used to compartmentalize the CPU and memory resources of a host or cluster. Virtual machines execute in, and draw their resources from, resource pools. You can create multiple resource pools as direct children of a standalone host or cluster and then delegate control over them to other individuals or organizations.

vCenter Server provides, through the DRS components, various options in monitoring the status of the resources and adjusting or suggesting adjustments to the virtual machines using the resources. You can monitor resources and set alarms on them.

**Templates**

A master copy of a virtual machine that can be used to create and provision new virtual machines. Templates can have a guest operating system and application software installed, and can be customized during deployment to ensure that the new virtual machine has a unique name and network settings.

**Virtual machines**

A virtualized computer environment in which a guest operating system and associated application software can run. Multiple virtual machines can operate on the same managed host machine concurrently.

**vApps**

vSphere vApp is a format for packaging and managing applications. A vApp can contain multiple virtual machines.
Optional vCenter Server Components

Optional vCenter Server components are packaged and installed with the base product, but might require a separate license.

Optional vCenter Server features include:

vMotion  A feature that enables you to move running virtual machines from one ESXi host to another ESXi host without service interruption. It requires licensing on both the source and target host. vCenter Server centrally coordinates all vMotion activities.

Storage vMotion  A feature that allows you to move the disks and configuration file of a running virtual machine from one datastore to another without service interruption. It requires licensing on the virtual machine’s host.

vSphere HA  A feature that enables a cluster with High Availability. If a host goes down, all virtual machines that were running on the host are promptly restarted on different hosts in the same cluster.

When you enable the cluster for vSphere HA, you specify the number of hosts you want to be able to recover. If you specify the number of host failures allowed as 1, vSphere HA maintains enough capacity across the cluster to tolerate the failure of one host. All running virtual machines on that host can be restarted on remaining hosts. By default, you cannot turn on a virtual machine if doing so violates required failover capacity. See the vSphere Availability documentation for more information.

vSphere DRS  A feature that helps improve resource allocation and power consumption across all hosts and resource pools. vSphere DRS collects resource usage information for all hosts and virtual machines in the cluster and gives recommendations (or migrates virtual machines) in one of two situations:

- Initial placement – When you first power on a virtual machine in the cluster, DRS either places the virtual machine or makes a recommendation.
- Load balancing – DRS attempts to improve resource utilization across the cluster by performing automatic migrations of virtual machines (vMotion) or by providing a recommendation for virtual machine migrations.

vSphere DRS includes distributed power management (DPM) capabilities. When DPM is enabled, the system compares cluster-level and host-level capacity to the demands of virtual machines running in the cluster. Based on the results of the comparison, DPM recommends (or implements) actions that can reduce the power consumption of the cluster.

Storage DRS  A feature that enables you to manage multiple datastores as a single compute resource, called a datastore cluster. A datastore cluster is an aggregation of multiple datastores into a single logical, load-balanced pool. You can treat the datastore cluster as a single flexible storage resource for resource management purposes. You can assign a virtual disk to a datastore cluster, and Storage DRS
finds an appropriate datastore for it. The load balancer takes care of initial placement and future migrations based on workload measurements. Storage space balancing and I/O balancing minimize the risk of running out of space and the risk of I/O bottlenecks slowing the performance of virtual machines.

**vSphere Fault Tolerance**

vSphere Fault Tolerance provides continuous availability for virtual machines by creating and maintaining a Secondary VM that is identical to, and continuously available to replace, the Primary VM in the event of a failover situation.

**vCenter Server Plug-Ins**

vCenter Server plug-ins extend the capabilities of vCenter Server by providing more features and functions. Some plug-ins are installed as part of the base vCenter Server product.

- **vCenter Storage Monitoring**
  
  Allows you to review information on storage usage and to visually map relationships between all storage entities available in vCenter Server.

- **vCenter Hardware Status**

  Uses CIM monitoring to display the hardware status of hosts that vCenter Server manages.

- **vCenter Service Status**

  Displays the status of vCenter services.

Some plug-ins are packaged separately from the base product and require separate installation. You can update plug-ins and the base product independently of each other. VMware modules include:

- **vSphere Update Manager (VUM)**

  Enables administrators to apply updates and patches across ESXi hosts and all managed virtual machines. Administrators can create user-defined security baselines that represent a set of security standards. Security administrators can compare hosts and virtual machines against these baselines to identify and remediate systems that are not in compliance.

- **vShield Zones**

  An application-aware firewall built for vCenter Server integration. vShield Zones inspects client-server communications and communications between virtual machines to provide detailed traffic analytics and application-aware firewall partitioning. vShield Zones is a critical security component for protecting virtualized datacenters from network-based attacks and misuse.

- **vCenter Orchestrator**

  A workflow engine that enables you to create and run automated workflows in your vSphere environment. vCenter Orchestrator coordinates workflow tasks across multiple VMware products and third-party management and administration solutions through its open plug-in architecture. vCenter Orchestrator provides a library of workflows that are extensible. You can use any operation available in the vCenter Server API to customize vCenter Orchestrator workflows.

- **Data Recovery**

  A disk-based backup and recovery solution that provides complete data protection for virtual machines. Data Recovery is fully integrated with vCenter Server to enable centralized and efficient management of backup jobs and includes data deduplication to minimize disk usage.
You have several ways to access vSphere components through vSphere interface options.

vSphere interface options include:

**vSphere Client**
A required component and the primary interface for creating, managing, and monitoring virtual machines, their resources, and their hosts. It also provides console access to virtual machines.

The vSphere Client is installed on a Windows machine with network access to your ESXi or vCenter Server system installation. The interface displays slightly different options depending on which type of server you are connected to. While all vCenter Server activities are performed by a vCenter Server system, you must use the vSphere Client to monitor, manage, and control the server. A single vCenter Server system or ESXi host can support multiple, simultaneously connected vSphere Clients.

**vSphere Web Client**
The vSphere Web Client is a Web application installed on a machine with network access to your vCenter Server installation. In this release, the vSphere Web Client includes a subset of the functionality included in the Windows-based vSphere Client, primarily related to inventory display and virtual machine deployment and configuration.

**vSphere Command-Line Interface**
A command-line interface for configuring an ESXi host. The vSphere Command-Line Interface can also be used to perform Storage vMotion operations on both ESXi hosts.

See Chapter 10, “Starting and Stopping the vSphere Components,” on page 105 for information and instructions about starting and stopping ESXi hosts and vCenter Server.

This chapter includes the following topics:

- “Start the vSphere Client and Log In,” on page 20
- “Stop the vSphere Client and Log Out,” on page 20
- “Register a vCenter Server System with the vSphere Web Client,” on page 20
- “Log in to vCenter Server using the vSphere Web Client,” on page 21
- “Log Out of vCenter Server Using the vSphere Web Client,” on page 22
Start the vSphere Client and Log In

The vSphere Client is a graphical user interface to vCenter Server and to hosts.

A login screen appears when you start the vSphere Client. After you log in, the client displays the objects and functionality appropriate to the server you are accessing and the permissions available to the user you logged in as.

**Procedure**

1. Log in to your Windows system.
   
   If this is the first time you are starting the vSphere Client, log in as the administrator.
   
   - If the managed host is not a domain controller, log in as either `local_host_name\user` or `user`, where `user` is a member of the local Administrators group.
   
   - If the managed host is a domain controller, you must log in as `domain\user\domain\user`, where `domain` is the domain name for which the managed host is a controller and `user` is a member of that domain’s Domain Administrators group. VMware does not recommend running on a domain controller.

2. Double-click a shortcut or select the vSphere Client from *Start > Programs > VMware > vSphere Client*.

3. Enter the server name, your user name, and your password.
   
   If you are logging in to a vCenter Server system that is part of a Connected Group, logging in to that server connects you to all servers in that group.

   **Note** Only previously entered server names appear in the Server drop-down menu.

4. Click *Login* to continue.

You are now connected to the host or vCenter Server system.

Stop the vSphere Client and Log Out

When you no longer need to view or alter the activities that the vCenter Server system is performing, log out of the vSphere Client.

**Note** Closing a vSphere Client session does not stop the server.

**Procedure**

- Click the close box (X), or select *File > Exit*.

The vSphere Client shuts down. The vSphere Client is logged out of the vCenter Server system. The server continues to run all its normal activities in the background. Any scheduled tasks are saved and performed by vCenter Server.

Register a vCenter Server System with the vSphere Web Client

Before you can connect to a vCenter Server system, you must register it with the vSphere Web Client.

You can register multiple vCenter Server systems with a single vSphere Web Client. However, the vSphere Web Client can connect only to one vCenter Server system at a time, unless those vCenter Server systems are joined together in Linked Mode.

VMware recommends that you register a given vCenter Server system with only one vSphere Web Client instance, rather than using multiple vSphere Web Client instances to manage that vCenter Server system.
The vCenter Server system in a vCenter Server appliance is preregistered with the vSphere Web Client installed in the appliance. To register another vCenter Server system with the vSphere Web Client installed as part of a vCenter Server Appliance, you must use the admin-app command-line script rather than the Web-based administration tool.

**Prerequisites**
- Log-in to the system on which the vSphere Web Client is installed. You cannot register a vCenter Server system with the client from a remote system.
- Ensure that you have login credentials with Administrator privileges for the vCenter Server system that you are registering.
- If you will use the server IP address to access the vSphere Web Client and your browser uses a proxy, add the server IP address to the list of proxy exceptions.

**Procedure**

1. Open a Web browser and enter the URL for the administration tool: `https://localhost:port/admin-app` or `https://127.0.0.1:port/admin-app`.
   Use the localhost or loopback address to access the administration tool instead of using the server IP address. Replace `port` with the port used by the vSphere Web Client. By default, this is 9443, but can be changed during installation.
2. Click **Register vCenter Server**.
3. In the **vCenter Server name or IP** text box, enter the server name or IP address of the vCenter Server system.
   Do not include `http://` or `https://`.
4. In the **User name** text box, enter the user name that you will use to connect to the vCenter Server system.
5. In the **Password** text box, enter the password.
6. In the **vSphere Web Client server name or IP** text box, enter the URL for the vSphere Web Client application, using the IP address or host name of the machine where the vSphere Web Client is installed.
   For example: `https://example.com:9443/vsphere-client`.
   Do not use the localhost URL for the vSphere Web Client. If you enter the localhost URL, the license reporting functionality will not be available in the vSphere Client unless the vSphere Web Client and vCenter Server are installed on the same system.
7. Click **Register**.

You can now use this instance of the client to log in to the vCenter Server system.

**What to do next**

In the Web browser, open `https://client-hostname:port/vsphere-client/` to access the vSphere Web Client and log in to vCenter Server, where `client-hostname` is the host name or IP address of the client, and `port` is the port used by the client.

**Log in to vCenter Server using the vSphere Web Client**

Log in to vCenter Server using the vSphere Web Client to manage your vSphere inventory.

**Prerequisites**

Verify that the vCenter Server system is registered with the client.
Procedure

1. Open a Web browser and enter the URL for the vSphere Web Client:
   By default the port is 9443, but this can be changed during vSphere Web Client installation.

2. In the Server drop-down menu, select the vCenter Server to which you want to connect.

3. In the Username text box, enter your user name on the vCenter Server system.

4. In the Password text box, enter your password.

5. Click Login.

6. If a warning message about an untrusted SSL certificate appears, select the appropriate action based on your security policy.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore the security warning for this login session only.</td>
<td>Click Ignore.</td>
</tr>
<tr>
<td>Ignore the security warning for this login session, and install the default certificate so that the warning does not appear again.</td>
<td>Select Install this certificate and do not display any security warnings for this server and click Ignore. Select this option only if using the default certificate does not present a security problem in your environment.</td>
</tr>
<tr>
<td>Cancel and install a signed certificate before proceeding.</td>
<td>Click Cancel and ensure that a signed certificate is installed on the vCenter Server system before you attempt to connect again.</td>
</tr>
</tbody>
</table>

The vSphere Web Client connects to the vCenter Server system, allowing you to view and manage your inventory.

Log Out of vCenter Server Using the vSphere Web Client

Log out of your vSphere Web Client to disconnect from the vCenter Server system.

Procedure

◆ Click the username at the top of the vSphere Web Client window and select Logout.
The vSphere Client is the principal interface for administering vCenter Server and ESXi.

The vSphere Client user interface is configured based on the server to which it is connected:

- When the server is a vCenter Server system, the vSphere Client displays all the options available to the vSphere environment, according to the licensing configuration and the user permissions.
- When the server is an ESXi host, the vSphere Client displays only the options appropriate to single host management.

When you first log in to the vSphere Client, it displays a Home page with icons that you select to access vSphere Client functions. When you log out of the vSphere Client, the client application retains the view that was displayed when it closed, and returns you to that view when you next log in.

You perform many management tasks from the Inventory view, which consists of a single window containing a menu bar, a navigation bar, a toolbar, a status bar, a panel section, and pop-up menus.

This chapter includes the following topics:

- “Getting Started Tabs,” on page 23
- “Status Bar, Recent Tasks, and Triggered Alarms,” on page 24
- “Panel Sections,” on page 24
- “View Virtual Machine Console,” on page 25
- “Searching the vSphere Inventory,” on page 25
- “Using Lists,” on page 26
- “Custom Attributes,” on page 27
- “Select Objects,” on page 28
- “Manage vCenter Server Plug-Ins,” on page 29
- “Save vSphere Client Data,” on page 30
- “Working with Active Sessions,” on page 30

**Getting Started Tabs**

In the case where vCenter Server is newly installed and no inventory objects have been added, the Getting Started tabs guide you through the steps of adding items to the inventory and setting up the virtual environment.

- **Disable Getting Started Tabs** on page 24

  You can disable the Getting Started tabs if you do not want to display them.
If you turned off the display of the Getting Started tabs, you can restore the settings to display these tabs for all inventory objects.

### Disable Getting Started Tabs

You can disable the Getting Started tabs if you do not want to display them.

You can disable the tabs in the following ways.

**Procedure**

- Click the **Close Tab** link to disable Getting Started tabs for the type of object selected.
- Change the vSphere Client settings to hide all Getting Started tabs.
  
  a. Select **Edit > Client Settings**.
  
  b. Select the **General** tab.
  
  c. Deselect the **Show Getting Started Tabs** check box and click **OK**.

### Restore Getting Started Tabs

If you turned off the display of the Getting Started tabs, you can restore the settings to display these tabs for all inventory objects.

**Procedure**

1. Select **Edit > Client Settings**.
2. Click the **General** tab.
3. Select **Show Getting Started Tabs** and click **OK**.

### Status Bar, Recent Tasks, and Triggered Alarms

Use the status bar to view information about alarms and recently completed or active tasks.

The status bar appears at the bottom of the window. It contains icons to view triggered alarms or recent tasks. The **Tasks** button displays any currently running or recently completed active tasks. Included is a progress bar indicating the percentage complete of each task. The recent tasks and the triggered alarm panels display across the bottom of the vSphere Client window.

### Panel Sections

The body of the vSphere Client page has a panel section. Most views have a left and a right panel: the Inventory panel and the Information panel.

You can resize these panels.

- **Inventory panel**: Displays a hierarchical list of vSphere objects when an Inventory or Maps view appears.

- **Information panels**: Display lists and charts. Depending on the navigation items or Inventory item selected, the Information panel is divided into tabbed elements.
View Virtual Machine Console

The console of a powered-on virtual machine is available through a connected server. All console connections to the virtual machine see the same information. The message line indicates if others are viewing the virtual machine.

Procedure

1. Select a powered-on virtual machine.
2. In the Information panel, click the Console tab.
3. (Optional) Click the pop-out icon in the navigation bar to show the virtual machine console in a separate window.
4. (Optional) Press Ctrl+Alt+Enter to enter or exit full screen mode.

Searching the vSphere Inventory

The vSphere Client allows you to search your vSphere inventory for virtual machines, hosts, datastores, networks, or folders that match specified criteria.

If the vSphere Client is connected to a vCenter Server system that is part of a connected group in vCenter Linked Mode, you can search the inventories of all vCenter Server systems in that group. You can view and search only for inventory objects that you have permission to view. Because the search service queries Active Directory for information about user permissions, you must be logged in to a domain account to search all vCenter Server systems in Linked Mode. If you log in using a local account, searches return results only for the local vCenter Server system, even if it is joined to other servers in Linked Mode.

**NOTE** If your permissions change while you are logged in, the search service might not immediately recognize these changes. To ensure that your search is performed with up-to-date permissions, log out of all your open sessions and log in again before performing the search.

Perform a Simple Search

A simple search searches all the properties of the specified type or types of objects for the entered search term.

Procedure

1. Click the icon in the search field at the top right of the vSphere Client window and select the type of inventory item to search for.
   - Virtual Machines
   - Folders
   - Hosts
   - Datastores
   - Networks
   - Inventory, which finds matches to the search criteria in any of the available managed object types.
2. Type one or more search terms into the search field and press Enter.
3. (Optional) If more items are found than can be displayed in the results pane, click Show all.

What to do next

If you are not satisfied with the results of the simple search, perform an advanced search.
Perform an Advanced Search

Using advanced search allows you to search for managed objects that meet multiple criteria. For example, you can search for virtual machines matching a search string. The virtual machines reside on hosts whose names match a second search string.

Procedure

1. Select View > Inventory > Search to display the advanced search page.

2. Click the icon in the search field at the top right of the vSphere Client window and select the type of inventory item to search for.
   - Virtual Machines
   - Folders
   - Hosts
   - Datastores
   - Networks
   - Inventory, which finds matches to the search criteria in any of the available managed object types.

3. Type one or more search terms into the search box.

4. Refine the search based on additional properties.
   a. Click Show options.
   b. From the drop-down menu, select the additional property that you want to use to restrict the search results.
      The available properties depend on the type of object you are searching for.
   c. Select or type the appropriate options for the property you have selected.
   d. To add more properties, click Add and repeat steps 4b through 4c.
      An advanced search always finds objects that match all the properties in the list.

5. Click Search.

The search results appear below the search specification.

Using Lists

Many vSphere Client inventory tabs display lists of information.

For example, the Virtual Machines tab displays a list of all the virtual machines associated with a host or a cluster. Sort any list in the vSphere Client by clicking the column label heading. A triangle in the column header shows the sort order as ascending or descending.

You can also filter a list, sorting and including only selected items. A filter is sorted by a keyword. Select the columns to include in the search for the keyword.
Filter a List View

You can filter a list if it is too long, or if you are looking for specific items in the list (alarms that begin with the word "datastore," for example). You can show and hide the filter field by using the Filtering option in the View menu.

The list is updated based on whether filtering is on or off. For example, if you are in the Virtual Machines tab, you have filtered the list and the filtered text is “powered on.” You see a list of virtual machines whose state is set to powered on. If the state of any virtual machine changes, the virtual machine is removed from the list. Virtual machines that are added to the list are also filtered.

Procedure

1. On any inventory panel that displays a list, click the arrow next to the filter box at the top right of the pane.
2. Select the attributes on which to filter.
3. Enter search criteria into the filter field.
   - The search automatically starts after a pause of more than one second. Neither boolean expressions nor special characters are supported. Filtering is not case-sensitive.
4. (Optional) Click Clear to clear the filter field.

Export a List

You can export a list to a file.

Procedure

1. Select the list to export.
2. Select File > Export > Export List.
3. Type a filename and select a file type.
4. Click Save.

Custom Attributes

You can use custom attributes to associate user-specific meta-information with virtual machines and managed hosts.

Attributes are the resources that are monitored and managed for all the managed hosts and virtual machines in your vSphere environment. Attributes’ status and states appear on the inventory panels.

After you create the attributes, set the value for the attribute on each virtual machine or managed host, as appropriate. This value is stored with vCenter Server and not with the virtual machine or managed host. Use the new attribute to filter information about your virtual machines and managed hosts. If you no longer need the custom attribute, remove it. A custom attribute is always a string.

For example, suppose you have a set of products and you want to sort them by sales representative. Create a custom attribute for sales person name, Name. Add the custom attribute, Name, column to one of the list views. Add the appropriate name to each product entry. Click the column title Name to sort alphabetically.

The custom attributes feature is available only when you are connected to a vCenter Server system.
**Add Custom Attributes**

You can create custom attributes to associate with virtual machines or managed hosts.

**Procedure**

1. Select **Administration > Custom Attributes**.
   - This option is not available when connected only to an ESXi host.
2. Click **Add**.
3. Enter the values for the custom attribute.
   - Type the name of the attribute in the **Name** text box.
   - Select the attribute type from the **Type** drop-down menu: **Virtual Machine**, **Host**, or **Global**.
   - In the **Value** text box, type the value you want to give to the attribute for the currently selected object.
   - Click **OK**.

   After you have defined an attribute on a single virtual machine or host, it is available to all objects of that type in the inventory. However, the value you specify is applied only to the currently selected object.

4. (Optional) To change the attribute name, click in the **Name** field and type the name you want to assign to the attribute.
5. Click **OK**.

**Edit a Custom Attribute**

You can edit custom attributes and add annotations for a virtual machine or host from the Summary tab for the object. Use annotations to provide additional descriptive text or comments for an object.

**Procedure**

1. Select the virtual machine or host in the inventory.
2. Click the **Summary** tab for the virtual machine or host.
3. In the **Annotations** box, click the **Edit** link.
4. To edit the value of an attribute that is already defined, double-click the **Value** field for that attribute and enter the new value.
5. Click **OK** to save your changes.

**Select Objects**

vCenter Server objects are datacenters, networks, datastores, resource pools, clusters, hosts, and virtual machines. Selecting an object allows you to view the status of the object and enables the menus so you can select actions to take on the object.

**Procedure**

- Locate the object by browsing or search.
  - From the vSphere Client Home page, click the icon for the appropriate inventory view, and browse through the inventory hierarchy to select the object.
  - Perform a search for the object, and double-click it in the search results.
Manage vCenter Server Plug-Ins

After the server component of a plug-in is installed and registered with vCenter Server, its client component is available to vSphere clients. Client component installation and enablement are managed through the Plug-in Manager dialog box.

The Plug-in Manager lets you perform the following actions:

- View available plug-ins that are not currently installed on the client.
- View installed plug-ins.
- Download and install available plug-ins.
- Enable and disable installed plug-ins.

Install Plug-Ins

You can install plug-ins using the Plug-in Manager.

Procedure

1. Launch the vSphere Client and log in to a vCenter Server system.
2. Select Plug-ins > Manage Plug-ins.
3. Select the Available tab in the Plug-in Manager dialog box.
4. Click Download and Install for the plug-in you want.
5. Follow the prompts in the installation wizard.
6. After installation is complete, verify that the plug-in is listed under the Installed tab and that it is enabled.

There might be a short delay between the completion of the installation and the plug-in appearing in the list of installed plug-ins.

Disable and Enable Plug-Ins

You can disable or enable plug-ins using the Plug-in Manager.

Disabling a plug-in does not remove it from the client. You must uninstall the plug-in to remove it.

Procedure

1. Launch the vSphere Client and log in to a vCenter Server system.
2. Select Plug-ins > Manage Plug-ins.
3. Select the Installed tab in the Plug-in Manager dialog box.
4. Select Enable to enable a plug-in, or deselect Enable to disable it.

Remove Plug-Ins

You can remove plug-ins through the operating system’s control panel.

Procedure

- Consult your operating system’s documentation for instructions on how to use the Add/Remove Programs control panel.
Troubleshooting vCenter Server Plug-Ins

In cases where vCenter Server plug-ins are not working, you have several options to correct the problem.

vCenter Server plug-ins that run on the Tomcat server have extension.xml files, which contain the URL where the corresponding Web application can be accessed. These files are located in C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions. Extension installers populate these XML files using the DNS name for the machine.

Example from the stats extension.xml file:

```
```

vCenter Server, plug-in servers, and the vSphere Clients that use them must be located on systems under the same domain. If they are not under the same domain, or if the DNS of the plug-in server is changed, the plug-in clients will not be able to access the URL, and the plug-in will not work.

You can edit the XML files manually by replacing the DNS name with an IP address. Reregister the plug-in after you edit its extension.xml file.

Save vSphere Client Data

The vSphere Client user interface is similar to a browser. Most user actions are persistent in vCenter Server data that appears. You typically do not have to save the data.

Procedure

- You can save the client data by either printing a copy of the window or exporting the server data.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy the window</td>
<td>Use the Microsoft Windows Print Screen option to print a copy of the vSphere Client window.</td>
</tr>
<tr>
<td>Export server data</td>
<td>Select File &gt; Export and select a format in which to save the vCenter Server data. Open the data in an appropriate application and print from that application.</td>
</tr>
</tbody>
</table>

Working with Active Sessions

You can view a list of users who are logged in to a vCenter Server system when your vSphere Client is connected to that server. You can end sessions, and you can send a message to all users logged on to an active session.

These features are not available when your vSphere Client is connected to an ESXi host.

View Active Sessions

You can view active sessions on the home page of a vSphere Client.

Procedure

- From the Home page of a vSphere Client connected to a vCenter Server system, click the Sessions button.

Terminate Active Sessions

Terminating an active session ends the vSphere Client session and any remote console connections started by the user during the session.

Procedure

1. On the Home page of a vSphere Client connected to a vCenter Server system, click the Sessions button.
2 Right-click a session and select **Terminate**.
3 Click **OK** to confirm the termination.

**Send a Message to All Active Users**

You can send a Message of the Day to all active session users and to new users when they log into the vSphere Client.

The **Message of the day** text is sent as a notice message to all active session users and to new users when they log in.

**Procedure**

1 On the Home page of a vSphere Client connected to a vCenter Server system, click the **Sessions** button.
2 Type a message in the **Message of the day** field.
3 Click **Change**.

The message is broadcast to all users logged into the vSphere Client.
Configuring ESXi hosts, vCenter Server systems, and the vSphere Client involves several tasks.

This chapter includes the following topics:

- “Host Configuration,” on page 33
- “Configuring vCenter Server,” on page 33
- “Configuring the VMware vCenter Server Appliance,” on page 43
- “Configuring Communication Among ESXi, vCenter Server, and the vSphere Client,” on page 50

**Host Configuration**

Before you create virtual machines on your hosts, you must configure the hosts to ensure that they have correct licensing, network and storage access, and security settings. Each type of host has a manual that provides information on the configuration for that host.

For information on configuring a host, see the configuration information for the specific vSphere component in the *vSphere Security* documentation, the *vSphere Storage* documentation, or the *vSphere Networking* documentation.

**Configuring vCenter Server**

Use the vCenter Server Settings dialog box to configure vCenter Server, including settings such as licensing, statistics collection, logging and other settings.

- **Configure License Settings for vCenter Server** on page 34
  You must configure a license to use vCenter Server. License keys are required for various vSphere components and features.

- **Configuring Statistics Settings** on page 35
  To set up how statistical data is recorded, you configure statistics intervals.

- **Configure Runtime Settings** on page 37
  You can change the port number the server is using for communications. You can also change the vCenter Server ID and the vCenter Server Managed IP address. Usually, you do not need to change these settings, but you might need to make changes if you run multiple vCenter Server systems in the same environment.

- **Configure Active Directory Settings** on page 38
  You can configure some of the ways vCenter Server interacts with the Active Directory server.
Configure Mail Sender Settings on page 38
You must configure the email address of the sender account in order to enable vCenter Server operations, such as sending email notifications as alarm actions.

Configure SNMP Settings on page 39
You can configure up to four receivers to receive SNMP traps from vCenter Server. For each receiver, specify a host name, port, and community.

View Ports Settings on page 39
You can view the ports used by the Web service to communicate with other applications. You can no longer configure these port settings.

Configure Timeout Settings on page 40
You can configure the timeout intervals for vCenter Server operations. These intervals specify the amount of time after which the vSphere Client times out.

Configure Logging Options on page 40
You can configure the amount of detail that vCenter Server collects in log files.

Configure the Maximum Number of Database Connections on page 41
You can configure the maximum number of database connections that can occur simultaneously.

Configure Database Retention Policy on page 41
In order to limit the growth of the vCenter Server database and conserve storage space, you can configure the database to discard information about tasks or events after a specified period of time.

Configure SSL Settings on page 42
You can configure vCenter Server to check the SSL certificates of hosts to which it connects. If you select this option, vCenter Server and the vSphere Client check for valid SSL certificates before connecting to a host for such operations as adding a host or making a remote console connection to a virtual machine.

Configure Advanced Settings on page 42
You can use the Advanced Settings page to modify the vCenter Server configuration file, vpxd.cfg.

Configure License Settings for vCenter Server
You must configure a license to use vCenter Server. License keys are required for various vSphere components and features.

Prerequisites
To configure licenses, the vSphere Client must be connected to a vCenter Server system.
Required privilege: Global.Settings

Procedure
1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.
3 Select the type of license key to assign to this vCenter Server.
   - Select **Assign an existing license key to this vCenter Server** and select a license key from the Product list.
   - Select **Assign a new license key to this vCenter Server**, click **Enter Key**, and enter a vCenter Server license key and an optional label for the key.

   **NOTE** To enter ESX 4.0/ESXi 4.0 keys, select **Home > Administration > Licensing**.

4 (Optional) Enter the fully qualified domain name or the IP address of a license server and, optionally, a port.

   A license server is required if this vCenter Server system manages ESX 3.x/ESXi 3.5 hosts or if you have additional vCenter modules that require a license server.

   If you do not specify a port, the default port, 27000, is used.

   For example, with the default license server port 27000 on a license server called license, your entry might look like this:

   27000@license.example.com

   If you do not use the fully qualified domain name or the IP address of the license server, legacy hosts might not be able to resolve the license server host name.

5 (Optional) Select **Reconfigure ESX 3 hosts using license servers to use this server** if you want each ESX 3.x/ESXi 3.5 host that you add to the vCenter Server inventory to use the same license server as this vCenter Server system.

   The settings on the host are altered by vCenter Server only when the host is added or when the license server used by vCenter Server is changed. If you leave this option unselected, you can either configure another license server for the ESX 3.x/ESXi 3.5 hosts or configure the hosts to use host-based license files.

### Configuring Statistics Settings

To set up how statistical data is recorded, you configure statistics intervals.

- **Configure Statistics Intervals** on page 35

   Statistic intervals determine the frequency at which statistic queries occur, the length of time statistical data is stored in the database, and the type of statistical data collected.

- **Enable or Disable a Statistics Interval** on page 36

   Enabling a statistics interval increases the number of statistics stored in the vCenter Server database. Disabling a statistics interval disables all subsequent intervals and decreases the number of statistics stored in the vCenter Server database.

- **Estimate the Effect of Statistics Collection on the Database** on page 37

   The impact of the statistics collection on your vCenter Server database is based on the current vCenter Server and inventory size.

### Configure Statistics Intervals

Statistic intervals determine the frequency at which statistic queries occur, the length of time statistical data is stored in the database, and the type of statistical data collected.

Required privilege: **Global.Settings**

**NOTE** Not all interval attributes are configurable.
Prerequisites
To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.

Procedure
1. If necessary, select Administration > Settings to open the vCenter Server Settings dialog box.
2. If your environment uses multiple vCenter Servers, in Current vCenter Server, select the server.
3. In the navigation panel, select Statistics.
4. In the Statistics Intervals section, select or deselect a collection interval to enable or disable it.
   Enabling a longer interval automatically enables all shorter intervals.
5. To change a collection interval attribute, select its row in the Statistics Interval section and click Edit to open the Edit Collection Interval dialog box.
   a. In Keep Samples for, select an archive length.
      This option is configurable only for the Day and Year intervals.
   b. In Statistics Interval, select an interval duration.
      This option is configurable only for the Day interval.
   c. In Statistics Level select a new level interval level.
      Level 4 uses the highest number of statistics counters. Use it only for debugging purposes.
      The statistics level must be less than or equal to the statistics level set for the preceding statistics interval. This is a vCenter Server dependency.
6. (Optional) In the Database Size section, estimate the effect of the statistics settings on the database.
   a. Enter the number of Physical Hosts.
   b. Enter the number of Virtual Machines.
      The estimated space required and number of database rows required are calculated and displayed.
   c. If necessary, make changes to your statistics collection settings.
7. Click OK.

Enable or Disable a Statistics Interval

Enabling a statistics interval increases the number of statistics stored in the vCenter Server database. Disabling a statistics interval disables all subsequent intervals and decreases the number of statistics stored in the vCenter Server database.

Required privilege: Global.Settings

Prerequisites
To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.

Procedure
1. Select or deselect the statistics interval check box.
2. Click OK.
Estimate the Effect of Statistics Collection on the Database

The impact of the statistics collection on your vCenter Server database is based on the current vCenter Server and inventory size.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.

Procedure

1. If necessary, configure the statistics intervals.
2. In the database calculator pane, specify the number of hosts and virtual machines in your datacenter.
   a. Enter the number of Physical Hosts.
   b. Enter the number of Virtual Machines.
      The estimated space required and number of database rows required are calculated and displayed.
   c. If necessary, make changes to your statistics collection settings.
3. Click OK.

Configure Runtime Settings

You can change the port number the server is using for communications. You can also change the vCenter Server ID and the vCenter Server Managed IP address. Usually, you do not need to change these settings, but you might need to make changes if you run multiple vCenter Server systems in the same environment.

Required privilege: Global.Settings

Prerequisites

To configure runtime settings, the vSphere Client must be connected to the vCenter Server system.

Procedure

1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.
3. In the navigation panel, select Runtime Settings.
4. In vCenter Server Unique ID, enter a unique ID.
   You can change this value to a number from 0 through 63 to uniquely identify each vCenter Server system running in a common environment. By default, an ID value is generated randomly.
5. In vCenter Server Managed IP, enter the vCenter Server system IP address.
6. In vCenter Server Name, enter the name of the vCenter Server system.
   If you change the DNS name of the vCenter Server, use this option to modify the vCenter Server name to match.
7. Click OK to save your changes and close the dialog box.
What to do next

If you made changes to the vCenter Server system Unique ID, you must restart the vCenter Server system for these changes to take effect.

Configure Active Directory Settings

You can configure some of the ways vCenter Server interacts with the Active Directory server.

Required privilege: Global.Settings

Prerequisites

To configure active directory settings, the vSphere Client must be connected to the vCenter Server system.

Procedure

1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.
3. In the navigation pane, select Active Directory.
4. In Active Directory Timeout, enter the timeout interval in seconds for connecting to the Active Directory server.
5. Select Enable Query Limit to limit the number of users and groups displayed in the Add Permissions dialog box.
6. In Users & Groups, enter the maximum number of users and groups to display.
   - If you enter 0 (zero), all users and groups appear.
7. Select Enable Validation to have vCenter Server periodically check its known users and groups against the Active Directory server.
8. In Validation Period, enter the number of minutes between instances of synchronization.
9. Click OK to save your changes and close the dialog box.

Configure Mail Sender Settings

You must configure the email address of the sender account in order to enable vCenter Server operations, such as sending email notifications as alarm actions.

Required privilege: Global.Settings

Prerequisites

To configure SMTP notifications, the vSphere Client must be connected to the vCenter Server system.

Procedure

1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.
3. In the navigation pane, select Mail.
4. Enter the SMTP server information.
   - The SMTP Server is the DNS name or IP address of the SMTP gateway to use for sending email messages.
5 Enter the sender account information.

The Sender Account is the email message address of the sender.

**NOTE** The full email address must be entered, including the domain name (the information after the @ sign).

For example, mail_server@datacenter.com.

6 Click OK.

**What to do next**

To test the mail settings, create an alarm that can be triggered by a user action, such as an alarm triggered by powering off a virtual machine, and verify that you receive an email when the alarm is triggered.

### Configure SNMP Settings

You can configure up to four receivers to receive SNMP traps from vCenter Server. For each receiver, specify a host name, port, and community.

**Prerequisites**

To configure SNMP settings, the vSphere Client must be connected to a vCenter Server system.

Required privilege: **Global.Settings**

**Procedure**

1 If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the **Current vCenter Server** drop-down menu.

3 In the settings list, select **SNMP**.

4 In **Receiver URL**, enter the host name or IP address of the SNMP receiver.

5 In the field next to the Receiver URL field, enter the port number of the receiver.

   The port number must be a value between 1 and 65535.

6 In **Community**, enter the community identifier.

7 Click **OK**.

### View Ports Settings

You can view the ports used by the Web service to communicate with other applications. You can no longer configure these port settings.

The Web Service is installed as part of the VMware vCenter Server installation. The Web Service is a required component for third-party applications that use the VMware SDK application programming interface (API).

For information about Web Service installation, see the *vSphere Installation and Setup* documentation.

**Procedure**

1 If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.

2 If the vCenter Server system is part of a connected group, select the server you want to configure from the **Current vCenter Server** drop-down menu.
3 In the settings list, select **Ports**.
   The ports used by the Web service are displayed.
4 Click **OK**.

### Configure Timeout Settings

You can configure the timeout intervals for vCenter Server operations. These intervals specify the amount of time after which the vSphere Client times out.

**Required privilege:** **Global.Settings**

**Prerequisites**

To configure timeout settings, the vSphere Client must be connected to the vCenter Server system.

**Procedure**

1 If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.
2 If the vCenter Server system is part of a connected group, select the server you want to configure from the **Current vCenter Server** drop-down menu.
3 In the settings list, select **Timeout Settings**.
4 In **Normal Operations**, enter the timeout interval in seconds for normal operations.
   Do not set the value to zero (0).
5 In **Long Operations**, enter the timeout interval in minutes for long operations.
   Do not set the value to zero (0).
6 Click **OK**.
7 Restart the vCenter Server system for the changes to take effect.

### Configure Logging Options

You can configure the amount of detail that vCenter Server collects in log files.

**Required privilege:** **Global.Settings**

**Prerequisites**

To configure statistics settings, the vSphere Client must be connected to a vCenter Server system.

**Procedure**

1 If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.
2 If the vCenter Server system is part of a connected group, select the server you want to configure from the **Current vCenter Server** drop-down menu.
3 In the settings list, select **Logging Options**.
4 From the vCenter Server Logging list, select logging options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None (Disable logging)</td>
<td>Turn off logging</td>
</tr>
<tr>
<td>Error (Errors only)</td>
<td>Display only error log entries</td>
</tr>
<tr>
<td>Warning (Errors and warnings)</td>
<td>Display warning and error log entries</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Info (Normal logging)</td>
<td>Displays information, error, and warning log entries</td>
</tr>
<tr>
<td>Verbose (Verbose)</td>
<td>Displays information, error, warning, and verbose log entries</td>
</tr>
<tr>
<td>Trivia (Extended verbose)</td>
<td>Displays information, error, warning, verbose, and trivia log entries</td>
</tr>
</tbody>
</table>

5. Click OK.

Changes to the logging settings take effect immediately. You do not need to restart vCenter Server system.

**Configure the Maximum Number of Database Connections**

You can configure the maximum number of database connections that can occur simultaneously.

**Prerequisites**

To configure database settings, the vSphere Client must be connected to a vCenter Server system.

**Procedure**

1. If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the **Current vCenter Server** drop-down menu.
3. In the settings list, select **Database**.
4. In **Maximum number**, type the number.
   Generally, you do not need to change this value. You might want to increase this number if your vCenter Server system frequently performs many operations and performance is critical. You might want to decrease this number, if the database is shared and connections to the database are costly. VMware recommends that you not change this value unless one of these issues pertains to your system.
5. Click OK.

**Configure Database Retention Policy**

In order to limit the growth of the vCenter Server database and conserve storage space, you can configure the database to discard information about tasks or events after a specified period of time.

Do not use these options if you want to retain a complete history of tasks and events for your vCenter Server.

**Prerequisites**

To configure the database retention policy, the vSphere Client must be connected to a vCenter Server system.

**Procedure**

1. If necessary, select **Administration > vCenter Server Settings** to display the vCenter Server Settings dialog box.
2. Select **Database Retention Policy**.
3. (Optional) Select **Tasks retained for**, and enter a value in days in the text box.
   Information about tasks performed on this vCenter Server system will be discarded after the specified number of days.
4. (Optional) Select **Events retained for**, and enter a value in days in the text box.
   Information about events for this vCenter Server system will be discarded after the specified number of days.
Configure SSL Settings

You can configure vCenter Server to check the SSL certificates of hosts to which it connects. If you select this option, vCenter Server and the vSphere Client check for valid SSL certificates before connecting to a host for such operations as adding a host or making a remote console connection to a virtual machine.

Required privilege: Global.Settings

Prerequisites

To configure SSL settings, the vSphere Client must be connected to a vCenter Server system.

Procedure

1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2. If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.
3. In Current vCenter Server, select the appropriate server.
4. In the settings list, select SSL Settings.
5. Select vCenter requires verified host certificates.
   
   If there are hosts that require manual validation, these hosts appear in the host list at the bottom of the dialog box.
6. Determine the host thumbprint for each host that requires validation.
   a. Log into the direct console.
   b. Select View Support Information on the System Customization menu.
      The thumbprint is displayed in the column on the right.
7. Compare the thumbprint you obtained from the host with the thumbprint listed in the vCenter Server Settings dialog box.
8. If the thumbprints match, select the check box for the host.

   Hosts that are not selected will be disconnected after you click OK.
9. Click OK.

Configure Advanced Settings

You can use the Advanced Settings page to modify the vCenter Server configuration file, vpxd.cfg.

This page can be used to add entries to the vpxd.cfg file, but not to edit or delete them. VMware recommends that you change these settings only when instructed to do so by VMware technical support or when you are following specific instructions in VMware documentation.

Required privilege: Global.Settings

Prerequisites

To configure statistics settings, the VI Client must be connected to a vCenter Server system.

Procedure

1. If necessary, select Administration > vCenter Server Settings to display the vCenter Server Settings dialog box.
2 If the vCenter Server system is part of a connected group, select the server you want to configure from the Current vCenter Server drop-down menu.

3 In the settings list, select Advanced Settings.

4 In the Key field, type a key.

5 In the Value field, type the value for the specified key.

6 Click Add.

7 Click OK.

What to do next
Many advanced options changes require that the vCenter Server system be restarted before they take effect. Consult VMware technical support to determine if your changes require a restart.

Configuring the VMware vCenter Server Appliance

The VMware vCenter Server Appliance is a preconfigured Linux-based virtual machine that is optimized for running vCenter Server and associated services.

For VMware vCenter Server Appliance installation, see the vSphere Installation and Setup publication.

The following features are not supported by the VMware vCenter Server Appliance.

- Linked Mode
- Microsoft SQL Server as a supported local or remote database
- DB2 as a supported remote database

The vCenter Server Appliance is supported only on ESX/ESXi 4.0 and 4.1 and ESXi 5.0.

- Log In to the VMware vCenter Server Appliance Web Console on page 44
  Log in to the VMware vCenter Server Appliance Web console to access VMware vCenter Server Appliance configuration settings.

- Configure Database Settings for the VMware vCenter Server Appliance on page 44
  Configure database settings, such as database type and log in, for the VMware vCenter Server Appliance.

- Configure Network Settings for the VMware vCenter Server Appliance on page 45
  Configure network settings for the VMware vCenter Server Appliance to specify static IP and proxy settings.

- Start vCenter Server in the VMware vCenter Server Appliance on page 46
  Start vCenter Server from the VMware vCenter Server Appliance.

- Stop vCenter Server in the VMware vCenter Server Appliance on page 46
  Stop vCenter Server from the VMware vCenter Server Appliance. A restart of vCenter Server is required for some setting changes to take effect.

- Start or Stop ESXi Services in the VMware vCenter Server Appliance on page 46
  Some VMware vCenter Server Appliance configuration changes require a restart of ESXi services to take effect.

- Change the Administrator Password for the VMware vCenter Server Appliance on page 46
  You can change the vCenter Server administrator password in the VMware vCenter Server Appliance.

- Enable or Disable SSH Administrator Login on the VMware vCenter Server Appliance on page 47
  You can enable or disable the ability to log in to the VMware vCenter Server Appliance using SSH.
Log In to the VMware vCenter Server Appliance Web Console

Log in to the VMware vCenter Server Appliance Web console to access VMware vCenter Server Appliance configuration settings.

Prerequisites

Install the VMware vCenter Server Appliance. See the vSphere Installation and Setup documentation.

Procedure

1. Go to the configuration address that your VMware vCenter Server Appliance virtual machine provides: https://VMware vCenter Server Appliance IP address:5480.
2. Type your user name and password, and click Login.

The initial default user name is root, and the default password is vmware.

What to do next

The first time you log in to the VMware vCenter Server Appliance, accept the End-User License Agreement by clicking Accept EULA and set the database type. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44.

Configure Database Settings for the VMware vCenter Server Appliance

Configure database settings, such as database type and log in, for the VMware vCenter Server Appliance.

Prerequisites

Install the VMware vCenter Server Appliance. See the vSphere Installation and Setup documentation.

Procedure

1. Log in to the VMware vCenter Server Appliance Web console.
2 On the vCenter Server tab, select Database.
3 Select the Database Type from the drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>embedded</td>
<td>Use the embedded database. This option is available only for a small inventory size, with fewer than 5 hosts and 50 virtual machines.</td>
</tr>
<tr>
<td>oracle</td>
<td>Use an external Oracle database.</td>
</tr>
</tbody>
</table>

4 Type the server and port information.
   This option is disabled if the database type is set to embedded.
5 Type the instance name.
   This option is disabled if the Database Type is set to embedded.
6 Type the database login and password.
   This option is disabled if the Database Type is set to embedded.
7 Click Test Settings to verify that the settings you entered are valid.
8 Click Save Settings to save your changes.
9 (Optional) Click Reset database contents.
10 Start or restart vCenter Server.

Configure Network Settings for the VMware vCenter Server Appliance

Configure network settings for the VMware vCenter Server Appliance to specify static IP and proxy settings.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the vSphere Installation and Setup documentation.

Procedure

1 Log in to the VMware vCenter Server Appliance Web console.
2 On the Network tab, click Address.
3 Select the method by which vCenter Server obtains IP settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>vCenter Server obtains IP settings from a DHCP server. This is the default setting.</td>
</tr>
<tr>
<td>Static</td>
<td>vCenter Server uses static IP settings. Specify the IP address, netmask, and gateway.</td>
</tr>
</tbody>
</table>

4 (Optional) Specify DNS configuration information.
5 Click Save Settings.
6 (Optional) Select Proxy, and select Use a proxy server to use a proxy server for vCenter Server.
7 (Optional) Specify a proxy server and proxy port.
8 (Optional) Specify a proxy username and proxy password if your proxy server requires them.
9 Click Save Settings.
Start vCenter Server in the VMware vCenter Server Appliance

Start vCenter Server from the VMware vCenter Server Appliance.

Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the vSphere Installation and Setup documentation.

Procedure

1. Log in to the VMware vCenter Server Appliance Web console.
2. On the vCenter Server tab, select Status.
3. Click Start vCenter.

You can now connect to vCenter Server using either the vSphere Client or the vSphere Web Client.

Stop vCenter Server in the VMware vCenter Server Appliance

Stop vCenter Server from the VMware vCenter Server Appliance. A restart of vCenter Server is required for some setting changes to take effect.

Procedure

1. Log in to the VMware vCenter Server Appliance Web console.
2. On the vCenter Server tab, select Status.
3. Click Stop vCenter.

Start or Stop ESXi Services in the VMware vCenter Server Appliance

Some VMware vCenter Server Appliance configuration changes require a restart of ESXi services to take effect.

Procedure

1. Log in to the VMware vCenter Server Appliance web console.
2. On the Services tab, click Status.
3. (Optional) Click Stop ESXi Services to stop ESXi services.
4. Click Start ESXi Services to start ESXi services.

Change the Administrator Password for the VMware vCenter Server Appliance

You can change the vCenter Server administrator password in the VMware vCenter Server Appliance.

Procedure

1. Log in to the VMware vCenter Server Appliance Web console.
2. On the vCenter Server tab, select Administration.
3. Type your current password in the Current administrator password text box.
4. Type the new password in the New administrator password and Retype new administrator password text boxes.
5. Click Change password.
Enable or Disable SSH Administrator Login on the VMware vCenter Server Appliance

You can enable or disable the ability to log in to the VMware vCenter Server Appliance using SSH.

**Procedure**

1. Log in to the VMware vCenter Server Appliance web console.
2. On the **vCenter Server** tab, click **Administration**.
3. (Optional) Click **Enable SSH login** to allow log in to the VMware vCenter Server Appliance using SSH.
4. (Optional) Click **Disable SSH login** to prevent log in to the VMware vCenter Server Appliance using SSH.

Configure Inventory Size for the VMware vCenter Server Appliance

Set the inventory size of the VMware vCenter Server Appliance based on the number of hosts and virtual machines that you plan to have in the VMware vCenter Server Appliance inventory.

**Prerequisites**

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the *vSphere Installation and Setup* documentation.

**Procedure**

1. In the VI Client, power off the VMware vCenter Server Appliance virtual machine.
2. Right-click the VMware vCenter Server Appliance virtual machine in the inventory pane and select **Edit Settings**.
3. On the **Hardware** tab, select **Memory**.
4. Set the memory size based on your planned inventory size.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4 GB or higher</strong></td>
<td>Memory requirement for fewer than 10 hosts and 100 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
<tr>
<td><strong>8 GB or higher</strong></td>
<td>Memory requirement for between 10 and 100 hosts or between 100 and 1000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
<tr>
<td><strong>13 GB or higher</strong></td>
<td>Memory requirement for between 100 and 400 hosts or between 1000 and 4000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
<tr>
<td><strong>17 GB or higher</strong></td>
<td>Memory requirement for over 400 hosts or 4000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
</tbody>
</table>

5. Click **OK**.
6. Power on the VMware vCenter Server Appliance virtual machine.
7. Log in to the VMware vCenter Server Appliance Web console.
8. On the **vCenter Server** tab, click **Settings**.
Select the inventory size from the drop-down menu.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>small</td>
<td>For fewer than 100 hosts and 1000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
<tr>
<td>medium</td>
<td>For between 100 and 400 hosts or between 1000 and 4000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
<tr>
<td>large</td>
<td>For over 400 hosts or 4000 virtual machines in the VMware vCenter Server Appliance inventory.</td>
</tr>
</tbody>
</table>

Click **Save Settings**.

**Configure ESXi Dump Collector on the VMware vCenter Server Appliance**

You can use ESXi Dump Collector to configure and dump a host's kernel core to a network server on the datacenter when the system fails. ESXi Dump Collector is installed and enabled by default on the VMware vCenter Server Appliance.

ESXi Dump Collector does not support vSphere distributed switches in ESXi 5.0.

**Prerequisites**

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the *vSphere Installation and Setup* documentation.

**Procedure**

1. Log in to the VMware vCenter Server Appliance.
2. On the **Services** tab, click **NetDump**.
3. Type the port number in the **Network Coredump Server (UDP) Port** text box.
4. Type the size in the **Network Coredump repository max size** text box to specify the maximum core dump repository size in GB.
5. Click **Test Settings** to verify that your changes are valid.
6. Click **Save Settings**.
7. Restart ESXi services.

**What to do next**

Configure hosts to dump kernel memory to the network server. See the *vSphere Installation and Setup* documentation.

**Configure ESXi Auto Deploy Settings on the VMware vCenter Server Appliance**

If you are using the VMware vCenter Server appliance for Auto Deploy, you can change the server port and maximum repository size for Auto Deploy.

**Prerequisites**

Enable the Auto Deploy server on the VMware vCenter Server Appliance. See the *vSphere Installation and Setup* documentation.

**Procedure**

1. Log in to the VMware vCenter Server Appliance web console.
2. On the **Services** tab, select **Autodeploy**.
3 Type the **Autodeploy Server Port** to use.

4 In the **Autodeploy repository max size** field, type the maximum Auto Deploy repository size in GB.

5 (Optional) Click **Test Settings** to verify that the specified settings are valid.

6 Click **Save Settings**.

7 Restart ESXi services.

## Configure NFS Storage on the VMware vCenter Server Appliance

Enable storing VMware vCenter Server Appliance log and core files on NFS to store VMware vCenter Server Appliance files on an NFS datastore.

### Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the *vSphere Installation and Setup* documentation.

Disable root squashing on the NFS server. For example, use the command `exportfs -vo rw,no_root_squash,sync :/share`.

### Procedure

1 Log in to the VMware vCenter Server Appliance Web console.

2 (Optional) On the **Status** tab, click **Stop vCenter**.
   
   This action minimizes logging to the old storage location.

3 On the **vCenter Server** tab, select **Storage**.

4 (Optional) Select **Enable storing log files on NFS** and type the NFS share on which to store VMware vCenter Server Appliance log files.

5 (Optional) Select **Enable storing core files on NFS** and type the NFS share on which to store VMware vCenter Server Appliance core files.

6 (Optional) Click **Test Settings** to verify that the VMware vCenter Server Appliance can successfully store files to the specified NFS shares.

7 Click **Save Settings**.

8 Restart the VMware vCenter Server Appliance.

## Configure Syslog Collector Ports on the VMware vCenter Server Appliance

The VMware vCenter Server Appliance acts as a syslog server, receiving system logs from hosts provisioned with Auto Deploy. You can change the system and SSL ports on the VMware vCenter Server Appliance to which hosts provisioned with Auto Deploy send log files.

### Prerequisites

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the *vSphere Installation and Setup* documentation.

### Procedure

1 Log in to the VMware vCenter Server Appliance Web console.

2 On the **Services** tab, click **Syslog**.

3 Type the Syslog collector server port and the Syslog collector server SSL port and click **Save Settings**.
Hosts provisioned with Auto Deploy send log files to the specified ports. Although the VMware vCenter Server Appliance acts as a syslog server, it does not appear as a syslog server in the vSphere Client.

**What to do next**

You must restart ESXi services for these changes to take effect.

**Configure Authentication Settings on the VMware vCenter Server Appliance**

You can configure authentication settings, such as enabling an NIS or Active Directory server, on the VMware vCenter Server Appliance.

**Prerequisites**

Install the VMware vCenter Server Appliance and configure the database. See “Configure Database Settings for the VMware vCenter Server Appliance,” on page 44 and the *vSphere Installation and Setup* documentation.

**Procedure**

1. Log in to the VMware vCenter Server Appliance Web console and navigate to the Authentication tab.
2. (Optional) Click NIS and select NIS Enabled to enable an NIS server for the VMware vCenter Server Appliance.
3. (Optional) Type the NIS domain and NIS server and click Save Settings.
4. (Optional) Click Active Directory and select Active Directory Enabled to enable an Active Directory server for the VMware vCenter Server Appliance.
5. (Optional) Type the domain, administrator user name, and administrator password for the Active Directory server and click Save Settings.
6. Restart vCenter Server.

**Configuring Communication Among ESXi, vCenter Server, and the vSphere Client**

By default, the vSphere Client uses ports 80 and 443 to communicate with vCenter Server and ESXi hosts. You can change these ports if necessary.

Configure your firewall to allow communication between the vSphere Client and vCenter Server by opening ports 80 and 443.

vCenter Server acts as a web service. If your environment requires the use of a web proxy, vCenter Server can be proxied like any other web service.
Using vCenter Server in Linked Mode

You can join multiple vCenter Server systems using vCenter Linked Mode to allow them to share information. When a server is connected to other vCenter Server systems using Linked Mode, you can connect to that vCenter Server system and view and manage the inventories of the linked vCenter Server systems.

Linked Mode uses Microsoft Active Directory Application Mode (ADAM) to store and synchronize data across multiple vCenter Server systems. ADAM is installed as part of vCenter Server installation. Each ADAM instance stores data from the vCenter Server systems in the group, including information about roles and licenses. This information is replicated across all of the ADAM instances in the connected group to keep them in sync.

When vCenter Server systems are connected in Linked Mode, you can perform the following actions:

- Log in simultaneously to vCenter Server systems for which you have valid credentials.
- Search the inventories of the vCenter Server systems in the group.
- View the inventories of the vCenter Server systems in the group in a single inventory view.

You cannot migrate hosts or virtual machines between vCenter Server systems connected in Linked Mode.

For more information on troubleshooting Linked Mode groups, see the vSphere Troubleshooting documentation.

This chapter includes the following topics:

- “Linked Mode Prerequisites for vCenter Server,” on page 51
- “Linked Mode Considerations for vCenter Server,” on page 52
- “Join a Linked Mode Group After Installation,” on page 53
- “Reconciling Roles When Connecting vCenter Server to a Linked Mode Group,” on page 54
- “Isolate a vCenter Server Instance from a Linked Mode Group,” on page 54
- “Change the Domain of a vCenter Server System in a Linked Mode Group,” on page 54
- “Configure the URLs on a Linked Mode vCenter Server System,” on page 55
- “Monitor vCenter Server Services,” on page 55

Linked Mode Prerequisites for vCenter Server

Prepare the vCenter Server system for joining a Linked Mode group.

Before joining a vCenter Server to a Linked Mode group, review “Linked Mode Considerations for vCenter Server,” on page 52.

All the requirements for standalone vCenter Server systems apply to Linked Mode systems.
The following requirements apply to each vCenter Server system that is a member of a Linked Mode group:

- Linked Mode groups that contain both vCenter Server 5.0 and earlier versions of vCenter Server are not supported. The vSphere Client does not function correctly with vCenter Servers in groups that have both version 5.0 and earlier versions of vCenter Server. Do not join a version 5.0 vCenter Server to earlier versions of vCenter Server, or an earlier version of vCenter Server to a version 5.0 vCenter Server. Upgrade any vCenter Server instance to version 5.0 before joining it to a version 5.0 vCenter Server.

- To join a Linked Mode group the vCenter Server must be in evaluation mode or licensed as a Standard edition. vCenter Server Foundation and vCenter Server Essentials editions do not support Linked Mode.

- DNS must be operational for Linked Mode replication to work.

- The vCenter Server instances in a Linked Mode group can be in different domains if the domains have a two-way trust relationship. Each domain must trust the other domains on which vCenter Server instances are installed.

- When adding a vCenter Server instance to a Linked Mode group, the installer must be run by a domain user who is an administrator on both the machine where vCenter Server is installed and the target machine of the Linked Mode group.

- All vCenter Server instances must have network time synchronization. The vCenter Server installer validates that the machine clocks are not more than five minutes apart.

### Linked Mode Considerations for vCenter Server

Consider several issues before you configure a Linked Mode group.

Before you configure a Linked Mode group, consider the following issues.

- If you upgrade a vCenter Server that is part of a Linked Mode group, it will be removed from the group. vCenter Server does not support Linked Mode groups that contain both version 5.0 and earlier versions of vCenter Servers. After all vCenter Servers in the group are upgraded to version 5.0, you can rejoin them.

- Each vCenter Server user sees the vCenter Server instances on which they have valid permissions.

- When you set up your vCenter Server Linked Mode group, you must install the first vCenter Server as a standalone instance because you do not yet have a remote vCenter Server machine to join. Subsequent vCenter Server instances can join the first vCenter Server or other vCenter Server instances that have joined the Linked Mode group.

- If you join a vCenter Server to a standalone instance that is not part of a domain, you must add the standalone instance to a domain and add a domain user as an administrator.

- The vCenter Server instances in a Linked Mode group do not need to have the same domain user login. The instances can run under different domain accounts. By default, they run as the LocalSystem account of the machine on which they are running, which means that they are different accounts.

- During vCenter Server installation, if you enter an IP address for the remote instance of vCenter Server, the installer converts it into a fully qualified domain name.

- You cannot join a Linked Mode group during the upgrade procedure when you are upgrading from VirtualCenter 25 to vCenter Server 5.0. You can join after the upgrade to vCenter Server is complete.

---

**CAUTION** If you need to uninstall and reinstall vCenter Server on more than one member of a Linked Mode group, do so with a single vCenter Server at a time. Uninstalling and reinstalling multiple linked vCenter Servers at the same time is not supported, and can cause errors that prevent vCenter Server from connecting to vCenter Inventory Service. If it is necessary to uninstall and reinstall multiple linked vCenter Servers at the same time, isolate them from the Linked Mode group first, and rejoin them to the Linked Mode group after the reinstallation is complete.
Join a Linked Mode Group After Installation

After installing vCenter Server, you can join a vCenter Server to a Linked Mode group.

**Prerequisites**

See “Linked Mode Prerequisites for vCenter Server,” on page 51.

**Note** Joining a version 5.0 vCenter Server to older versions of vCenter Server is not supported.

**Procedure**

1. Select **Start > All Programs > VMware > vCenter Server Linked Mode Configuration**.
2. Click **Next**.
3. Select **Modify linked mode configuration** and click **Next**.
4. Click **Join this vCenter Server instance to an existing linked mode group or another instance** and click **Next**.
5. Enter the server name and LDAP port number of a remote vCenter Server instance that is a member of the group and click **Next**.
   
   If you enter an IP address for the remote server, the installer converts it into a fully qualified domain name.
6. If the vCenter Server installer detects a role conflict, select how to resolve the conflict.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes, let VMware vCenter Server resolve the conflicts for me</td>
<td>Click <strong>Next</strong>. The role on the joining system is renamed to ( vcenter_namerole_name ), where ( vcenter_name ) is the name of the vCenter Server system that is joining the Linked Mode group, and ( role_name ) is the name of the original role.</td>
</tr>
</tbody>
</table>
| No, I'll resolve the conflicts myself        | To resolve the conflicts manually:  
   a Using the vSphere Client, log in to one of the vCenter Server systems using an account with **Administrator** privileges.  
   b Rename the conflicting role.  
   c Close the vSphere Client session and return to the vCenter Server installer.  
   d Click **Back** and click **Next**.  
   The installation continues without conflicts. |

A conflict results if the joining system and the Linked Mode group each contain a role with the same name but with different privileges.

7. Click **Finish**.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode might take from a few seconds to a few minutes to complete.

The vCenter Server instance is now part of a Linked Mode group. After you form a Linked Mode group, you can log in to any single instance of vCenter Server and view and manage the inventories of all the vCenter Servers in the group. It might take several seconds for the global data (such as user roles) that are changed on one machine to be visible on the other machines. The delay is usually 15 seconds or less. It might take a few minutes for a new vCenter Server instance to be recognized and published by the existing instances, because group members do not read the global data very often.
Reconciling Roles When Connecting vCenter Server to a Linked Mode Group

When you join a vCenter Server system to a linked mode group, the roles defined on each vCenter Server system in the group are replicated to the other systems in the group.

If the roles defined on each vCenter Server system are different, the roles lists of the systems are combined into a single common list. For example, if vCenter Server 1 has a role named Role A and vCenter Server 2 has a role named Role B, then both servers will have both Role A and Role B after they are joined in a linked mode group.

If two vCenter Server systems have roles with the same name, the roles are combined into a single role if they contain the same privileges on each vCenter Server system. If two vCenter Server systems have roles with the same name that contain different privileges, this conflict must be resolved by renaming at least one of the roles. You can choose to resolve the conflicting roles either automatically or manually.

If you choose to reconcile the roles automatically, the role on the joining system is renamed to vcenter_namerole_name where vcenter_name is the name of the vCenter Server system that is joining the Linked Mode group and role_name is the name of the original role.

If you choose to reconcile the roles manually, connect to one of the vCenter Server systems with the vSphere Client and rename one instance of the role before proceeding to join the vCenter Server system to the Linked Mode group.

If you remove a vCenter Server system from a linked mode group, the vCenter Server system retains all the roles it had as part of the group.

Isolate a vCenter Server Instance from a Linked Mode Group

You can isolate a vCenter Server instance from a Linked Mode group.

Procedure
1. Select Start > All Programs > VMware > vCenter Server Linked Mode Configuration.
2. Click Modify linked mode configuration and click Next.
3. Click Isolate this vCenter Server instance from linked mode group and click Next.
4. Click Continue and click Finish.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode configuration might take from a few seconds to a few minutes to complete.

The vCenter Server instance is no longer part of the Linked Mode group.

Change the Domain of a vCenter Server System in a Linked Mode Group

To change the domain of a vCenter Server system in a Linked Mode group, isolate the vCenter Server system from the Linked Mode group first.

vCenter Server systems in a Linked Mode group can be in different domains if the domains have a trust relationship.

Procedure
1. Isolate the vCenter Server system from the Linked Mode group.
2. Change the domain of the vCenter Server system.

Refer to the documentation for the operating system on which vCenter Server is installed for more information on changing the domain.
Rejoin the vCenter Server system to the Linked Mode group.

**Configure the URLs on a Linked Mode vCenter Server System**

If you connect a vCenter Server system to a Linked Mode group and the vCenter Server system has a machine name that does not match the domain name, several connectivity problems arise. Correct this situation by changing the URLs.

If you do not update the URLs, remote instances of vCenter Server cannot reach the vCenter Server system, because the default vCenter Server URL entries are no longer accurate. The vCenter Server installer configures default URL entries as follows:

- For the Virtualcenter.VimApiUrl key, the default value is `http(s)://Fully qualified domain name (FQDN) of vCenter Server machine/sdkvCenter Server`.
- For the Virtualcenter.VimWebServicesUrl key, the default value is `https://FQDN of vCenter Server machine:installed-webservices-port/vwsvCenter Server`.

**Procedure**

1. Isolate the vCenter Server system from the Linked Mode group.
   
   See “Isolate a vCenter Server Instance from a Linked Mode Group,” on page 54

2. Change the domain name or the machine name to make them match.

3. From the vSphere Client, connect directly to the vCenter Server instance on which you have changed the domain or machine name.

4. Select Administration > vCenter Server Settings and click Advanced Settings.

5. For the Virtualcenter.VimApiUrl key, change the value to point to the location where the vSphere Client and SDK clients can access the vCenter Server system.
   
   For example: `http(s)://machine-name/IP address:vc-port/sdk`.

6. For the Virtualcenter.VimWebServicesUrl key, change the value to point to the location where vCenter Server Webservices is installed.
   
   For example: `https://machine-name/ip:webservices-port/vws`.

7. For the Virtualcenter.Instancename key, change the value so that the modified name appears in the vCenter Server inventory view.

8. Rejoin the vCenter Server system to the Linked Mode group.
   
   See “Join a Linked Mode Group After Installation,” on page 53.

The URLs are now correctly configured.

**Monitor vCenter Server Services**

When you are logged in to a vCenter Server system that is part of a connected group, you can monitor the health of services running on each server in the group.

**Procedure**

- From the vSphere Client Home page, click **vCenter Service Status**.

  You can view the following information in the status window:

  - A list of vCenter Server systems and their services, and vCenter Server plug-ins.
  - Status of all listed items.
  - Date and time when the last change in status occurred.
- Messages associated with the change in status.
Plan how you will set up your virtual infrastructure. A large vSphere implementation might contain several virtual datacenters with a complex arrangement of hosts, clusters, resource pools, and networks. It might involve multiple vSphere Servers operating in Linked Mode. Smaller implementations might require a single virtual datacenter with a much less complex topology. Regardless of the scale of your virtual infrastructure, consider how the virtual machines it will support are going to be used and administered.

Here are questions you should answer as you create and organize an inventory of virtual objects:

- Will some virtual machines require dedicated resources?
- Will some virtual machines experience periodic spikes in workload?
- Will some virtual machines need to be administered as a group?
- Do you want to use multiple Distributed Switches?
- Do you want to use vMotion and Distributed Resource Management with certain virtual machines but not others?
- Will some virtual objects require one set of system permissions, while other objects will require a different set of permissions?

The left pane of the vSphere Client displays your vSphere inventory. You can add and arrange objects in any way with the following restrictions:

- The name of an inventory object must be unique with its parent.
- vApp names must be unique within the Virtual Machines and Templates view.
- System permissions are inherited and cascade.

Populating and organizing your inventory involves the following activities:

This chapter includes the following topics:

- “Create Datacenters,” on page 58
- “Add Hosts,” on page 58
- “Create Clusters,” on page 59
- “Create Resource Pools,” on page 60
- “Create a Resource Pool in the vSphere Web Client,” on page 60
- “Create a Folder in the vSphere Web Client,” on page 61
- “Create Datastores,” on page 61
- “Create Host-Wide Networks,” on page 62
Create Datacenters

A virtual datacenter is a container for all the inventory objects required to complete a fully functional environment for operating virtual machines. You can create multiple datacenters to organize sets of environments. For example, you might create a datacenter for each organizational unit in your enterprise or create some datacenters for high performance environments and others for less demanding virtual machines.

Prerequisites

- Open a vSphere Client session to a vCenter Server.
- Verify that you have sufficient permissions to create a datacenter object.

Note: Inventory objects can interact within a datacenter, but interaction across datacenters is limited. For example, you can hot migrate virtual machines from one host to another host in the same datacenter, but not from a host in one datacenter to a host in a different datacenter.

Procedure

1. Go to Home > Inventory > Hosts and Clusters.
2. Select File > New > Datacenter.
3. Rename the datacenter.

What to do next

Add hosts, clusters, resource pools, vApps, networking, datastores, and virtual machines to the datacenter.

Add Hosts

You can add hosts under a datacenter object, folder object, or cluster object. If a host contains virtual machines, those virtual machines are added to the inventory together with the host. Information about configuring hosts is located in the vSphere Networking, vSphere Storage, vSphere Security, and vSphere Host Profiles documentation.

Prerequisites

- Open a vSphere Client session to a vCenter Server.
- Verify that you have sufficient permissions to create a host object.
- Verify that a Datacenter, folder, or cluster exists in the inventory.
- Obtain the user name and password for an account with administrative privileges on the host.
- Verify that hosts behind a firewall are able to communicate with the vCenter Server system and all other hosts through port 902 or other custom-configured port.
- Verify that all NFS mounts on the host are active.

Procedure

1. Select Home > Inventory > Hosts and Clusters.
2. Select a datacenter, cluster, or folder within a datacenter.
4. Enter host name or IP address and administrator credentials and click Next.
(Optional) Select **Enable Lockdown Mode** to disable remote access for the administrator account after vCenter Server takes control of this host.

Selecting this check box ensures that the host is managed only through vCenter Server. You can perform certain management tasks while in lockdown mode by logging into the local console on the host.

6 Review host information and click **Next**.

7 (Optional) Assign a license key to the host if needed and click **Next**.

8 Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are adding the host to a cluster</td>
<td>Select a resource pool option and click <strong>Next</strong>.</td>
</tr>
<tr>
<td>If you are not adding the host to a cluster</td>
<td>Select a location where you want to place virtual machines that already exist on the host and click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

9 Review the summary information and click **Finish**.

The host and its virtual machines are added to the inventory.

### Create Clusters

A cluster is a group of hosts. When a host is added to a cluster, the host’s resources become part of the cluster’s resources. The cluster manages the resources of all hosts within it. Clusters enable the vSphere High Availability (HA) and vSphere Distributed Resource Scheduler (DRS) solutions.

#### Prerequisites

- Open vSphere Client session to a vCenter Server.
- Verify that you have sufficient permissions to create a cluster object.
- Verify that a Datacenter, or folder within a datacenter, exists in the inventory.

#### Procedure

1 Right-click a datacenter or folder in the vSphere Client and select **New Cluster**.

2 Enter a name for the cluster.

3 Choose cluster features.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you chose to use DRS with this cluster</td>
<td>a Click the <strong>vSphere DRS</strong> box.</td>
</tr>
<tr>
<td></td>
<td>b Select an automation level and a migration level and click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>c Select a default power management setting and a DPM threshold, and click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you chose to use HA with this cluster</td>
<td>a Click <strong>vSphere HA</strong>.</td>
</tr>
<tr>
<td></td>
<td>b Select whether to enable host monitoring and admission control.</td>
</tr>
<tr>
<td></td>
<td>c If admission control is enabled, specify a policy.</td>
</tr>
<tr>
<td></td>
<td>d Click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>e Specify cluster default behavior and click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>f Specify virtual machine monitoring settings and click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

4 Select an Enhanced vMotion Compatibility (EVC) setting and click **Next**.

EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines, even if the actual CPUs on the hosts differ. This prevents migrations with vMotion from failing due to incompatible CPUs.
5  Select a swap file policy and click **Next**.

6  Review the options you selected for the cluster and click **Finish**.

The cluster is added to the inventory.

**What to do next**

Add hosts and resource pools to the cluster.

---

### Create Resource Pools

You can use resource pools to hierarchically partition available CPU and memory resources of a standalone host or a cluster. Use resource pools to aggregate resources and set allocation policies for multiple virtual machines, without the need to set resources on each virtual machine.

**Prerequisites**

- Verify that the vSphere Client is connected to a vCenter Server system. If the client is connected directly to a host, you cannot create a resource pool.
- Make sure you have permissions sufficient to create a resource pool object.
- Verify that a cluster, vApp, or other resource pool object is parent to the resource pool.

**Procedure**

1  Select **Home > Inventory > Hosts and Clusters**.

2  Select a cluster, vApp, or resource pool.

3  Select **File > New > Resource Pool**.

4  Enter a name and specify resource settings.

5  Click **OK**.

The resource pool is added to the inventory.

**What to do next**

Add virtual machines and vApps to your resource pool.

---

### Create a Resource Pool in the vSphere Web Client

You can use resource pools to hierarchically partition available CPU and memory resources of a standalone host or a cluster. You can use resource pools to aggregate resources and set allocation policies for multiple virtual machines, without setting resources on each virtual machine.

You can create a child resource pool of a standalone host, resource pool, vApp, or DRS cluster. You cannot create resource pools in a cluster that is not enabled for DRS.

**Prerequisites**


**Procedure**

1  In the Hosts and Clusters view of the vSphere Web Client inventory tree, select the parent object for the resource pool.

2  Click the All Actions icon (🔧) and select **Inventory > New Resource Pool**.
3 Type a name to identify the resource pool.

4 Specify how to allocate CPU and memory resources.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shares</td>
<td>Specify shares for this resource pool with respect to the parent’s total resources.Sibling resource pools share resources according to their relative share values bounded by the reservation and limit.</td>
</tr>
<tr>
<td></td>
<td>- Select Low, Normal, or High to specify share values respectively in a 1:2:4 ratio.</td>
</tr>
<tr>
<td></td>
<td>- Select Custom to give each virtual machine a specific number of shares, which expresses a proportional weight.</td>
</tr>
<tr>
<td>Reservation</td>
<td>Specify a guaranteed CPU or memory allocation for this resource pool and select the units for this reservation from the drop-down menu. A nonzero reservation is subtracted from the unreserved resources of the parent (host or resource pool). The resources are considered reserved, regardless of whether virtual machines are associated with the resource pool.</td>
</tr>
<tr>
<td>Reservation Type</td>
<td>When the Expandable check box is selected (default), expandable reservations are considered during admission control. If you power on a virtual machine in this resource pool, and the combined reservations of the virtual machines are larger than the reservation of the resource pool, the resource pool can use resources from its parent or ancestors.</td>
</tr>
<tr>
<td>Limit</td>
<td>Specify the upper limit for this resource pool’s CPU or memory allocation by typing a value or selecting a value from the drop-down menu.</td>
</tr>
</tbody>
</table>

5 Click OK.

Create a Folder in the vSphere Web Client

You can use folders to group objects of the same type for easier management.

A folder can contain other folders, or a group of objects of the same type. For example, a single folder can contain virtual machines and another folder containing virtual machines, but it cannot contain hosts and a folder containing virtual machines.

Only virtual machine folders can be created in the vSphere Web Client.

Procedure

1 In the Virtual Machines and Templates view of the vSphere Web Client inventory tree, select the parent location for the folder.

2 Click the All Actions icon ( ) and select Inventory > New Folder.

3 Click the new folder, type the name for the folder, and press Enter.

Create Datastores

A datastore is a logical container that holds virtual machine files and other files necessary for virtual machine operations. Datastores can exist on different types of physical storage, including local storage, iSCSI, Fibre Channel SAN, or NFS. A datastore can be VMFS-based or NFS-based.

Prerequisites

- Open a vSphere Client session to a vCenter Server.
- Verify that you have sufficient permissions to create a datastore object.
- Verify that at least one host in the inventory has access to physical storage.
Procedure

1. Select Home > Inventory > Datastores.
2. Right-click on a datacenter and select Add Datastore.
3. Select a host and click Next.
4. Select a type of storage and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk or LUN</td>
<td>a) Select a disk or LUN and click Next.</td>
</tr>
<tr>
<td></td>
<td>b) Review the disk layout information and click Next.</td>
</tr>
<tr>
<td></td>
<td>c) Enter a name for the datastore and click Next.</td>
</tr>
<tr>
<td></td>
<td>d) Specify maximum file and block sizes.</td>
</tr>
<tr>
<td></td>
<td>e) Specify disk or LUN capacity and click Next.</td>
</tr>
<tr>
<td>Network File System</td>
<td>a) Enter server and folder information.</td>
</tr>
<tr>
<td></td>
<td>b) Select whether clients should mount the NFS as read-only.</td>
</tr>
<tr>
<td></td>
<td>c) Enter a name and click Next.</td>
</tr>
</tbody>
</table>

5. Review summary information and click Finish.

A datastore is added to the inventory.

Create Host-Wide Networks

In vSphere, you can create standard networks and distributed networks. Standard networks provide a method of communication among the virtual machines on a standalone host and consist of standard switches and port groups. Distributed networks aggregate the networking capabilities of multiple hosts and enable virtual machines to keep consistent network configuration as they migrate across hosts. Distributed networks consist of vSphere Distributed Switches, uplink port groups, and port groups.

Prerequisites

- Open a vSphere Client connection to a vCenter Server.
- Verify that you have sufficient permissions to create a standard switch.
- Verify that a host exists in the inventory.

Procedure

1. Select a host from the inventory.
2. Click the Configuration tab.
3. Click Networking.
4. Click Virtual Switch.
5. Click Add Networking.
6. Select a connection type.
7. Select an existing virtual switch or create one.
8. Enter a display label for the port group on the switch.
9. Select a VLAN ID.
10. Review your settings and click Finish.

If you chose to use an existing standard switch, a new port group is added to it. If you chose to create a standard switch, it is added with a port group.
Create Datacenter-Wide Networks

In vSphere, you can create standard networks and distributed networks. Standard networks provide a method of communication among the virtual machines on a standalone host and consist of standard switches and port groups. Distributed networks aggregate the networking capabilities of multiple hosts and enable virtual machines to keep consistent network configuration as they migrate across hosts. Distributed networks consist of vSphere Distributed Switches, uplink port groups, and port groups.

Prerequisites

- Open a vSphere Client connection to a vCenter Server.
- Verify that you have sufficient permissions to create a standard switch.
- Verify that a host exists in the inventory.

Procedure

1. Select Home > Inventory > Networking view, and select a datacenter.
2. Click New vNetwork Distributed Switch in the toolbar.
3. Select a version and click Next.
4. Enter a display name for the switch.
5. Specify the maximum number of physical adapters per host (uplink ports) and click Next.
6. Add hosts and their physical network adapters to the switch and click Next.
7. Choose whether you want vSphere to automatically create a port group and click Finish.

A vSphere Distributed Switch, with its associated uplink ports and port groups, is added to the inventory.

What to do next

- Add hosts to the switch.
- Add port groups to the switch.
- Edit switch properties.

Edit General vSphere Distributed Switch Settings

You can edit the general settings for a vSphere distributed switch, such as the distributed switch name and the number of uplink ports on the distributed switch.

Procedure

1. Log in to the vSphere Client and select the Networking inventory view.
2. Right-click the vSphere distributed switch in the inventory pane, and select Edit Settings.
3. Select General to edit the vSphere distributed switch settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type the name for the distributed switch.</td>
</tr>
<tr>
<td>Number of Uplink Ports</td>
<td>Select the number of uplink ports for the distributed switch.</td>
</tr>
<tr>
<td>Notes</td>
<td>Type any notes for the distributed switch.</td>
</tr>
</tbody>
</table>
4. (Optional) Edit uplink port names.
   a. Click Edit uplink names.
   b. Type new names for one or more uplink ports.
   c. Click OK.

5. Click OK.

**Edit Advanced vSphere Distributed Switch Settings**

You can change advanced vSphere distributed switch settings such as Cisco Discovery Protocol and the maximum MTU for the vSphere distributed switch.

**Procedure**

1. Log in to the vSphere Client and select the Networking inventory view.
2. Right-click the vSphere distributed switch in the inventory pane, and select Edit Settings.
3. Select Advanced to edit the following vSphere distributed switch settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum MTU</td>
<td>Maximum MTU size for the vSphere distributed switch.</td>
</tr>
<tr>
<td>Discovery Protocol Status</td>
<td>Choose the status for discovery protocol on the vSphere distributed switch.</td>
</tr>
<tr>
<td></td>
<td>* Enabled. Enabled discovery protocol for the vSphere distributed switch.</td>
</tr>
<tr>
<td></td>
<td>1. Select Cisco Discovery Protocol or Link Layer Discovery Protocol</td>
</tr>
<tr>
<td></td>
<td>from the Type drop-down menu.</td>
</tr>
<tr>
<td></td>
<td>2. Set Operation to Listen, Advertise, or Both.</td>
</tr>
<tr>
<td></td>
<td>* Disabled.</td>
</tr>
<tr>
<td>Admin Contact Info</td>
<td>Enter the Name and Other Details for the vSphere distributed switch administrator.</td>
</tr>
</tbody>
</table>

4. Click OK.

**Add Hosts to a vSphere Distributed Switch**

You can add hosts and physical adapters to a vSphere distributed switch at the distributed switch level after it is created.

**Procedure**

1. Log in to the vSphere Client and select the Networking inventory view.
2. Right-click the vSphere distributed switch in the inventory pane, and select Add Host.
3. Select the hosts to add.
4. Under the selected hosts, select the physical adapters to add and click Next.
   You can select physical adapters that are not being used and physical adapters that are being used.

   **Note** Moving a physical adapter to a distributed switch without moving any associated virtual adapters can cause those virtual adapters to lose network connectivity.

5. For each virtual adapter, select Destination port group and select a port group from the drop-down menu to migrate the virtual adapter to the distributed switch or select Do not migrate.
6 (Optional) Set the maximum number of ports on a host.
   a Click View Details for the host.
   b Select the maximum number of ports for the host from the drop-down menu.
   c Click OK.
7 Click Next.
8 (Optional) Migrate virtual machine networking to the distributed switch.
   a Select Migrate virtual machine networking.
   b For each virtual machine, select Destination port group and select a port group from the drop-down menu or select Do not migrate.
9 Click Next.
10 (Optional) If you need to make any changes, click Back to the appropriate screen.
11 Review the settings for the distributed switch and click Finish.

Add a Distributed Port Group
Add a distributed port group to a vSphere distributed switch to create a distributed switch network for your virtual machines.

Procedure
1 Log in to the vSphere Client and select the Networking inventory view.
2 Select Inventory > vSphere Distributed Switch > New Port Group.
3 Enter a Name and the Number of Ports for your new distributed port group.
4 Select a VLAN Type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Do not use VLAN.</td>
</tr>
<tr>
<td>VLAN</td>
<td>In the VLAN ID field, enter a number between 1 and 4094.</td>
</tr>
<tr>
<td>VLAN Trunking</td>
<td>Enter a VLAN trunk range.</td>
</tr>
<tr>
<td>Private VLAN</td>
<td>Select a private VLAN entry. If you did not create any private VLANs, this menu is empty.</td>
</tr>
</tbody>
</table>
5 Click Next.
6 Click Finish.

Edit General Distributed Port Group Settings
You can edit general distributed port group settings such as the distributed port group name and port group type.

Procedure
1 Log in to the vSphere Client and select the Networking inventory view.
2 Right-click the distributed port group in the inventory pane, and select Edit Settings.
3 Select General to edit the following distributed port group settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type the name for the distributed port group.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a brief description of the distributed port group.</td>
</tr>
<tr>
<td>Number of Ports</td>
<td>Type the number of ports on the distributed port group.</td>
</tr>
<tr>
<td>Port binding</td>
<td>Choose when ports are assigned to virtual machines connected to this</td>
</tr>
<tr>
<td></td>
<td>distributed port group.</td>
</tr>
<tr>
<td></td>
<td>▪ Select Static binding to assign a port to a virtual machine when</td>
</tr>
<tr>
<td></td>
<td>the virtual machine connects to the distributed port group. This</td>
</tr>
<tr>
<td></td>
<td>option is not available when the vSphere Client is connected directly</td>
</tr>
<tr>
<td></td>
<td>to ESXi.</td>
</tr>
<tr>
<td></td>
<td>▪ Select Dynamic binding to assign a port to a virtual machine the first</td>
</tr>
<tr>
<td></td>
<td>time the virtual machine powers on after it is connected to the</td>
</tr>
<tr>
<td></td>
<td>distributed port group. Dynamic binding is deprecated in ESXi 5.0.</td>
</tr>
<tr>
<td></td>
<td>▪ Select Ephemeral for no port binding. This option is not available</td>
</tr>
<tr>
<td></td>
<td>when the vSphere Client is connected directly to ESXi.</td>
</tr>
</tbody>
</table>

4 Click OK.

Edit Advanced Distributed Port Group Settings

You can edit advanced distributed port group settings, such as override settings and reset at disconnect.

**Procedure**

1 Log in to the vSphere Client and select the Networking inventory view.
2 Right-click the distributed port group in the inventory pane, and select Edit Settings.
3 Select Advanced to edit the distributed port group properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow override of port</td>
<td>Select this option to allow distributed port group policies to be overridden</td>
</tr>
<tr>
<td>policies</td>
<td>on a per-port level. Click Edit Override Settings to select which policies</td>
</tr>
<tr>
<td></td>
<td>can be overridden at the port level.</td>
</tr>
<tr>
<td>Edit Override Settings</td>
<td>Select which policies can be overridden at the port level.</td>
</tr>
<tr>
<td>Configure reset at disconnect</td>
<td>When a distributed port is disconnected from a virtual machine, the</td>
</tr>
<tr>
<td></td>
<td>configuration of the distributed port is reset to the distributed port group</td>
</tr>
<tr>
<td></td>
<td>setting. Any per-port overrides are discarded.</td>
</tr>
</tbody>
</table>

4 Click OK.
vCenter Server provides licensing infrastructure that you can use for management and reporting of licenses that apply to ESXi hosts, vCenter Server, and certain solutions such as vCenter Site Recovery Manager, vCenter CapacityIQ, vCenter Chargeback, and so on.

Licensing in vCenter Server is implemented using license keys. You can assign one license key to multiple licensable objects of the same type if the key has enough capacity. However, you cannot assign multiple license keys to a single licensable object. For example, you can assign one license key to multiple vCenter Server systems in a Linked Mode group, but you cannot assign multiple license keys to a single vCenter Server system.

ESXi 5.0 hosts, vCenter Server 5.0, and solutions have different licensing models.

- ESXi 5.0 hosts are licensed with vSphere 5.0 license keys that have per-processor capacity with pooled vRAM entitlements. You can assign a vSphere 5.0 license key to multiple ESXi 5.0 hosts if the key has large enough processor capacity to cover all physical processors in the hosts. When you assign a vSphere 5.0 license key to an ESXi 5.0 host, the amount of processor capacity of the key that is consumed is equal to the number of physical processors in the host. vRAM is defined as the memory that is configured to a virtual machine. vRAM entitlements are pooled across all in-use vSphere 5.0 license keys of the same product edition for a single vCenter Server system or a Linked Mode group. A license key is in use if it is assigned to at least one host. The amount of vRAM capacity that each in-use license key contributes to the pool of its vSphere edition is equal to the processor capacity of the key multiplied by the base vRAM entitlement of the corresponding vSphere edition. The vRAM capacity of the pool is consumed only by powered-on virtual machines that run on ESXi 5.0 hosts. Each powered-on virtual machine consumes an amount of vRAM that is equal to its configured memory. If a virtual machine is configured with memory greater than 96GB, the vRAM usage for the virtual machine equals to 96GB. For details about vRAM and how to apply the licensing model for ESXi 5.0 hosts, see “Licensing for ESXi 5.0 Hosts,” on page 69.

- vCenter Server 5.0 systems are licensed with vCenter Server 5.0 license keys that have per-instance capacity type. A license key for vCenter Server determines the number of vCenter Server instances that you can license with the key.

- Solutions are licensed depending on the specific usage and licensing needs of each solution. For example, vCenter Site Recovery Manager, vCenter Capacity IQ, and vCenter Chargeback are licensed on a per-virtual-machine basis.

The licensing infrastructure in vCenter Server provides functions that you can use to implement and monitor the licensing models of ESXi hosts, vCenter Server, and solutions.

- Licensing Terminology and Definitions on page 68

The licensing infrastructure in vCenter Server uses specific terminology and definitions to refer to different licensing-related objects.
ESXi 5.0 hosts are licensed with vSphere 5.0 license keys. vSphere 5.0 license keys have per-processor capacity with pooled vRAM entitlements. vRAM entitlements of vSphere 5.0 licenses are pooled across all assigned vSphere 5.0 license keys of the same product edition for a single vCenter Server system or for a Linked Mode group.

vCenter Server 5.0 systems are licensed with vCenter Server 5.0 license keys that have per-instance capacity.

Solutions can have different licensing models depending on the specifics of every solution.

Upgrading the ESXi or vCenter Server software may require changes in the licensing configuration of ESXi hosts or vCenter Server.

All license keys of ESXi hosts, vCenter Server and solutions are kept in the vCenter Server license inventory. vCenter Server systems in Linked Mode share a common license inventory.

You can control which users can view and manage license resources.

Use the license portal to get upgraded license keys, downgrade license keys, combine the capacity of multiple license keys, divide the capacity of a single license key, view the change history of your license keys, and find lost license keys.

License management is centralized. You can use the vSphere Client to manage all licenses that are available in the license inventory of a vCenter Server system or a Linked Mode group.

You can view the use and capacity of the license keys that are assigned to assets for a period that you select.

The licensing infrastructure in vCenter Server uses specific terminology and definitions to refer to different licensing-related objects.

**License Key**
An alphanumeric sequence of 25 characters in groups of five that are separated by dashes. The license key encodes details for the product it is associated with, the license expiration date, the license capacity, and other information. The license key is entered in the system to activate the product it is associated with.

**Product**
A set of functionality that you can purchase together as a group. Examples of products are vCenter Server, vSphere, and solutions.

**Product Edition**
A set of specific features that are associated with a unique license key. When assigned, the license key unlocks the features in the product edition. Examples of product editions are vSphere Enterprise, vSphere Standard, vCenter Server Essentials, and so on.

**Feature**
Functionality that is enabled or disabled by a license that is associated with a specific product edition. Examples of features are vSphere DRS, vSphere vMotion, vSphere High Availability, and so on.
Solution
A product that is packed and distributed independently from vSphere. You install a solution in vSphere to take advantage of certain functionality. Every solution has a licensing model specific for the solution, but can use the licensing infrastructure of vCenter Server for license management and reporting. Examples of solutions are vCenter CapacityIQ, vCenter Site Recovery Manager, vCenter Chargeback, and so on.

Asset
Any licensable object in vSphere. The license administrator in vSphere can assign one license key to one or multiple assets of the same type if the key has sufficient capacity. Assets are vCenter Server systems, ESXi hosts, and solution instances.

License Key Capacity
Amount of units that you can assign to assets. The units of a license key capacity can be of different types depending on the product that the license key is associated with. For example, a license key for vCenter Server determines the number of vCenter Server instances that you can license with the key.

License Use
The number of units that an asset uses from the capacity of a license key. For example, if you assign a per-virtual-machine license key to vCenter Site Recovery Manager, the license use for Site Recovery Manager is the number of protected virtual machines.

vRAM
The memory that is configured for virtual machines. vSphere 5.0 licenses entitle a certain amount of vRAM capacity. vRAM entitlements are pooled across all assigned vSphere 5.0 license keys of the same product edition for a vCenter Server system or for a Linked Mode group. Only powered-on virtual machines consume vRAM capacity from a vRAM pool. For details about vRAM and vRAM pooling, see “vRAM Entitlement and Pooling,” on page 70.

Licensing for ESXi 5.0 Hosts
ESXi 5.0 hosts are licensed with vSphere 5.0 license keys. vSphere 5.0 license keys have per-processor capacity with pooled vRAM entitlements. vRAM entitlements of vSphere 5.0 licenses are pooled across all assigned vSphere 5.0 license keys of the same product edition for a single vCenter Server system or for a Linked Mode group.

Assigning a vSphere 5.0 License Key
Each vSphere 5.0 license key has a certain processor capacity that you can use to license multiple physical processors on ESXi hosts. When you assign a vSphere license key to a host, the amount of processor capacity that is consumed is equal to the number of physical processors in the host.

vRAM Entitlement and Pooling
Every vSphere 5.0 edition includes a vRAM capacity entitlement. vRAM entitlements are pooled across all assigned vSphere 5.0 licenses of the same edition for a vCenter Server instance or in a Linked Mode group. Only powered-on virtual machines consume vRAM capacity in an amount that is equal to the sum of their configured memory.

Assigning a vSphere 5.0 License Key
Each vSphere 5.0 license key has a certain processor capacity that you can use to license multiple physical processors on ESXi hosts. When you assign a vSphere license key to a host, the amount of processor capacity that is consumed is equal to the number of physical processors in the host.

To license an ESXi 5.0 host, you need to assign it a vSphere 5.0 license key with processor capacity that is sufficient to license all physical processors on the host. For example, to license two ESXi 5.0 hosts that have four processors each, you need to assign a vSphere 5.0 license key with a minimum capacity of 8 processors to the hosts.
If you try to assign a license key that has insufficient capacity to license all physical processors on the host, the license assignment is unsuccessful. In such case, you need to assign a different license key with a larger processor capacity. You need to use a different license key in your inventory or combine your license key with another license key to create a new license key with a larger processor capacity.

You can assign and reassign the processor capacity of a vSphere 5.0 license key to any combination of ESXi 5.0 hosts. For example, suppose that you purchase a vSphere 5.0 license key for 10 processors. You can assign the license key to any of the following combinations of hosts:

- Five 2-processor hosts.
- Three 2-processor hosts and one 4-processor host.
- Two 4-processor hosts and one 2-processor host.
- One 8-processor host and one 2-processor host.

Dual-core and quad-core processors, such as Intel processors that combine two or four independent processors on a single chip, count as one processor.

vRAM Entitlement and Pooling

Every vSphere 5.0 edition includes a vRAM capacity entitlement. vRAM entitlements are pooled across all assigned vSphere 5.0 licenses of the same edition for a vCenter Server instance or in a Linked Mode group. Only powered-on virtual machines consume vRAM capacity in an amount that is equal to the sum of their configured memory.

The vRAM capacity of a vSphere 5.0 license key equals the vRAM entitlement of the license edition multiplied by the processor capacity of the license key. For example, vSphere 5.0 Standard entitles to a 32GB of vRAM. A license key of vSphere 5.0 Standard with capacity for 10 processor entitles to a vRAM capacity of 320GB.

- vRAM Pooling on page 70
  The amount of vRAM that vSphere 5.0 license keys provide is aggregated into vRAM pools for every license edition when the license keys are assigned to ESXi 5.0 hosts.

- Calculating the vRAM Usage on page 71
  The vRAM usage equals the sum of memory that is configured on powered-on virtual machines that run on ESXi 5.0 hosts. The vRAM usage is calculated for every vRAM pool that is available in a vCenter Server system or a Linked Mode group.

- Compliance Rules on page 71
  No restriction exist for the number of virtual machines that can consume the available capacity in a vRAM pool. No restriction exists on how virtual machines are distributed across all hosts in a vRAM pool either. However, you must maintain the ESXi 5.0 in your environment in compliance with the vSphere 5.0 licensing model.

- Extending a vRAM Pool on page 72
  If the amount of vRAM that is available in the vRAM pools in your virtual environment is insufficient, you can extend the vRAM pools to keep them in compliance with the licensing model of vSphere 5.0 products.

vRAM Pooling

The amount of vRAM that vSphere 5.0 license keys provide is aggregated into vRAM pools for every license edition when the license keys are assigned to ESXi 5.0 hosts.

When you assign a vSphere 5.0 license key to one or more ESXi 5.0 hosts, the key adds its vRAM capacity to a vRAM pool. For example, if you assign a license key of vSphere 5.0 Standard with a capacity of 10 processors and vRAM capacity of 320GB, the key adds 320GB of vRAM to the pool for vSphere Standard.
A vRAM pool aggregates all vRAM entitlements of vSphere 5.0 license keys of one edition that are assigned to ESXi 5.0 hosts. A vRAM pool for one license edition is available for one vCenter Server or a Linked Mode group. The amount of vRAM that is available in a vRAM pool for a license edition determines the total amount of memory that you can provision on powered-on virtual machines running on ESXi 5.0 hosts.

For example, you assign license key A of vSphere 5.0 Standard to an ESXi 5.0 host. The key has a capacity of six processors and entitles 32GB of vRAM. The vRAM pool that is created for vSphere Standard contains 192GB of vRAM that license key A provides. Later, you assign license key B of vSphere Standard to another ESXi 5.0 host. License key B has a capacity for 10 processors and entitles 32GB of vRAM. License key B adds 320GB of vRAM to the vRAM pool for vSphere Standard. The total amount of vRAM that is available in the vRAM pool for vSphere Standard is the sum from the vRAM entitlements of license key A and license key B, which is 512GB. In this example, you can provision up to 512GB of memory on the virtual machines that run on the ESXi 5.0 hosts that are licensed with vSphere 5.0 Standard license keys.

Calculating the vRAM Usage

The vRAM usage equals the sum of memory that is configured on powered-on virtual machines that run on ESXi 5.0 hosts. The vRAM usage is calculated for every vRAM pool that is available in a vCenter Server system or a Linked Mode group.

For example, suppose that the vRAM pool for vSphere Standard contains 320GB of vRAM. On the ESXi 5.0 hosts that are licensed with vSphere 5.0 Standard, you can create and power on 50 virtual machines each with 4GB of configured memory. The total amount of memory that is provisioned on the new virtual machines is 200GB, and the vRAM usage for the vRAM pool for vSphere Standard is 200GB.

Note If any of your virtual machines have more than 96GB of configured memory, the amount of memory above 96GB does not count against vRAM. For example, if you power on two virtual machines each with 100GB of configured memory, the vRAM usage for the virtual machines is 192GB.

Compliance Rules

No restriction exist for the number of virtual machines that can consume the available capacity in a vRAM pool. No restriction exists on how virtual machines are distributed across all hosts in a vRAM pool either. However, you must maintain the ESXi 5.0 in your environment in compliance with the vSphere 5.0 licensing model.

Two requirements must be satisfied to maintain compliance with the vSphere 5.0 licensing model.

- Every physical processor in an ESXi host that runs vSphere 5.0 must be licensed.
- The 365-day moving average of daily high watermark of the vRAM usage for a vRAM pool must be equal to or less than the amount of available vRAM capacity in the pool.

The 365-day moving average of daily high watermark for a vRAM pool is calculated by using the maximum usage for the pool for each of the past 365 days to calculate the average value. You can track the 365-day moving average by using the license reporting function in vCenter Server. To view the value of the 365-day moving average for a vRAM pool, you can view the vRAM usage for the corresponding vSphere product edition for a period of one year. Using the license reporting function, you can also set custom thresholds for the license usage of particular products to get notifications when the license usage for the products exceeds certain limits. For details about using the license reporting function in vCenter Server, see “Viewing License Use,” on page 81.

Because licensing compliance for vSphere 5.0 is based on the 365-day moving average, temporary peaks of vRAM usage might exceed the total capacity that is available in a vRAM pool without making the pool out of compliance. For example, suppose the vRAM usage for vSphere 5.0 Standard on the current date is 210GB, and the available vRAM in the pool for vSphere 5.0 Standard is 200BG. However, the 365-day of moving average for vSphere 5.0 Standard is 195GB and the vRAM pool for vSphere Standard is in compliance.
vSphere 5.0 Essentials and Essentials Plus Kits

If you have vSphere 5.0 Essentials or Essential Plus kits, you cannot use more than 192GB of vRAM for powered-on virtual machines. If the memory that is configured to powered-on virtual machines reaches 192GB, you cannot power on any new virtual machines or hot add memory to already powered-on virtual machines.

Extending a vRAM Pool

If the amount of vRAM that is available in the vRAM pools in your virtual environment is insufficient, you can extend the vRAM pools to keep them in compliance with the licensing model of vSphere 5.0 products.

You can extend a vRAM pool of a certain license edition in three ways.

- Assign new license keys of the same edition to unlicensed ESXi 5.0 hosts. To increase the vRAM pool for vSphere Standard, you can assign another license key of vSphere Standard to an unlicensed ESXi 5.0 host. In this case, the key adds its vRAM capacity to the vRAM pool for vSphere Standard.

- Assign a license key of the same edition and a larger processor capacity to ESXi 5.0 hosts. You can use the VMware License Portal to create a license key with a larger processor capacity by combining the capacities of an already assigned license key and a new key. You can combine the capacities of only license keys that are of the same vSphere 5.0 edition. To extend the vRAM pool for the corresponding license edition, you can remove the old license key from the ESXi 5.x hosts and license them with the key that you created by using the License Portal. For example, suppose that you license a group of ESXi 5.0 hosts with license key A of vSphere Standard. License key A has a capacity of 10 processors and adds 320GB of vRAM to the pool for vSphere Standard. The 365-day moving average for the vRAM usage reaches 320GB. You purchase license key B of vSphere Standard that has a capacity of 15 processors corresponding to a vRAM entitlement of 160GB. You use the VMware Licensing Portal to combine the capacities of license key A and B to create license key C of vSphere Standard that has a capacity of 15 processors. You remove license key A from the ESXi 5.0 hosts and assign them the new license key C. Respectively, the vRAM pool for vSphere Standard is extended to 480GB.

- Upgrade the editions of the license keys that are assigned to ESXi 5.0 hosts. For example, you can upgrade the license keys from vSphere Standard to vSphere Enterprise. License keys of vSphere Enterprise entitle 64GB of vRAM.

Licensing for vCenter Server 5.0

vCenter Server 5.0 systems are licensed with vCenter Server 5.0 license keys that have per-instance capacity.

To license a single vCenter Server 5.0, you need a vCenter Server 5.0 license key with a capacity for one instance. If you have vCenter Server systems in a Linked Mode group, you can purchase a vCenter Server license key with a larger capacity and assign the key to all vCenter Server systems in the group.

**NOTE** If you license vCenter Server 5.0 with vCenter Server Standard or Foundation licenses, vCenter Server restricts managing hosts that are licensed with vSphere Essentials or Essentials Plus license keys.

Solution Licensing

Solutions can have different licensing models depending on the specifics of every solution.

Every solution that integrates its license management in vCenter Server is licensed on a different basis. Some solutions can be licensed on per-instance basis, others can be licensed on per-virtual machine basis. For example, vCenter Site Recovery Manager 5.0 is licensed on per-virtual machine basis. A license key for Site Recovery Manager 5.0 defines the number of virtual machines that you can protect.

For information about the licensing model of a certain solution, see the documentation for that solution.
Licensing ESXi Hosts and vCenter Server After Upgrade

Upgrading the ESXi or vCenter Server software may require changes in the licensing configuration of ESXi hosts or vCenter Server.

When you apply a minor upgrade or patch to the ESXi or vCenter Server software, you do not need to replace the existing license key with a new one. If you apply a major upgrade to ESXi or vCenter Server, you need to apply a new license key. For example, if you upgrade an ESXi host from 4.x to 5.x, you need to license the host with a vSphere 5.x license. Similarly, if you upgrade vCenter Server from 4.x to 5.x, you must assign a vCenter Server 5.x license.

If you upgrade the edition of the license, for example, from vSphere Standard to vSphere Enterprise, you must replace the existing license key on the assets with the upgraded license key.

ESX/ESXi 3.5 hosts require a license server to manage host-based license files. If you upgrade all your ESX/ESXi 3.5 hosts to 4.0 and later, you do not need a license server.

vCenter Server License Inventory

All license keys of ESXi hosts, vCenter Server and solutions are kept in the vCenter Server license inventory. vCenter Server systems in Linked Mode share a common license inventory.

The license inventories in the vCenter Server systems maintain work slightly differently, depending on whether you have Linked Mode groups or standalone systems.

These examples are specific to ESXi hosts and might not apply to solutions.

Example: Uninstallation Scenarios

1. You uninstall vCenter Server without first unlicensing and removing the hosts.
2. The hosts remain licensed.
3. You add the licensed hosts to another vCenter Server instance.
4. The license keys are transferred with the hosts.

A slightly different scenario:

1. You uninstall vCenter Server keeping all hosts licensed.
2. You reinstall vCenter Server and make it part of a different Linked Mode group.
3. The host license keys from the previous group are not transferred to the new group.
4. You add hosts that were licensed by the previous vCenter Server group to the new group.
5. The host license keys are transferred to the new group.
6. The host license keys now belong to two Linked Mode groups. If the total assignment of the key exceeds the key’s capacity, this scenario is not supported and causes your license usage to be out of compliance.

Example: Standalone Scenario

Each vCenter Server instance maintains its own license inventory. If you add an ESXi host to vCenter Server and add the same host to another vCenter Server instance, the host license key moves from the first inventory to the second inventory.

1. You have two vCenter Server instances that are standalone.
2. You assign a license to a host in one vCenter Server instance.
3. You add the host to another vCenter Server instance and retain the license when you add a host.
4 The host license key belongs to two separate license inventories. If the total assignment of the key exceeds the key’s capacity, this scenario is not supported and causes your license use to be out of compliance.

**Example: Linked Mode Scenario**

1 You have two vCenter Server instances that belong to the same Linked Mode group.
2 You assign a license to a host in one vCenter Server instance.
3 The two vCenter Server instances share a single license inventory.
4 When you add a license key, the key becomes available to all the vCenter Server systems within the same Linked Mode group. The license keys are shared, and each system in the group has the same inventory view, although this might not always seem so because of replication delays.

**License Management Permissions**

You can control which users can view and manage license resources.

The following permission types are supported.

- **Global.Licenses**
  
  If you have global permission at the root folder, you can view and modify all licenses in the vCenter Server inventory. This permission includes other vCenter Server systems in a Linked Mode group.

- **Read-only**
  
  If you have read-only permission on a host, the vCenter Server displays the first and last five characters of the license key assigned to the host, the features present in the license, and the expiration date for the license.

If you have neither of these permissions but you have the permission to add a host to vCenter Server, you can add a license to the inventory and assign a license to the host when you perform the add host operation.

**About the License Portal**

Use the license portal to get upgraded license keys, downgrade license keys, combine the capacity of multiple license keys, divide the capacity of a single license key, view the change history of your license keys, and find lost license keys.

**Getting Upgraded License Keys**

If you have VMware Infrastructure 3 license keys and you have upgrades to vSphere 4.1 or later, use the license portal to retrieve the new license keys and deactivate the old licenses. After you retrieve the license keys, add them to the vCenter Server license inventory.

**Downgrading License Keys**

If you have license keys for vSphere 5.0, but you need to license VMware Infrastructure 3 or vSphere 4.x assets, use the license portal to downgrade the license keys. When you downgrade the license keys, the vSphere 5.0 license keys remain valid. When you are ready to upgrade your assets, you can stop using the VMware Infrastructure or vSphere 4.x licenses and start using the vSphere 5.0 license keys by adding them to the vCenter Server license inventory and assigning them to your upgraded assets.
Combining the Capacity of License Keys

If your license inventory contains multiple license keys, each with a small amount of capacity, you might want to combine them into one large-capacity license key. Combining license keys is useful when the total available capacity across license keys is large enough to accommodate an asset, but no single license key is large enough to accommodate the asset.

After you use the license portal to combine license keys, you must add the new license key to the vCenter Server license inventory and remove the old license keys.

Dividing the Capacity of License Keys

If you have a large-capacity license key, you might want to divide the capacity to create multiple smaller-capacity license keys. Dividing license keys is useful for managing license keys in different vCenter Server license inventories or assigning different license keys to groups in your organization.

Viewing the Change History of License Keys

The license portal tracks the complete history of license key upgrades, downgrades, combinations, and divisions for your organization.

Finding Lost License Keys

If a license key is misplaced, you can search for it in the license portal using the following criteria:

- Date range
- License key
- Order number
- Transaction type

Managing Licenses

License management is centralized. You can use the vSphere Client to manage all licenses that are available in the license inventory of a vCenter Server system or a Linked Mode group.

- View License Information on page 76
  You can view the license keys available in the vCenter Server license inventory from the Licensing page in the vSphere Client.

- Add a License Key and Assign It to an Asset on page 76
  After you obtain a license key, you can add it to the vCenter Server license inventory and assign the license key to assets.

- Add License Keys to the License Inventory on page 77
  After you obtain license keys, you can add them to the vCenter Server license inventory. You can add multiple license keys at the same time.

- Assign a License Key to Assets on page 78
  You can assign license keys to single or multiple assets, individually, or in batches.

- Export License Information on page 78
  You can export license information in a file that you can later open with third-party applications.
Managing Licenses on ESXi Hosts on page 79
You can license an ESXi host that is connected to vCenter Server or if your vSphere Client is connected directly to the host. You can also query which features are licensed on a host or set a host to evaluation mode.

Managing Licenses on ESX/ESXi 3.5 Hosts on page 80
vCenter Server 5.0 requires a license server to manage licenses on ESX/ESXi 3.5. For ESX/ESXi 4.x and later hosts, vCenter Server 5.0 does not require a license server.

View License Information
You can view the license keys available in the vCenter Server license inventory from the Licensing page in the vSphere Client.

Prerequisites
- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure
1. In the vSphere Client, select Home > Licensing.
   You can view and manage the license keys available in the vCenter Server inventory from the Management tab.
2. (Optional) Click Refresh.
3. In the Management tab, select a sorting option for the license information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Displays the available license keys listed by product.</td>
</tr>
<tr>
<td>License key</td>
<td>Displays the available license keys listed by license key.</td>
</tr>
<tr>
<td>Asset</td>
<td>Displays the available license keys listed by the asset to which they are assigned: host, vCenter Server, or solution.</td>
</tr>
</tbody>
</table>

The Management tab displays the available license keys listed by product, license key, or asset. You can right-click any of the listed items to add, assign, and remove license keys and copy license information to your clipboard.

What to do next
If you have a license key with zero assigned capacity, you can:
- Assign the license key to assets that require licensing.
- Remove the license key if the key is no longer required.

You should not keep unassigned license keys in the vCenter Server license inventory.

Add a License Key and Assign It to an Asset
After you obtain a license key, you can add it to the vCenter Server license inventory and assign the license key to assets.

Prerequisites
- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
Procedure
1. In the vSphere Client, select Home > Administration > Licensing.
2. In the Management tab, select Asset as a primary entity for sorting the license information.
3. Right-click an asset and select Change license key.
4. Select Assign a new license key and click Enter Key.
5. Specify the license key, type an optional label for the key, and click OK.
6. Click OK.

The license key is added to the vCenter Server license inventory and assigned to the corresponding asset. If vCenter Server is part of a Linked Mode group, the license key is added to the shared inventory of the group.

What to do next
Assign the license key to other assets of the same type in case the license key has available capacity.

Add License Keys to the License Inventory
After you obtain license keys, you can add them to the vCenter Server license inventory. You can add multiple license keys at the same time.

Prerequisites
- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.

Procedure
1. In the vSphere Client, select Home > Administration > Licensing.
2. Click Manage vSphere Licenses.
3. In the Add License Keys text area, specify license keys one per line.
   - You can specify a list of keys in one operation.
4. (Optional) Type a brief description of the keys.
5. Click Add License Keys.

If you specify any invalid license keys, you receive an error message that lists only the invalid keys. You can either delete the invalid keys, or add them after correcting them.
6. If you are not ready to assign the license keys to assets, click Next through the remaining wizard screens and click Finish to save your changes.

The license keys are added to the vCenter Server license inventory. If vCenter Server is in a Linked Mode group, the license keys are added to the shared inventory of the Linked Mode group.

What to do next
Assign the license keys to assets that require licensing. You should not keep unassigned license keys in the vCenter Server license inventory.
Assign a License Key to Assets

You can assign license keys to single or multiple assets, individually, or in batches.

**Note** If an ESXi host disconnects from vCenter Server immediately after you assign a license key, the license assignment operation does not complete but the host appears as licensed. The host is licensed after it reconnects to vCenter Server.

**Prerequisites**
- Verify that you have the **Global.Licenses** privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.

**Procedure**
1. In the vSphere Client, select **Home > Administration > Licensing**.
2. Click **Manage vSphere Licenses**.
3. Click **Next** to go to the Assign Licenses page.
4. Click the **ESX**, **vCenter Server**, or **Solutions** tab to display the available assets.
5. Select the assets to show.
6. In the Asset window, select one or more assets to license.
   - To select multiple assets, use Ctrl-click or Shift-click.
7. In the Product window, select an appropriate license key and click **Next**.
   - If the license key you assign has a strong limit, the license capacity must be greater than or equal to the required license use for the asset. Otherwise, you cannot assign the license key. Check the EULA of the license to determine whether it has a strong limit.
8. (Optional) If you are not ready to remove any license keys, click **Next** to skip the Remove License Keys page and click **Finish** to save your changes.

Export License Information

You can export license information in a file that you can later open with third-party applications.

**Prerequisites**
- Verify that you have the **Global.Licenses** privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.

**Procedure**
1. In the vSphere Client, select **Home > Administration > Licensing**.
2. In the **Management** tab, select the view that you want to export.
   - **Product**
   - **License key**
   - **Asset**
3. On the report screen, click **Export**.
4. In the **Save As** dialog box, select a folder, a filename, and a format for the exported license data and click **Save**.
Managing Licenses on ESXi Hosts

You can license an ESXi host that is connected to vCenter Server or if your vSphere Client is connected directly to the host. You can also query which features are licensed on a host or set a host to evaluation mode.

- **License a Host When Adding It to the vCenter Server Inventory** on page 79
  When you add a host to the vCenter Server inventory, you can assign a license key to the host.

- **License an ESXi Host Without vCenter Server** on page 79
  If you are directly connected to the host through the vSphere Client, you can assign the host a license key.

- **View Which Features Are Licensed on a Host** on page 80
  You can view which features a host is licensed to use.

- **Set an ESXi Host to Evaluation Mode** on page 80
  If you have assigned a license key to an ESXi host, you can switch to evaluation mode to explore the full set of features that are available for the host.

**License a Host When Adding It to the vCenter Server Inventory**

When you add a host to the vCenter Server inventory, you can assign a license key to the host.

**Prerequisites**

You must have a communication channel through a firewall before you add a host.

**Note** Verify that the edition of the license key you assign to the host matches the currently configured features and resources. Otherwise, you cannot assign the license key.

**Procedure**

1. Click **Inventory** in the navigation bar.
2. Expand the inventory as needed and click the appropriate datacenter, folder, or cluster.
3. Right-click the datacenter or cluster and select **Add Host**.
4. At the prompt, assign an existing vSphere license key or add a new vSphere license key.

**License an ESXi Host Without vCenter Server**

If you are directly connected to the host through the vSphere Client, you can assign the host a license key.

**Note** Verify that the edition of the license key you assign to the host matches the currently configured features and resources. Otherwise, you cannot assign the license key.

**Procedure**

1. From the vSphere Client, click the **Configuration** tab.
2. Under Software, click **Licensed Features**.
3. Click **Edit**.
4. Assign a license key.
   - Select **Assign an existing license key to this host** and select a license key from the Product list.
   - Select **Assign a new license key to this host**, click **Enter Key**, and enter a license key and an optional label for the license key.
5 Click OK.

View Which Features Are Licensed on a Host

You can view which features a host is licensed to use.

If you try to configure features that are not included in the host license, the vSphere Client displays an error message.

Procedure

1 From the vSphere Client, select the host in the inventory.
2 Click the Configuration tab.
3 Under Software, click Licensed Features.

The list appears of features that you can configure on the host.

Set an ESXi Host to Evaluation Mode

If you have assigned a license key to an ESXi host, you can switch to evaluation mode to explore the full set of features that are available for the host.

Procedure

1 From the vSphere Client connected to a vCenter Server, select the host in the inventory.
2 Click the Configuration tab.
3 Under Software, click Licensed Features.
4 Click Edit next to ESX Server License Type.
5 Click Product Evaluation.
6 Click OK to save your changes.

The host is in evaluation mode and you can explore the entire set of features for ESXi. If you have already used the host in evaluation mode, the time that remains in the evaluation period is decreased by the time already used. For example, suppose you have used the host in evaluation mode for 20 days and then assigned a vSphere Standard license key to the host. If you set the host back in evaluation mode, you can explore the entire set of features that are available for the host for the remaining evaluation period of 40 days. You can track the remaining days from the evaluation period of a host in the host’s page in the vSphere Client.

NOTE After the evaluation period of the host expires, you receive a warning message, and the host disconnects from vCenter Server. All powered-on virtual machines continue to work, but you cannot power on any new virtual machines. You cannot change the current configuration of the features that are already in use. You cannot use the features that remained unused while the host was in evaluation mode.

Managing Licenses on ESX/ESXi 3.5 Hosts

vCenter Server 5.0 requires a license server to manage licenses on ESX/ESXi 3.5. For ESX/ESXi 4.x and later hosts, vCenter Server 5.0 does not require a license server.

If you do not have a license server installed and you need one, download the VMware License Server from the VMware Web site.

The license server installation requires no downtime. No virtual machines, servers, hosts, or clients need to be powered off for the installation of the license server.
Configure vCenter Server to Use a License Server

To manage ESX/ESXi 3.5 hosts, you must configure vCenter Server to use a license server.

Prerequisites

You must have a license server installed. You can download the VMware License Server from the VMware Web site.

Procedure

1. In vCenter Server, select Administration > vCenter Server Settings.
2. In the License Server text box, enter the port number and license server machine name, as in $port@host$. For example: 27000@license-3.companyname.com
3. If you want the hosts and vCenter Server to use the same license server, select the Reconfigure ESX 3 hosts using license servers to use this server check box.
4. Click OK.

Viewing License Use

You can view the use and capacity of the license keys that are assigned to assets for a period that you select.

You can use the Reporting tab of the Licensing page in the vSphere Client to perform the following tasks:

- View statistics for the license use and capacity of products filtered by a vCenter Server system and time period.
- Export license use reports in CSV format for further analysis and processing.
- Set a threshold for the license use of products with use-based licensing models, such as per-virtual machine and vRAM. License use thresholds allow you to receive notifications if a certain use is exceeded.

The License Usage History service on vCenter Server takes snapshots of the license use every hour. The license use snapshots are stored in the vCenter Server database. A license use snapshot contains data about the current license assignment and use for assets. The license use information that you can view on the Reporting tab contains aggregated statistics from the snapshots that are collected in the period that you select.

The license use reports that you can export in CSV format contain the raw data from the license use snapshots that are collected in the period that you select.

**NOTE** The license reporting function is part of the vSphere Web Client and is integrated as a plug-in to the vSphere Client. To have the license reporting in the vSphere Client, you must install the vSphere Web Client and register the vCenter Server system with the vSphere Web Client.

View the License Use for Multiple Products

You can view the license use for products from the Licensing page in the vSphere Client. You can filter the license use data by vCenter Server system and time period.

Prerequisites

- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
- Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with it.
Procedure

1. In the vSphere Client, select Home > Administration > Licensing.

2. Select the Reporting tab.

3. (Optional) If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default All vCenter Server instances value in the vCenter Server drop-down menu.

   You should leave the default All vCenter Server instances value to view the license use for the entire group. If you view the license use for a single vCenter Server instance and not the entire group, you do not receive information about the total use of license keys assigned to more than one asset in the group.

4. From the Time period drop-down menu, select a preconfigured or a custom time period for which you want to view the license use for products.
   a. (Optional) If you select a custom time period, specify the start and end dates, and click Recalculate.

The Products Chart shows the license use for each product as a percentage of the license capacity for the product over the period that you select. If a threshold exists for the license use of a product, the percentage of the threshold use appears in the chart.

The vRAM use for vSphere 5.0 products is reported separately from the CPU use for every product edition. For example, if you have license keys of vSphere 5.0 Enterprise Plus that are assigned to ESXi 5.0 hosts, the vRAM use for vSphere 5.0 Enterprise Plus is reported as VMware vSphere 5 Enterprise Plus (vRAM) in the Products Chart.

Certain products in the Products Chart might have one or two asterisk (*) symbols next to their names. The asterisks have a special meaning.

Table 7-1. Interpreting Chart Results for Products Marked With Asterisks

<table>
<thead>
<tr>
<th>vCenter Server Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single vCenter Server instance or all vCenter Server</td>
<td>An asterisk (*) next to a product in the Products Chart indicates that the</td>
</tr>
<tr>
<td>instances in a Linked Mode group</td>
<td>licenses for the product are hard-enforced. You cannot use more than 100%</td>
</tr>
<tr>
<td></td>
<td>from the license capacity.</td>
</tr>
<tr>
<td>All vCenter Server instances in a Linked Mode group</td>
<td>Two asterisks (**) next to a product in the Products Chart indicate that</td>
</tr>
<tr>
<td></td>
<td>the license use that is reported for the product includes data from vCenter</td>
</tr>
<tr>
<td></td>
<td>Server instances that no longer participate in the Linked Mode group.</td>
</tr>
<tr>
<td>Single vCenter Server instance from a Linked Mode</td>
<td>Two asterisks (**) next to a solution in the Products Chart indicate that</td>
</tr>
<tr>
<td>group</td>
<td>the license use that is reported for the solution includes data for the entire</td>
</tr>
<tr>
<td></td>
<td>Linked Mode group.</td>
</tr>
</tbody>
</table>

View License Use Details for a Single Product

You can view details about the license use for a product from the Licensing page in the vSphere Client. You can filter the license use data by a vCenter Server and period.

Prerequisites

- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
- Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with it.

Procedure

1. In the vSphere Client, select Home > Administration > Licensing.
2 Select the **Reporting** tab.

3 If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default **All vCenter Server instances** value in the **vCenter Server** drop-down menu.

   You should leave the default **All vCenter Server Instances** value to view the license use for a product for the entire group. If you view the license use for a single vCenter Server instance and not the entire group, you do not receive information about the total use of license keys that are assigned to more than one asset in the group.

4 Select a preconfigured or a custom period for the license use details from the **Time period** drop-down menu.
   a (Optional) If you select a custom time period, specify the start and end dates, and click **Recalculate**.

5 Select a product from the Products Chart.

   The vRAM use for vSphere 5.0 products is reported separately from the CPU use for the every product edition. For example, the vRAM use for vSphere 5.0 Standard is reported as VMware vSphere 5 Standard (vRAM) in the Products Chart.

   Details about the license use of the product that you select appear in the Product Details pane. The table in the Product Details pane lists all the license keys for the product that are assigned to assets in the selected period. The table can list license keys that are not used currently but were assigned to assets in the selected period.

**What to do next**

View details about each license key for the product.

### Licensing Details for a Selected Product

The licensing details for a product provide information about the current and average license keys use, and the current and average capacity of the license keys available for the product. You can view licensing details for a product from the **Reporting** tab of the Licensing page in the vSphere Client.

   To view licensing details for a product, you select the product from the Products Chart pane and the licensing details for the product appear in the Product Details pane.

   Above the table in the Product Details pane, you can view the license use and capacity for the product over the selected period and on the current date. The value for the license use that you view is the total use for all license keys that belong to the product and that are assigned to assets. If a threshold exists for the license use of the product, you can view the threshold limit.

#### Table 7-2. Licensing Details for a Product

<table>
<thead>
<tr>
<th>Licensing Detail for a Product</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licenses used (selected period)</td>
<td>Number of units from the purchased license capacity that assets use over the selected period.</td>
</tr>
<tr>
<td>Purchased capacity (selected period)</td>
<td>Latest amount of license capacity that is purchased for the selected period.</td>
</tr>
<tr>
<td>Licenses used % (selected period)</td>
<td>Percentage from the purchased license capacity that assets use over the selected period.</td>
</tr>
<tr>
<td>Licenses used (today)</td>
<td>Number of units from the purchased license capacity that assets use on the current date.</td>
</tr>
<tr>
<td>Purchased capacity (today)</td>
<td>Amount of license capacity that is purchased for the product on the current date.</td>
</tr>
<tr>
<td>Licenses used % (today)</td>
<td>Percentage from the purchased license capacity that assets use on the current date.</td>
</tr>
<tr>
<td>Alert threshold</td>
<td>Value of the threshold set for the product.</td>
</tr>
</tbody>
</table>
The table in the Product Details pane lists all license keys that belong to the selected product and that are assigned to assets over the selected period. The table contains details for the use and capacity of every key.

The license use on the Product Details pane is an aggregated value from the row data in the license use snapshots that are stored in vCenter Server. The License Usage History service in every vCenter Server system collects license use snapshots every hour.

**View Details for a License Key**

From the Licensing page of the vSphere Client, you can view details about the use and capacity of each license key that is assigned to an asset.

**Prerequisites**

- Verify that you have the Global.Licenses privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
- Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with it.

**Procedure**

1. In the vSphere Client, select Home > Administration > Licensing.
2. Select the Reporting tab.
3. If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default All vCenter Server instances value in the vCenter Server drop-down menu.
   
   You should leave the default All vCenter Server instances value to view the use for a license key for the entire group. If you select a single vCenter Server instance and the license key is assigned to more than one asset in the group, you do not receive information about the total use of the license key.
4. From the Time period drop-down menu, select the time period for which you want to view details for a license key.
   
   a. (Optional) If you select a custom time period, specify the start and end dates, and click Recalculate.
5. To view the license keys that belong to a product, select the product from the Products Chart pane.
6. To view the details for a license key, select the key from the Product Details pane.

**Details for a License Key**

The details for a license key provide information about the license key assignment and use for a vCenter Server system during the selected time period. You can view details for a license key from the Reporting tab on the Licensing page in the vSphere Client.

To view the details for a license key, select the key from the Product Details pane.

**Table 7-3. Details for a License Key**

<table>
<thead>
<tr>
<th>License Key Details</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Assets licensed with the license key over the selected period.</td>
</tr>
<tr>
<td>Licenses used (selected</td>
<td>Amount of units from the license capacity that the asset uses over the selected period. The value is aggregated from the data in the license use</td>
</tr>
<tr>
<td>period)</td>
<td>use snapshots that are available in the vCenter Server database for the selected period. The License Usage History service in every vCenter Server</td>
</tr>
<tr>
<td></td>
<td>system collects license use snapshots every hour.</td>
</tr>
<tr>
<td>Licenses used (today)</td>
<td>Amount of units from the license capacity that the asset uses on the current date.</td>
</tr>
</tbody>
</table>
Export a License Use Report

From the Licensing page in the vSphere Client, you can export a report for the license use of products for a certain time period. The report is exported in a CSV file that you can later open with third party applications.

**NOTE** A tamper-detection feature in vCenter Server protects the license use information. If the licensing data in the vCenter Server database has been edited, you cannot export a license use report.

**Prerequisites**
- Verify that you have the **Global.Licenses** privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
- Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with it.

**Procedure**

1. In the vSphere Client, select **Home > Administration > Licensing**.
2. Select the **Reporting** tab.
3. Click **export**.

   The Export License Data window appears.

4. (Optional) If the vCenter Server instance that you are connected to is part of a Linked Mode group, leave the default **All vCenter Server instances** value in the **vCenter Server** drop-down menu.

   You should leave the default **All vCenter Server instances** value to export the license use for the entire group. By exporting the license use for a single vCenter Server instance and not the entire group, you do not receive information about the total use of license keys that are assigned to more than one asset in the group.

5. Select a preconfigured or a custom time period for the license use report from the **Time period** drop-down menu.
6. Click **Export**.

   The export operation takes a few seconds.
7. In the Save Export File window, click **Yes**.
8. Browse to the location where you want to save the file and click **Save**.

The license use for products over the selected time period is exported in an CSV file. The CSV file is contained in a .zip file that you can find in the location you specified.

**License Use Data in an Exported Report**

You can export the license use data for a certain period and for a vCenter Server system in a CSV file for later analysis and reference.

The license use information that you view in the **Reporting** tab differs from the license use information that you can export.

The license use information on the **Reporting** tab is aggregated data from the license use snapshots available in the vCenter Server database for the period that you select.
The exported report contains raw data about the license use of products for a single vCenter Server instance or a Linked Mode group. The exported report includes all of the snapshots collected over the selected period. The exported report can contain host, vCenter Server, or solution asset IDs, but does not include user-defined names. The exported report is free of user and company-specific information.

Each row of the exported report CSV file lists a single license use snapshot, which includes an asset, its assigned license key, and the use at the given timestamp.

**Table 7-4. Information in an Exported Report**

<table>
<thead>
<tr>
<th>Download Report Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Key</td>
<td>Assigned license key.</td>
</tr>
<tr>
<td>Product Edition</td>
<td>Edition of the product to which the license key belongs.</td>
</tr>
<tr>
<td>Cost Unit</td>
<td>Capacity type of the license key (CPU, instance, virtual machine, and so on).</td>
</tr>
<tr>
<td>License Key Expiration Date</td>
<td>If applicable.</td>
</tr>
<tr>
<td>Asset ID</td>
<td>Automatically generated ID that vCenter Server uses to identify the asset.</td>
</tr>
<tr>
<td>Usage</td>
<td>Amount of units from the license capacity that the asset uses at the time of the timestamp. The unit of this value is indicated in the Cost Unit column.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Capacity of the license key. The unit of this value is indicated in the Cost Unit column.</td>
</tr>
<tr>
<td>vCenter Servers</td>
<td>vCenter Server instances for which the usage is reported. This column is useful when the report is generated for multiple vCenter Server instances.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>Timestamp of the license use snapshot.</td>
</tr>
</tbody>
</table>

The last section of raw data in the file contains a signature that is a checksum of the file content. You can ignore this section of the report.

**Set a Threshold for the License Use of a Product**

You can set a threshold for the license use of products. A threshold helps you to track whether the current license use for a product exceeds certain limits. If the license use for the product exceeds the threshold, an alarm is triggered on the corresponding vCenter Server system.

You can apply thresholds only to products with use-based licensing models such as per-virtual machine or vRAM. You can set thresholds below or above the purchased license capacity. You can use thresholds as an additional means to receive notifications if the license use for a product exceeds certain limits. Thresholds do not enforce license use limits.

**Note** You can set thresholds for the license use of products only for individual vCenter Server systems. You cannot set thresholds for all vCenter Server systems in a Linked Mode group.

**Prerequisites**

- Verify that you have the **Global.Licenses** privilege.
- Ensure that the vSphere Client is connected to the vCenter Server system.
- Ensure that you have the vSphere Web Client installed and the vCenter Server system is registered with it.

**Procedure**

1. In the vSphere Client, select **Home > Administration > Licensing**.
2 Select the **Reporting** tab.

3 (Optional) If the vCenter Server that you are connected to is part of a Linked Mode group, from the **vCenter Server** drop-down menu, select the vCenter Server system where you want to set a threshold for the license use of a product.

4 Select the product from the Products Chart pane.

5 Click **Edit Threshold** in the Product Details pane.

6 Type the value for the threshold.

7 Click **OK**.

You receive a message that the threshold is successfully set for the relevant product. The view in the Products Chart refreshes after a few seconds and a bar appears that indicates the threshold value as a percent of the license capacity of the product.

If the license use for the product exceeds the threshold amount, an alarm is triggered on the corresponding vCenter Server, and a notice appears on the **Reporting** tab of the Licensing page. However, further use of the product is not restricted.

**NOTE** The notifications might take several minutes to appear after a threshold is exceeded.
In addition to lists of events and alarms, vSphere components generate assorted logs. These logs contain additional information about activities in your vSphere environment.

This chapter includes the following topics:
- “View System Log Entries,” on page 89
- “View System Logs on an ESXi Host,” on page 89
- “External System Logs,” on page 90
- “Export System Log Files,” on page 90
- “Configure Syslog on ESXi Hosts,” on page 91
- “Collecting Log Files,” on page 92

View System Log Entries

You can view system logs generated by vSphere components.

Procedure
1. From the Home page of a vSphere Client connected to either a vCenter Server system or an ESXi host, click System Logs.
2. From the drop-down menu, select the log and entry you want to view.
3. Select View > Filtering to refer to the filtering options.
4. Enter text in the data field.
5. Click Clear to empty the data field.

View System Logs on an ESXi Host

You can use the direct console interface to view the system logs on an ESXi host. These logs provide information about system operational events.

Procedure
1. From the direct console, select View System Logs.
2. Press a corresponding number key to view a log.
   - vCenter Server agent (vpxa) logs appear if the host is managed by vCenter Server.
3. Press Enter or the spacebar to scroll through the messages.
4 (Optional) Perform a regular expression search.
   a Press the slash (/).
   b Type the text to find.
   c Press Enter
      The found text is highlighted on the screen.

5 Press q to return to the direct console.

**External System Logs**

VMware technical support might request several files to help resolve any issues you have with the product. This section describes the types and locations of log files found on various ESXi component systems.

*NOTE* On Windows systems, several log files are stored in the Local Settings directory, which is located at C:\Documents and Settings\<user name>\Local Settings\Local Settings. This folder is hidden by default.

**ESXi System Logs**

You might need the ESXi system log files to resolve technical issues.

The ESXi system logs can be found in the /var/run/log directory.

**vSphere Client System Logs**

You might need the vSphere Client system log files to resolve technical issues.

Table 8-1 lists log files associated with the vSphere Client machine.

<table>
<thead>
<tr>
<th>Component</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>vSphere Client Installation log</td>
<td>Temp directory on the vSphere Client machine.</td>
</tr>
<tr>
<td></td>
<td>Example: C:\Documents and Settings\user_name\Local Settings\Temp\vmmsi.log or</td>
</tr>
<tr>
<td></td>
<td>C:Users\user_name\Local Settings\Temp\vmmsi.log</td>
</tr>
<tr>
<td>vSphere Client Service log</td>
<td>\vpx directory in the Application Data directory on the vSphere Client machine.</td>
</tr>
<tr>
<td></td>
<td>Example: C:\Documents and Settings\user_name\Local Settings\Application</td>
</tr>
<tr>
<td></td>
<td>Data\vpx\viclient-x.log or C:Users\user_name\Local Settings\Application</td>
</tr>
<tr>
<td></td>
<td>Data\vpx\viclient-x.log</td>
</tr>
<tr>
<td></td>
<td>x(=0, 1, ... 9)</td>
</tr>
</tbody>
</table>

**Export System Log Files**

When the vSphere Client is connected to vCenter Server, you can select hosts from which to download system log files.

To save diagnostic data for ESXi hosts and vCenter Server, the vSphere Client must be connected to the vCenter Server system. If you are connected directly to an ESXi host, you can save diagnostic data only for that specific ESXi host.

Required privileges:

- To view diagnostic data: Read-Only User
- To manage diagnostic data: Global.Licenses
Procedure


2. If you are connected to vCenter Server, select the object for which you want to export data.
   Selecting an object selects all of its child objects.

3. If you are connected to vCenter Server, select Include information from vCenter Server and vSphere Client to download vCenter Server and vSphere Client log files and host log files, and click Next.

4. If the selected host supports manifest driven exports of system log files, select the system log files to collect.
   Select the specific system log files to download.
   If the host does not support manifest exports of log files, all system log files are exported.

5. Select Gather performance data to include performance data information in the log files. Click Next.
   You can update the duration and interval time you want the data collected.

6. Click Next.

7. Click Browse and specify the location to which to save the log files.
   The host or vCenter Server generates .zip bundles containing the log files. The Recent Tasks panel shows the Generate diagnostic bundles task in progress.

8. Click Next.
   The Downloading Log Bundles dialog box appears when the Generating Diagnostic Bundle task is finished. The download status of each bundle appears in the dialog box.
   Some network errors can cause download failures. When you select an individual download in the dialog box, the error message for that operation appears under the name and location of the log bundle file.

9. Verify the information in the Summary and click Finish to download the log files.

10. If the download fails, click Retry to attempt to download the generated bundles again.
    Diagnostic bundles containing log files for the specified objects are downloaded to the location specified.

Configure Syslog on ESXi Hosts

All ESXi hosts run a syslog service (vmsyslogd), which logs messages from the VMkernel and other system components to log files.

You can use the vSphere Client or the esxcli system syslog vCLI command to configure the syslog service.
For more information about using vCLI commands, see Getting Started with vSphere Command-Line Interfaces.

Procedure

1. In the vSphere Client inventory, select the host.

2. Click the Configuration tab.

3. In the Software panel, click Advanced Settings.

4. Select Syslog in the tree control.
To set up logging globally, click **global** and make changes to the fields on the right.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syslog.global.defaultRotate</td>
<td>Sets the maximum number of archives to keep. You can set this number globally and for individual subloggers.</td>
</tr>
<tr>
<td>Syslog.global.defaultSize</td>
<td>Sets the default size of the log, in KB, before the system rotates logs. You can set this number globally and for individual subloggers.</td>
</tr>
<tr>
<td>Syslog.global.LogDir</td>
<td>Directory where logs are stored. The directory can be located on mounted NFS or VMFS volumes. Only the /scratch directory on the local file system is persistent across reboots. The directory should be specified as [datastoreName] path_to_file where the path is relative to the root of the volume backing the datastore. For example, the path /storage1/var/log/messages maps to the path /vmfs/volumes/storage1/var/log/messages. If no path is specified, all log files are sent to /var/log.</td>
</tr>
<tr>
<td>Syslog.global.logDirUnique</td>
<td>Selecting this option creates a subdirectory with the name of the ESXi host under the directory specified by Syslog.global.LogDir. A unique directory is useful if the same NFS directory is used by multiple ESXi hosts.</td>
</tr>
<tr>
<td>Syslog.global.LogHost</td>
<td>Remote host to which syslog messages are forwarded and port on which the remote host receives syslog messages. You can include the protocol and the port, for example, ssl://hostName1:514. UDP (default), TCP, and SSL are supported. The remote host must have syslog installed and correctly configured to receive the forwarded syslog messages. See the documentation for the syslog service installed on the remote host for information on configuration.</td>
</tr>
</tbody>
</table>

(Optional) To overwrite the default log size and log rotation for any of the logs.

a. Click **loggers**.

b. Click the name of the log you want to customize and enter the number of rotations and log size you want.

7 Click **OK**.

Changes to the syslog options take effect immediately.

### Collecting Log Files

VMware technical support might request several files to help resolve technical issues. The following sections describe script processes for generating and collecting some of these files.

### Set Verbose Logging

You can specify how verbose log files will be.

**Procedure**

1. Select **Administration > vCenter Server Settings**.
2. Select **Logging Options**.
3. Select **Verbose** from the pop-up menu.
4. Click **OK**.
Collect vSphere Log Files

You can collect vSphere log files into a single location.

Procedure

- View the log file using one of the following methods.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the viclient-*.log file</td>
<td>Change to the directory, %temp%.</td>
</tr>
<tr>
<td>Download the log bundle from vSphere Client connected to a vCenter Server system</td>
<td>Select Administration &gt; Export System Logs to download the log bundle. The log bundle is generated as a .zip file. By default, the vpxd logs within the bundle are compressed as .gz files. You must use gunzip to uncompress these files.</td>
</tr>
<tr>
<td>Generate vCenter Server log bundles from a vCenter Server system</td>
<td>Select Start &gt; Programs &gt; VMware &gt; Generate vCenter Server log bundle. You can use this to generate vCenter Server log bundles even when you are unable to connect to the vCenter Server using the vSphere Client. The log bundle is generated as a .zip file. By default, the vpxd logs within the bundle are compressed as .gz files. You must use gunzip to uncompress these files.</td>
</tr>
</tbody>
</table>

Collect ESXi Log Files

You can collect and package all relevant ESXi system and configuration information, a well as ESXi log files. This information can be used to analyze the problems.

Procedure

- Run the following script on the ESXi Shell: /usr/bin/vm-support

  The resulting file has the following format: esx-date-unique-xnumber.tgz

Turn Off Compression for vpxd Log Files

By default, vCenter Server vpxd log files are rolled up and compressed into .gz files. You can turn off this setting to leave the vpxd logs uncompressed.

Procedure

1. Log in to the vCenter Server using the vSphere Client.
2. Select Administration > vCenter Server Settings.
3. Select Advanced Settings.
4. In the Key text box, type log.compressOnRoll.
5. In the Value text box, type false.
6. Click Add, and click OK.

ESXi VMkernel Files

If the VMkernel fails, an error message appears and then the virtual machine reboots. If you specified a VMware core dump partition when you configured your virtual machine, the VMkernel also generates a core dump and error log.

More serious problems in the VMkernel can freeze the machine without an error message or core dump.
vSphere tasks and events are activities and actions that occur on an object within the vSphere inventory.

This chapter includes the following topics:

- “Managing Tasks,” on page 95
- “Managing Events,” on page 101
- “Report Errors to VMware,” on page 104

Managing Tasks

Tasks represent system activities that do not complete immediately, such as migrating a virtual machine. They are initiated by high-level activities that you perform with the vSphere Client in real time and activities that you schedule to occur at a later time or on a recurring basis.

For example, powering off a virtual machine is a task. You can perform this task manually every evening, or you can set up a scheduled task to power off the virtual machine every evening for you.

NOTE The functionality available in the vSphere Client depends on whether the vSphere Client is connected to a vCenter Server system or an ESXi host. Unless indicated, the process, task, or description applies to both kinds of vSphere Client connections. When the vSphere Client is connected to an ESXi host, the Tasks option is not available; however, you can view recent tasks in the Status Bar at the bottom of the vSphere Client.

Viewing Tasks

You can view tasks that are associated with a single object or all objects in the vSphere Client inventory. The Tasks & Events tab lists completed tasks and tasks that are currently running.

By default, the tasks list for an object also includes tasks performed on its child objects. You can filter the list by removing tasks performed on child objects and by using keywords to search for tasks.

If you are logged in to a vCenter Server system that is part of a Connected Group, a column in the task list displays the name of the vCenter Server system on which the task was performed.

View All Tasks

You view completed tasks and running tasks on the vSphere Client Tasks & Events tab.

Procedure

1. Display the object in the inventory.
2. Display the tasks for a single object or the entire vCenter Server.
   - To display the tasks for an object, select the object.
   - To display the tasks in the vCenter Server, select the root folder.

3. Click the **Tasks & Events** tab.
   
The task list contains tasks performed on the object and its children.

4. (Optional) To view detailed information for a task, select the task in the list.
   
The **Task Details** pane displays details such as task status, any error messages in the error stack, and any related events.

**View Recent Tasks**

You view recent tasks for vCenter Server or an ESXi host in the vSphere Client **Recent Tasks** pane.

**Procedure**

1. Display the Inventory panel.
2. Select the object.
3. If necessary, select **View > Status** to display the status bar at the bottom of the vSphere Client.
4. In the status bar, Click **Tasks**.
   
The list of completed tasks appears in the **Recent Tasks** pane of the **Status Bar**.

**View Scheduled Tasks**

You view scheduled tasks in the vSphere Client **Scheduled Tasks** pane. The scheduled task list includes tasks that are scheduled to run and those that have already run.

**Procedure**

- In the navigation bar, select **Home > Management > Scheduled Tasks**.

**Filter Tasks for a Host or Datacenter**

Filtering the task list removes tasks performed on child objects.

**Procedure**

1. Select the host or datacenter in the inventory and click the **Tasks & Events** tab.
2. In **View**, click **Tasks** to display the tasks list.
3. If the **Show all entries** list and the search field are not displayed under the **Tasks** and **Events** buttons, select **View > Filtering**.
4. Click **Show all entries** and select **Show host entries** or **Show datacenter entries**, depending on the object selected.

**Use Keywords to Filter the Tasks List**

You can filter the tasks list based on any task attribute, including task name, target, status, initiator, change history, and time. Filtering is inclusive, not exclusive. If the keyword is found in any of the selected columns, the task is included in the filtered list.

**Procedure**

1. Display the object in the inventory.
2. Select the object and click the **Tasks & Events** tab.
3 If the Name, Target or Status contains search field is not displayed, select View > Filtering.
4 Click the search field arrow and select the attributes to include in the search.
5 Type a keyword into the box and press Enter.

Cancel a Task
Canceling a task stops a running task from occurring. Canceling a scheduled task does not cancel subsequent runs. To cancel a scheduled task that has not run, reschedule it.

NOTE You can only cancel a subset of tasks by using the vSphere Client.

Required privileges:
- Manual tasks: Tasks.Update Task
- Scheduled tasks: Scheduled Task.Remove Task
- Appropriate permissions on the host where the task is running

Prerequisites
To cancel a task, the vSphere Client must be connected to a vCenter Server system.

Procedure
1 Locate the task in the Recent Tasks pane of the Status Bar.
   By default, the Status Bar is displayed at the bottom of the vSphere Client. If it is not visible, select View > Status Bar.
2 Right-click the appropriate task and select Cancel.
   If the cancel option is unavailable, the selected task cannot be canceled.

The vCenter Server system or ESXi host stops the progress of the task and returns the object to its previous state. The vSphere Client displays the task with a Canceled status.

Schedule Tasks
You can schedule tasks to run once in the future or multiple times, at a recurring interval.

The vSphere Client must be connected to a vCenter Server system to create and manage scheduled tasks. The tasks you can schedule are listed in the following table.

<table>
<thead>
<tr>
<th>Scheduled Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a host</td>
<td>Adds the host to the specified datacenter or cluster.</td>
</tr>
<tr>
<td>Change the power state of a virtual machine</td>
<td>Powers on, powers off, suspends, or resets the state of the virtual machine.</td>
</tr>
<tr>
<td>Change cluster power settings</td>
<td>Enable or disable DPM for hosts in a cluster.</td>
</tr>
<tr>
<td>Change resource settings of a resource pool or virtual machine</td>
<td>Changes the following resource settings:</td>
</tr>
<tr>
<td>Check compliance of a profile</td>
<td>Checks that a host’s configuration matches the configuration specified in a host profile.</td>
</tr>
<tr>
<td>Clone a virtual machine</td>
<td>Makes a clone of the virtual machine and places it on the specified host or cluster.</td>
</tr>
<tr>
<td>Create a virtual machine</td>
<td>Creates a new virtual machine on the specified host.</td>
</tr>
</tbody>
</table>
### Table 9-1. Scheduled Tasks (Continued)

<table>
<thead>
<tr>
<th>Scheduled Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploy a virtual machine</td>
<td>Creates a new virtual machine from a template on the specified host or cluster.</td>
</tr>
<tr>
<td>Migrate a virtual machine</td>
<td>Migrate a virtual machine to the specified host or datastore by using migration or migration with vMotion.</td>
</tr>
<tr>
<td>Make a snapshot of a virtual machine</td>
<td>Captures the entire state of the virtual machine at the time the snapshot is taken.</td>
</tr>
<tr>
<td>Scan for Updates</td>
<td>Scans templates, virtual machines, and hosts for available updates.</td>
</tr>
<tr>
<td></td>
<td>This task is available only when vSphere Update Manager is installed.</td>
</tr>
<tr>
<td>Remediate</td>
<td>Downloads any new patches discovered during the scan operation and applies the newly configured settings.</td>
</tr>
<tr>
<td></td>
<td>This task is available only when vSphere Update Manager is installed.</td>
</tr>
</tbody>
</table>

You create scheduled tasks by using the Scheduled Task wizard. For some scheduled tasks, this wizard opens the wizard used specifically for that task. For example, if you create a scheduled task that migrates a virtual machine, the Scheduled Task wizard opens the Migrate Virtual Machine wizard, which you use to set up the migration details.

Scheduling one task to run on multiple objects is not possible. For example, you cannot create one scheduled task on a host that powers on all virtual machines on that host. You must create a separate scheduled task for each virtual machine.

After a scheduled task runs, you can reschedule it to run again at another time.

### Create a Scheduled Task

To schedule a task, use the Scheduled Task wizard.

**Required privilege:** Schedule Task.Create Tasks

You can schedule a limited number of tasks by using the vSphere Client. If the task to schedule is not available, use the vSphere API. See the vSphere SDK Programming Guide.

**CAUTION** Do not schedule multiple tasks to be performed at the same time on the same object. The results are unpredictable.

### Prerequisites

The vSphere Client must be connected to a vCenter Server system to schedule tasks.

### Procedure

1. In the navigation bar, click **Home > Management > Scheduled Tasks**.
   
   The current list of scheduled tasks appears.

2. In the toolbar, click **New**.

3. In the Select a Task to Schedule dialog box, select a task and click **OK** to open the wizard for that task.

   **NOTE** For some scheduled tasks, the wizard opens the wizard used specifically for that task. For example, to migrate a virtual machine, the Scheduled Task wizard opens the Migrate Virtual Machine Wizard, which you use to set up the migration details.

4. Complete the wizard that opens for the task.

5. Click **OK** to open the Scheduled Task wizard.

6. Enter a task name and task description and click **Next**.
7 Select a **Frequency** and specify a **Start Time**.

You can schedule a task to run only once during a day. To set up a task to run multiple times in one day, set up additional scheduled tasks.

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Once</td>
<td>To run the scheduled task immediately, select <strong>Now</strong> and click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>To run the scheduled task at a later time and date, select <strong>Later</strong> and enter a <strong>Time</strong>. Click the <strong>Date</strong> arrow to display the calendar and click a date.</td>
</tr>
<tr>
<td>After Startup</td>
<td>In <strong>Delay</strong>, enter the number of minutes to delay the task.</td>
</tr>
<tr>
<td>Hourly</td>
<td>1 In <strong>Start Time</strong>, enter the number of minutes after the hour to run the task.</td>
</tr>
<tr>
<td></td>
<td>2 In <strong>Interval</strong>, enter the number of hours after which to run the task.</td>
</tr>
<tr>
<td></td>
<td>For example, to start a task at the half-hour mark of every 5th hour, enter <strong>30</strong> and <strong>5</strong>.</td>
</tr>
<tr>
<td>Daily</td>
<td>Enter the <strong>Start Time</strong> and <strong>Interval</strong>.</td>
</tr>
<tr>
<td></td>
<td>For example, to run the task at 2:30 pm every four days, enter <strong>2:30</strong> and <strong>4</strong>.</td>
</tr>
<tr>
<td>Weekly</td>
<td>1 Enter the <strong>Interval</strong> and <strong>Start Time</strong>.</td>
</tr>
<tr>
<td></td>
<td>2 Select each day on which to run the task.</td>
</tr>
<tr>
<td></td>
<td>For example, to run the task at 6 am every Tuesday and Thursday, enter <strong>1</strong> and <strong>6 am</strong>, and select <strong>Tuesday</strong> and <strong>Thursday</strong>.</td>
</tr>
<tr>
<td>Monthly</td>
<td>1 Enter the <strong>Start Time</strong>.</td>
</tr>
<tr>
<td></td>
<td>2 Specify the days by using one of the following methods.</td>
</tr>
<tr>
<td></td>
<td>Enter a specific date of the month.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>first, second, third, fourth, or last</strong>, and select the day of the week.</td>
</tr>
<tr>
<td></td>
<td><strong>last</strong> runs the task on the last week in the month that the day occurs. For example, if you select the last Monday of the month and the month ends on a Sunday, the task runs six days before the end of the month.</td>
</tr>
<tr>
<td></td>
<td>3 In <strong>Interval</strong>, enter the number of months between each task run.</td>
</tr>
</tbody>
</table>

8 Click **Next**.

9 Set up email notifications and click **Next**.

10 Click **Finish**.

The vCenter Server system adds the task to the list in the **Scheduled Tasks** window.

### Canceling Scheduled Tasks

Canceling a task stops a running task from occurring, regardless of whether the task was a real-time task or a scheduled task. The operation cancels only the running task. If the task being canceled is a scheduled task, subsequent runs are not canceled.

Tasks that aren’t running can be cleared when they are in a queued or scheduled state. In such cases, because the cancel operation is not available, either remove the task or reschedule it to run at a different time. Removing a scheduled task requires that you recreate it to run it in the future, rescheduling does not.

You can cancel the following tasks:

- Connecting to a host
- Cloning a virtual machine
- Deploying a virtual machine
- Migrating a powered off virtual machine. This task is cancelable only when the source disks have not been deleted.
If your vSphere uses virtual services, you can also cancel the following scheduled tasks:

- Change the power state of a virtual machine
- Make a snapshot of a virtual machine

**Change or Reschedule a Task**

After a scheduled task is created, you can change the timing, frequency, and specifics of the task. You can edit and reschedule tasks before or after they run.

Required privilege: **Schedule Task.Modify Task**

**Procedure**

1. In the vSphere Client navigation bar, click **Home > Management > Scheduled Tasks**.
2. Select the task.
3. In the toolbar, click **Properties**.
4. Change task attributes as necessary.
5. Click **Next** to advance through the wizard.
6. Click **Finish**.

**Remove a Scheduled Task**

Removing a scheduled task removes all future occurrences of the task. The history associated with all completed occurrences of the task remains in the vCenter Server database.

**Prerequisites**

To remove scheduled tasks, the vSphere Client must be connected to the vCenter Server system.

Required privilege: **Scheduled Task.Remove Task**

**Procedure**

1. In the vSphere Client navigation bar, click **Home > Management > Scheduled Tasks**.
2. Select the task.
3. Select **Inventory > Scheduled Task > Remove**.
4. Click **OK**.

The task is removed from the list of scheduled tasks.

**Policy Rules for Task Operations**

The vCenter Server and ESXi hosts adhere to certain rules when managing tasks in the system.

vCenter Server and ESXi hosts use the following rules to process tasks:

- The user performing the task in the vSphere Client must have the correct permissions on the relevant objects. After a scheduled task is created, it will be performed even if the user no longer has permission to perform the task.
- When the operations required by manual tasks and scheduled tasks conflict, the activity due first is started first.
- When a virtual machine or host is in an incorrect state to perform any activity, manual or scheduled, vCenter Server or the ESXi host does not perform the task. A message is recorded in the log.
- When an object is removed from the vCenter Server or the ESXi host, all associated tasks are also removed.
The vSphere Client and vCenter Server system use UTC time to determine the start time of a scheduled task. This ensures vSphere Client users in different time zones see the task scheduled to run at their local time.

Events are logged in the event log at start and completion of a task. Any errors that occur during a task are also recorded in the event log.

**CAUTION** Do not schedule multiple tasks to be performed at the same time on the same object. The results are unpredictable.

### Managing Events

An event is an action that occurs on an object in vSphere Server or on a host.

Events include user actions and system actions that occur on managed objects in the vSphere Client inventory. For example, events are created when a user logs in to a virtual machine and when a host connection is lost.

Each event records an event message. An event message is a predefined description of an event. Event messages contain information such as the user who generated the event, the time the event occurred, and the type of event message (information, error, or warning). Event messages are archived in vCenter Server.

Typically, event details include the name of the object on which the event occurred and describes the action that occurred. The object of the event is a link to the object’s individual event page.

**NOTE** When actions occur on a folder, for example, when an alarm is created on a folder, the related event (in this case the AlarmCreatedEvent) is visible only in the parent datacenter.

### Viewing Events

You can view events associated with a single object or with all objects in the vSphere Client inventory.

The events listed for a selected object include events associated with the child objects. Detailed information about a selected event appears in the Event Details panel below the event list.

**NOTE** When the vSphere Client is connected directly to a host, the Tasks & Events tab is labeled Events.

### View Events Associated with One Object

The events listed for a selected object include events associated with its child objects.

Required privilege: **Read-only**

**Procedure**

1. Select the inventory object and click the Tasks & Events tab.
2. Click Events.
   
   A list of events appears.
3. (Optional) Select an event in the list to see the Event Details, including a list of related events and errors in the error stack.
   
   Error messages that display in the Error Stack are shown by default.
4. (Optional) Click the icon next to Description to view further details and possible causes of the event.
   
   You can print or save the event details.
View Events

You can view events associated with a single object or view all vSphere events. The events list for a selected inventory object includes events associated with child objects.

Prerequisites

You must have a vSphere Web Client or a vSphere Client connected to a vCenter Server.

Required privilege: Read-only

Procedure

◆ Perform the actions that correspond with the client interface you are using.

<table>
<thead>
<tr>
<th>In this interface...</th>
<th>Do this...</th>
</tr>
</thead>
</table>
| vSphere Client       | - To see a list of all events in the system, select Home > Management > Events.  
|                      | - To see a list of events associated with a selected inventory object and its child objects, select the Tasks & Events tab and click Events. |
| vSphere Web Client   | - To see a list of all events in the system, select Monitor > Event Console from the Console Launcher.  
|                      | - To see a list of events associated with a selected inventory object and its child objects, perform the following actions:  
|                      |   1 Open the vCenter Management console.  
|                      |   2 Select an inventory object.  
|                      |   3 Select the Monitor tab.  
|                      |   4 Click Events. |
| Both clients         | - Select an event to see event details.  
|                      | - Use the filter controls above the list to filter the list.  
|                      | - Click a column heading to sort the list. |

Filter the Events List

By default, the events list for an object includes events performed on its child objects. You can remove all child events associated with a host or a datastore and display only the events performed on the object itself.

Procedure

1 Display the host or datacenter in the inventory.
2 Select the host or datacenter and click the Tasks & Events tab.
3 Click Events to display the events list.
4 If the Show all entries list and search field are not visible under the Tasks and Events buttons, select View > Filtering.
5 Click Show all entries and select Show host entries or Show datacenter entries, depending on the object selected.

Use Keywords to Filter the Events List

You can display events based on any attribute, including event name, target, type, user, change history, and time. Filtering is inclusive, not exclusive. If the keyword is found in any of the selected columns, the event is included in the list.

Prerequisites

Required privilege: Read-only.
**Procedure**

1. Select the object on which to filter the events.
   - To filter events associated with one object, select the object in the inventory, click the **Events** tab, and click **Events**.
   - To filter events associated with all objects, in the navigation bar, click **Home > Management > Events**.

2. If the **Name, Target or Status contains** search field is not visible, select **View > Filtering**.
   - The search field appears.

3. Click the search field arrow and select the attributes to include in the search.
4. Type a keyword in the field and press Enter.
   - The events that match the search are retrieved and displayed in the events list.

**Trigger and Alarm on an Event**

You might find it useful to have an alarm notify you, or to have an action take place, when a particular event occurs. vSphere provides a set of preconfigured alarms. You can create new, custom alarms and modify the settings of existing ones.

**Procedure**

1. In the inventory, select the object on which to create the alarm.
   - For example, to create an alarm for all hosts in a cluster, display the cluster. To create an alarm for a single host, display the host.

2. Select **File > New > Alarm**.

3. Complete the information on the **General** tab.
   - Enter an alarm name and description.
   - In **Alarm Type**, select the object to monitor and select **Monitor for specific events occurring on this object**.

4. Click the **Triggers** tab and set up the alarm triggers.

5. Click to the **Actions** tab and set up the alarm actions.
   - The vCenter Server verifies the configuration of the alarm and adds the alarm to the list of alarms for the selected object.

For help on configuring the values on each tab, click **Help**.

**Export Events Data**

You can export all or part of the events data stored in the vCenter Server database.

**Prerequisites**

You must have a vSphere Web Client or a vSphere Client connected to a vCenter Server.

Required Privilege: **Read-only**
Procedure

» Perform the actions that correspond with the client interface you are using.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>vSphere Client</strong></td>
<td>a Select File &gt; Export &gt; Export Events.</td>
</tr>
<tr>
<td></td>
<td>b (Linked-mode only) In the vCenter Server list, select the server where</td>
</tr>
<tr>
<td></td>
<td>the events occurred.</td>
</tr>
<tr>
<td></td>
<td>c Specify Events, Time, and Limits attributes for the events you want to</td>
</tr>
<tr>
<td></td>
<td>export.</td>
</tr>
<tr>
<td></td>
<td>d Specify a file name and location.</td>
</tr>
<tr>
<td></td>
<td>e Click OK.</td>
</tr>
<tr>
<td><strong>vSphere Web Client</strong></td>
<td>a Switch console views to the Event Console view and click Export.</td>
</tr>
<tr>
<td></td>
<td>b Specify Events, Time, and Limits attributes for the events you want to</td>
</tr>
<tr>
<td></td>
<td>export.</td>
</tr>
<tr>
<td></td>
<td>c Click Proceed.</td>
</tr>
<tr>
<td></td>
<td>d Click Export.</td>
</tr>
<tr>
<td></td>
<td>e Specify a file name and location.</td>
</tr>
<tr>
<td></td>
<td>f Click OK.</td>
</tr>
</tbody>
</table>

vCenter Server creates the file in the specified location. The file contains the Type, Time, and Description of the events.

Report Errors to VMware

Some errors that appear for tasks, events, and in error dialogs can be submitted to VMware for further investigation. In some cases, more information or links to knowledge base articles are provided.

Perform this task in the vSphere Client, within an error dialog, Task Details, or Event Details

Procedure

1  Click **Submit error report** to send the error report.
   The Submit Error Report window displays details about the specific error.
2  (Optional) Click the printer icon to print the error log report.
3  (Optional) Click the disk icon to save the error log report.
   The error log report can be saved as an HTML file. If you are working offline, this allows you to use the HTML file to submit the error report to VMware at a later time.
4  Click **Submit**.
   The data is sent to VMware for analysis. Additionally, the data is compared to entries in the VMware Knowledge Base and, if matches are found, the relevant articles are displayed.
Starting and Stopping the vSphere Components

You can start and stop each one of the major vSphere components, ESXi, and vCenter Server. You might want to stop a component to perform maintenance or upgrade operations.

This chapter includes the following topics:

- “Start an ESXi Host,” on page 105
- “Reboot or Shut Down an ESXi Host,” on page 105
- “Starting vCenter Server,” on page 106

Start an ESXi Host

When you install ESXi, it starts itself through the installation reboot process. If your ESXi host is shut down, you must manually restart it.

Procedure

- On the physical box where ESXi is installed, press the power button until the power on sequence begins.

The ESXi host starts, locates its virtual machines, and proceeds with its normal ESXi functions.

Reboot or Shut Down an ESXi Host

You can power off or restart (reboot) any ESXi host using the vSphere Client. Powering off a managed host disconnects it from vCenter Server, but does not remove it from the inventory.

Procedure

1. Shut down all virtual machines running on the ESXi host.
2. Select the ESXi host you want to shut down.
3. From the main or right-click menu, select Reboot or Shut Down.
   - If you select Reboot, the ESXi host shuts down and reboots.
   - If you select Shut Down, the ESXi host shuts down. You must manually power the system back on.
4. Provide a reason for the shut down.
   This information is added to the log.
Starting vCenter Server

vCenter Server runs as a Windows service. vCenter Server starts when you start the Windows machine on which it is installed. It also restarts when that machine is rebooted.

Verify That vCenter Server Is Running

You can verify that the vCenter Server service is running.

Procedure

1. Go to the Services console for your version of Windows.
   
   For example, select Control Panel > Administrative Tools > Services and click VMware VirtualCenter Server.
   
   The Status column indicates whether the service started.

2. Right-click the vCenter Server service and select Properties.

3. In the VMware vCenter Server Services Properties dialog box, click the General tab and view the service status.

Restart the vCenter Server System

The vCenter Server service starts when the machine on which it is installed is booted. You can manually restart the vCenter Server system.

Procedure

1. Go to the Services console for your version of Windows.
   
   For example, select Control Panel > Administrative Tools > Services and click VMware vCenter Server.

2. Right-click VMware vCenter Server, select Start, and wait for startup to complete.

3. Close the Properties dialog box.

Stop the vCenter Server System

vCenter Server is a Windows service. You can use the Windows interface to select the service and stop it.

You should not have to stop the vCenter Server service. The vCenter Server should operate without interruption. Continuous operation ensures that all monitoring and task activities are performed as expected.

Procedure

1. Go to the Services console for your version of Windows.
   
   For example, select Start > Control Panel > Administrative Tools > Services.

2. Click VMware vCenter Server Service.

3. Right-click VMware vCenter Server, select Stop, and wait for it to stop.

4. Close the Properties dialog box.
To access the full capabilities of your hosts and to simplify the management of multiple hosts, you should connect your hosts to a vCenter Server system.

For information on configuration management of ESXi hosts, see the *vSphere Networking* documentation, the *vSphere Storage* documentation, or the *vSphere Security* documentation.

The views and capabilities displayed vary depending on whether the vSphere Client is connected to a vCenter Server system or an ESXi host. Unless indicated, the process, task, or description applies to all kinds of vSphere Client connections.

See “Add Hosts,” on page 58 for information and instructions about adding hosts to vCenter Server.

This chapter includes the following topics:

- “Disconnecting and Reconnecting a Host,” on page 107
- “Remove a Host from a Cluster,” on page 108
- “Understanding Managed Host Removal,” on page 109
- “Remove a Managed Host from vCenter Server,” on page 110

### Disconnecting and Reconnecting a Host

You can disconnect and reconnect a host that is being managed by vCenter Server. Disconnecting a managed host does not remove it from vCenter Server; it temporarily suspends all monitoring activities performed by vCenter Server.

The managed host and its associated virtual machines remain in the vCenter Server inventory. By contrast, removing a managed host from vCenter Server removes the managed host and all its associated virtual machines from the vCenter Server inventory.

### Disconnect a Managed Host

Use the vSphere Client to disconnect a managed host from vCenter Server.

**Procedure**

1. From the vSphere Client connected to a vCenter Serversystem, display the inventory and click the managed host to disconnect.
2. Right-click the host and select **Disconnect** from the pop-up menu.
3. In the confirmation dialog box that appears, click **Yes**.

   If the managed host is disconnected, the word “disconnected” is appended to the object name in parentheses, and the object is dimmed. All associated virtual machines are similarly dimmed and labeled.
Reconnect a Managed Host

Use the vSphere Client to reconnect a managed host to a vCenter Server system.

Procedure
1. From the vSphere Client connected to a vCenter Server system, display the inventory and click the managed host to reconnect.
2. Right-click the host and select Connect from the pop-up menu.

When the managed host’s connection status to vCenter Server is changed, the statuses of the virtual machines on that managed host are updated to reflect the change.

Reconnecting Hosts After Changes to the vCenter Server SSL Certificate

vCenter Server uses an SSL certificate to encrypt and decrypt host passwords stored in the vCenter Server database. If the certificate is replaced or changed, vCenter Server cannot decrypt host passwords, and therefore cannot connect to managed hosts.

If vCenter Server fails to decrypt a host password, the host is disconnected from vCenter Server. You must reconnect the host and supply the login credentials, which will be encrypted and stored in the database using the new certificate.

Remove a Host from a Cluster

When a host is removed from a cluster, the resources it provides are deducted from the total cluster resources. The virtual machines deployed on the host are either migrated to other hosts within the cluster, or remain with the host and are removed from the cluster, depending on the state of the virtual machines when the host is removed from the cluster.

You can remove hosts from a cluster by selecting them in the inventory and dragging them to a new location within the inventory. The new location can be a folder as a standalone host or another cluster.

Prerequisites

Before you can remove a host from a cluster, you must power off all virtual machines that are running on the host, or migrate the virtual machines to a new host using vMotion.

Procedure
1. From the vSphere Client connected to a vCenter Server system, display the inventory.
2. Right-click the appropriate managed host icon in the inventory panel, and select Enter Maintenance Mode from the pop-up menu.

   If all virtual machines on the host are not powered off, the host will not enter maintenance mode.

   If the host is inside a DRS-enabled cluster, entering maintenance mode causes DRS to attempt to automatically evacuate powered-on virtual machines from the host using vMotion.
3. In the confirmation dialog that appears, click Yes.

   The confirmation dialog also asks if you want to automatically evacuate virtual machines that are not powered on from the host. This is useful if you want those virtual machines to remain registered to a host within the cluster.

   The host icon changes and the term “maintenance mode” is added to the name in parentheses.
4. Select the host icon in the inventory panel, and drag it to the new location.

The host can be moved to another cluster or another datacenter. When the new location is selected, a blue box surrounds the cluster or datacenter name.

vCenter Server moves the host to the new location.

5. Right-click the host, and select **Exit Maintenance Mode** from the pop-up menu.

6. (Optional) Restart any virtual machines, as needed.

**Understanding Managed Host Removal**

Removing a managed host from vCenter Server breaks the connection and stops all monitoring and managing functions of that managed host and of all the virtual machines on that managed host. The managed host and its associated virtual machines are removed from the inventory.

Historical data for removed hosts remains in the vCenter Server database.

Removing a managed host differs from disconnecting the managed host from vCenter Server. Disconnecting a managed host does not remove it from vCenter Server; it temporarily suspends all vCenter Server monitoring activities. The managed host and its associated virtual machines remain in the vCenter Server inventory.

Removing a managed host from vCenter Server does not remove the virtual machines from the managed host or datastore. It removes only vCenter Server’s access to the managed host and virtual machines on that managed host.

Figure 11-1 illustrates the process for removing a managed host from vCenter Server. In the example here, notice the lost link between vCenter Server and the removed managed host, while the managed host files remain on the datastore.

**Figure 11-1. Removing a Host**

1. Registered host and virtual machines

2. Remove host. Virtual machines stay on the host’s datastore.
Remove a Managed Host from vCenter Server

Remove a managed host from vCenter Server to stop all vCenter Server monitoring and management of that host.

If possible, remove managed hosts while they are connected. Removing a disconnected managed host does not remove the vCenter Server agent from the managed host.

**Prerequisites**

Make sure NFS mounts are active. If NFS mounts are unresponsive, the operation fails.

**Procedure**

1. From the vSphere Client connected to a vCenter Server system, display the inventory.
2. (Optional) If the host is part of a cluster, you must put it in maintenance mode.
   a. Right-click the managed host in the inventory and select **Enter Maintenance Mode** from the pop-up menu.
   b. On the confirmation dialog, click **Yes**.
      
      The host icon changes and the term “maintenance mode” is added to the name in parentheses.
3. Right-click the appropriate host in the inventory panel, and select **Remove** from the pop-up menu.
4. In the confirmation dialog that appears, click **Yes** to remove the managed host.

vCenter Server removes the managed host and associated virtual machines from the vCenter Server environment. vCenter Server then returns the status of all associated processor and migration licenses to available.
Migrating Virtual Machines

Migration is the process of moving a virtual machine from one host or storage location to another. Copying a virtual machine creates a new virtual machine. It is not a form of migration.

In vCenter Server, you have the following migration options:

**Cold Migration**
Moving a powered-off virtual machine to a new host. Optionally, you can relocate configuration and disk files to new storage locations. You can use cold migration to move virtual machines from one datacenter to another.

**Migrating a Suspended Virtual Machine**
Moving a suspended virtual machine to a new host. Optionally, you can relocate configuration and disk files to new storage location. You can migrate suspended virtual machines from one datacenter to another.

**Migration with vMotion**
Moving a powered-on virtual machine to a new host. Migration with vMotion allows you to move a virtual machine to a new host without any interruption in the availability of the virtual machine. You cannot use vMotion to move virtual machines from one datacenter to another. Some configurations include Metro vMotion, a feature that enables reliable migrations between hosts separated by high network round-trip latency times. Metro vMotion is automatically enabled when the appropriate license is installed. No user configuration is necessary.

**Migration with Storage vMotion**
Moving the virtual disks or configuration file of a powered-on virtual machine to a new datastore. Migration with Storage vMotion allows you to move a virtual machine’s storage without any interruption in the availability of the virtual machine.

Both migration of a suspended virtual machine and migration with vMotion are sometimes referred to as “hot migration”, because they allow migration of a virtual machine without powering it off. Migration with vMotion is sometimes referred to as “live migration”.

You can move virtual machines manually or set up a scheduled task to perform the cold migration.

Cloning a virtual machine or copying its disks and configuration file creates a new virtual machine. Cloning is not a form of migration.

This chapter includes the following topics:

- “Cold Migration,” on page 112
- “Migrating a Suspended Virtual Machine,” on page 112
- “Migration with vMotion,” on page 113
- “Migration with Storage vMotion,” on page 116
- “CPU Compatibility and EVC,” on page 117
Cold Migration

Cold migration is the migration of a powered-off virtual machine. With cold migration, you have the option of moving the associated disks from one datastore to another. The virtual machines are not required to be on shared storage.

The virtual machine you want to migrate must be powered off prior to beginning the cold migration process.

If a virtual machine is configured to have a 64-bit guest operating system, vCenter Server generates a warning if you try to migrate it to a host that does not support 64-bit operating systems. Otherwise, CPU compatibility checks do not apply when you migrate a virtual machine with cold migration.

A cold migration consists of the following tasks:

1. If the option to move to a different datastore was chosen, the configuration files, including the NVRAM file (BIOS settings), and log files are moved from the source host to the destination host’s associated storage area. If you chose to move the virtual machine’s disks, these are also moved.

2. The virtual machine is registered with the new host.

3. After the migration is completed, the old version of the virtual machine is deleted from the source host if the option to move to a different datastore was chosen.

Migrating a Suspended Virtual Machine

When migrating a suspended virtual machine, you also have the option of moving the associated disks from one datastore to another. The virtual machines are not required to be on shared storage.

When you migrate a suspended virtual machine, the new host for the virtual machine must meet CPU compatibility requirements, because the virtual machine must be able to resume executing instructions on the new host.

Migration of a suspended virtual machine consists of the following steps:

1. The configuration files, including the NVRAM file (BIOS settings), log files, and the suspend file as well as the disks of the virtual machine are moved from the source host to the destination host’s associated storage area.

2. The virtual machine is registered with the new host.

3. After the migration is completed, the old version of the virtual machine is deleted from the source host.
Migration with vMotion

Migration with vMotion™ allows virtual machine working processes to continue throughout a migration.

The entire state of the virtual machine, as well as its configuration file, if necessary, is moved to the new host, while the associated virtual disk remains in the same location on storage that is shared between the two hosts. After the virtual machine state is migrated to the alternate host, the virtual machine runs on the new host.

The state information includes the current memory content and all the information that defines and identifies the virtual machine. The memory content includes transaction data and whatever bits of the operating system and applications are in the memory. The defining and identification information stored in the state includes all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses for the Ethernet cards, chip set states, registers, and so forth.

When you migrate a virtual machine with vMotion, the new host for the virtual machine must meet compatibility requirements in order for the migration to proceed.

Migration with vMotion happens in three stages:

1. When the migration with vMotion is requested, vCenter Server verifies that the existing virtual machine is in a stable state with its current host.
2. The virtual machine state information (memory, registers, and network connections) is copied to the target host.
3. The virtual machine resumes its activities on the new host.

If any error occurs during migration, the virtual machines revert to their original states and locations.

Migration of a suspended virtual machine and migration with vMotion can be referred to as hot migration, because they allow migration of a virtual machine without powering it off.

Host Configuration for vMotion

In order to successfully use vMotion, you must first configure your hosts correctly.

Ensure that you have correctly configured your hosts in each of the following areas:

- Each host must be correctly licensed for vMotion.
- Each host must meet shared storage requirements for vMotion.
- Each host must meet the networking requirements for vMotion.

**IMPORTANT** The ESXi firewall in ESXi 5.0 does not allow per-network filtering of vMotion traffic. Therefore, you must install rules on your external firewall to ensure that no incoming connections can be made to the vMotion socket.

**vMotion Shared Storage Requirements**

Configure hosts for vMotion with shared storage to ensure that virtual machines are accessible to both source and target hosts.

During a migration with vMotion, the migrating virtual machine must be on storage accessible to both the source and target hosts. Ensure that the hosts configured for vMotion use shared storage. Shared storage is typically on a storage area network (SAN), but can also be implemented using iSCSI and NAS shared storage. See the VMware SAN Configuration Guide for additional information on SAN and the vSphere Storage for information on other shared storage.
vMotion Networking Requirements

Migration with vMotion requires correctly configured network interfaces on source and target hosts.

vMotion requires a Gigabit Ethernet (GigE) network between all vMotion-enabled hosts. Each host enabled for vMotion must have a minimum of two Ethernet adapters, at least one of which must be a GigE adapter.

Recommended networking best practices are as follows:

- Use one dedicated GigE adapter for vMotion.
- If only two Ethernet adapters are available:
  - For best security, dedicate the GigE adapter to vMotion, and use VLANs to divide the virtual machine and management traffic on the other adapter.
  - For best availability, combine both adapters into a bond, and use VLANs to divide traffic into networks: one or more for virtual machine traffic and one for vMotion.

Configure the virtual networks on vMotion-enabled hosts as follows:

- On each host, configure a VMkernel port group for vMotion.
- Ensure that virtual machines have access to the same subnets on source and destination hosts.
- If you are using standard switches for networking, ensure that the network labels used for virtual machine port groups are consistent across hosts. During a migration with vMotion, vCenter Server assigns virtual machines to port groups based on matching network labels.

**Note** You cannot migrate virtual machines that are attached to a virtual intranet with vMotion, even if the destination host has a virtual intranet configured with the same network label.

- If you are using vSphere Distributed Switches for networking, ensure that source and destination hosts are members of all vSphere Distributed Switches that virtual machines use for networking.
- Use of Jumbo Frames is recommended for best vMotion performance.

Virtual Machine Configuration Requirements for vMotion

A number of specific virtual machine configurations can prevent migration of a virtual machine with vMotion.

The following virtual machine configurations can prevent migration with vMotion:

- You cannot use migration with vMotion to migrate virtual machines using raw disks for clustering purposes.
- You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by a device that is not accessible on the destination host. (For example, you cannot migrate a virtual machine with a CD drive backed by the physical CD drive on the source host.) Disconnect these devices before migrating the virtual machine.

Virtual machines with USB passthrough devices can be migrated with vMotion as long as the devices are enabled for vMotion.

- You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by a device on the client computer. Disconnect these devices before migrating the virtual machine.
Swapfile Location Compatibility

Virtual machine swapfile location affects vMotion compatibility in different ways depending on the version of ESXi running on the virtual machine’s host.

Virtual machines on hosts running ESX Server 3.0.x have a virtual machine swap file located with the virtual machine configuration file. Virtual machines on these hosts can be migrated with vMotion only if the destination host can access the VMFS volume where the swap file is located.

You can configure ESX 3.5 or ESXi 3.5 or later hosts to store virtual machine swapfiles in one of two locations: with the virtual machine configuration file, or on a local swapfile datastore specified for that host. You can also set individual virtual machines to have a different swapfile location from the default set for their current host.

The location of the virtual machine swapfile affects vMotion compatibility as follows:

- Migrations between hosts running ESX/ESXi version 3.5 and later: Migrations with vMotion and migrations of suspended and powered-off virtual machines are allowed.
  
  During a migration with vMotion, if the swapfile location specified on the destination host differs from the swapfile location specified on the source host, the swapfile is copied to the new location. This can result in slower migrations with vMotion. If the destination host cannot access the specified swapfile location, it stores the swapfile with the virtual machine configuration file.

- Migrations between a host running ESX/ESXi version 3.5 and later and a host running an earlier version of ESX: Migrations of suspended and powered-off virtual machines are allowed. If the virtual machine is configured to use a local swapfile datastore, attempting to migrate it to a host that does not support this configuration produces a warning, but the migration can proceed. When the virtual machine is powered on again, the swapfile is located with the virtual machine configuration file.

Migrations with vMotion are not allowed unless the destination swapfile location is the same as the source swapfile location. In practice, this means that virtual machine swapfiles must be located with the virtual machine configuration file.

See the vSphere Client online Help for more information on configuring swapfile policies.

Migrating Virtual Machines with Snapshots

Migration of virtual machines with snapshots is possible if the virtual machine resides on shared storage accessible to source and destination hosts.

Migrating a virtual machine with snapshots is permitted, regardless of the virtual machine power state, as long as the virtual machine is being migrated to a new host without moving its configuration file or disks. (The virtual machine must reside on shared storage accessible to both hosts.)

If the migration involves moving the configuration file or virtual disks, the following additional restrictions apply:

- The starting and destination hosts must be running ESX 3.5 or ESXi 3.5 or later.
- All of the virtual machine files and disks must reside in a single directory, and the migrate operation must move all the virtual machine files and disks to a single destination directory.

Reverting to a snapshot after migration with vMotion might cause the virtual machine to fail, because the migration wizard cannot verify the compatibility of the virtual machine state in the snapshot with the destination host. Failure occurs only if the configuration in the snapshot uses devices or virtual disks that are not accessible on the current host, or if the snapshot contains an active virtual machine state that was running on hardware that is incompatible with the current host CPU.
Migration with Storage vMotion

Using Storage vMotion, you can migrate a virtual machine and its disk files from one datastore to another while the virtual machine is running.

You can choose to place the virtual machine and all its disks in a single location, or select separate locations for the virtual machine configuration file and each virtual disk. The virtual machine does not change execution host during a migration with Storage vMotion.

During a migration with Storage vMotion, you can transform virtual disks from thick-provisioned to thin-provisioned or from thin-provisioned to thick-provisioned.

Storage vMotion has a number of uses in administering virtual infrastructure, including the following examples of use:

- Upgrading datastores without virtual machine downtime. You can migrate running virtual machines from a VMFS2 datastore to a VMFS3 datastore, and upgrade the VMFS2 datastore using a two step process. You can then use Storage vMotion to migrate virtual machines back to the original datastore without any virtual machine downtime. For information on upgrading VmFS2 to VmFS5, see the vSphere Storage documentation.

- Storage maintenance and reconfiguration. You can use Storage vMotion to move virtual machines off of a storage device to allow maintenance or reconfiguration of the storage device without virtual machine downtime.

- Redistributing storage load. You can use Storage vMotion to manually redistribute virtual machines or virtual disks to different storage volumes to balance capacity or improve performance.

Storage vMotion Requirements and Limitations

A virtual machine and its host must meet resource and configuration requirements for the virtual machine disks to be migrated with Storage vMotion.

Storage vMotion is subject to the following requirements and limitations:

- Virtual machine disks must be in persistent mode or be raw device mappings (RDMs). For virtual compatibility mode RDMs, you can migrate the mapping file or convert to thick-provisioned or thin-provisioned disks during migration as long as the destination is not an NFS datastore. If you convert the mapping file, a new virtual disk is created and the contents of the mapped LUN are copied to this disk. For physical compatibility mode RDMs, you can migrate the mapping file only.

- Migration of virtual machines during VMware Tools installation is not supported.

- The host on which the virtual machine is running must have a license that includes Storage vMotion.

- ESX/ESXi 3.5 hosts must be licensed and configured for vMotion. ESX/ESXi 4.0 and later hosts do not require vMotion configuration in order to perform migration with Storage vMotion.

- The host on which the virtual machine is running must have access to both the source and target datastores.

- For limits on the number of simultaneous migrations with vMotion and Storage vMotion, see “Limits on Simultaneous Migrations,” on page 134.
CPU Compatibility and EVC

vCenter Server performs a number of compatibility checks before allowing migration of running or suspended virtual machines to ensure that the virtual machine is compatible with the target host.

vMotion transfers the running state of a virtual machine between underlying ESXi systems. Successful live migration requires that the processors of the target host be able to provide the same instructions to the virtual machine after migration that the processors of the source host provided before migration. Clock speed, cache size, and number of cores can differ between source and target processors, but the processors must come from the same vendor class (AMD or Intel) to be vMotion compatible.

Migrations of suspended virtual machines also require that the virtual machine be able to resume execution on the target host using equivalent instructions.

When you initiate a migration with vMotion or a migration of a suspended virtual machine, the Migrate Virtual Machine wizard checks the destination host for compatibility and produces an error message if there are compatibility problems that will prevent migration.

The CPU instruction set available to the operating system and applications running in a virtual machine is determined at the time that a virtual machine is powered on. This CPU “feature set” is determined based on the following items:

- Host CPU family and model
- Settings in the BIOS that might disable CPU features
- The ESX/ESXi version running on the host
- The virtual machine’s virtual hardware version
- The virtual machine’s guest operating system

To improve CPU compatibility between hosts of varying CPU feature sets, some host CPU features can be “hidden” from the virtual machine by placing the host in an Enhanced vMotion Compatibility (EVC) cluster.

**Note**  Host CPU features can also be hidden from a virtual machine by applying a custom CPU compatibility mask to the virtual machine, but this is not recommended. VMware, in partnership with CPU and hardware vendors, is working to maintain vMotion compatibility across the widest range of processors. For additional information, search the VMware Knowledge Base for the vMotion and CPU Compatibility FAQ.

CPU Compatibility Scenarios

vCenter Server’s CPU compatibility checks compare the CPU features available on the source host, the subset of features that the virtual machine can access, and the features available on the target host. Without the use of EVC, any mismatch between two hosts’ user-level features will block migration, whether or not the virtual machine itself has access to those features. A mismatch between two hosts’ kernel-level features, however, blocks migration only when the virtual machine has access to a feature that the target host does not provide.

User-level features are non-privileged instructions that might be used by virtual machine applications. These include SSE3, SSSE3, SSE4.1, SSE4.2, and AES. Because they are user-level instructions that bypass the virtualization layer, these instructions could cause application instability if mismatched after a migration with vMotion.

Kernel-level features are privileged instructions that might be used by the virtual machine operating system. These include the AMD No eXecute (NX) and the Intel eXecute Disable (XD) security features.

When you attempt to migrate a virtual machine with vMotion, one of the following scenarios applies:

- The destination host feature set matches the virtual machine’s CPU feature set. CPU compatibility requirements are met, and migration with vMotion proceeds.
The virtual machine’s CPU feature set contains features not supported by the destination host. CPU compatibility requirements are not met, and migration with vMotion cannot proceed.

**Note** EVC overcomes such incompatibility by providing a "baseline" feature set for all virtual machines running in a cluster and that hides the differences among the clustered hosts’ CPUs from the virtual machines.

The destination host supports the virtual machine’s feature set, plus additional user-level features (such as SSE4.1) not found in the virtual machine’s feature set. CPU compatibility requirements are not met, and migration with vMotion cannot proceed.

**Note** This type of incompatibility is ignored for migrations among hosts in EVC clusters.

The destination host supports the virtual machine’s feature set, plus additional kernel-level features (such as NX or XD) not found in the virtual machine’s feature set. CPU compatibility requirements are met, and migration with vMotion proceeds. The virtual machine retains its CPU feature set as long as it remains powered on, allowing it to migrate freely back to the original host. However, if the virtual machine is rebooted, it acquires a new feature set from the new host, which might cause vMotion incompatibility if you attempt to migrate the virtual machine back to the original host.

**CPU Families and Feature Sets**

Processors are grouped into families. Processors within a given family generally have similar feature sets.

Processor families are defined by the processor vendors. You can distinguish different processor versions within the same family by comparing the processors’ model, stepping level, and extended features. In some cases, processor vendors have introduced significant architectural changes within the same processor family, such as the SSSE3 and SSE4.1 instructions, and NX/XD CPU security features.

By default, vCenter Server identifies mismatches on features accessible to applications as incompatible to guarantee the stability of virtual machines after migrations with vMotion.

Server hardware’s CPU specifications will usually indicate whether or not the CPUs contain the features that affect vMotion compatibility.

For more information on identifying Intel processors and their features, see Application Note 485: Intel® Processor Identification and the CPUID Instruction, available from Intel. For more information on identifying AMD processors and their features, see CPUID Specification, available from AMD.

**About Enhanced vMotion Compatibility**

You can use the Enhanced vMotion Compatibility (EVC) feature to help ensure vMotion compatibility for the hosts in a cluster. EVC ensures that all hosts in a cluster present the same CPU feature set to virtual machines, even if the actual CPUs on the hosts differ. Using EVC prevents migrations with vMotion from failing because of incompatible CPUs.

Configure EVC from the cluster settings dialog box. When you configure EVC, you configure all host processors in the cluster to present the feature set of a baseline processor. This baseline feature set is called the EVC mode. EVC leverages AMD-V Extended Migration technology (for AMD hosts) and Intel FlexMigration technology (for Intel hosts) to mask processor features so that hosts can present the feature set of an earlier generation of processors. The EVC mode must be equivalent to, or a subset of, the feature set of the host with the smallest feature set in the cluster.

EVC masks only those processor features that affect vMotion compatibility. Enabling EVC does not prevent a virtual machine from taking advantage of faster processor speeds, increased numbers of CPU cores, or hardware virtualization support that might be available on newer hosts.
EVC cannot prevent virtual machines from accessing hidden CPU features in all circumstances. Applications that do not follow CPU vendor recommended methods of feature detection might behave unexpectedly in an EVC environment. VMware EVC cannot be supported with ill-behaved applications that do not follow the CPU vendor recommendations. For more information about creating well-behaved applications, search the VMware Knowledge Base for the article Detecting and Using New Features in CPUs.

**EVC Requirements**

Hosts in an EVC cluster must meet certain requirements.

To enable EVC on a cluster, the cluster must meet the following requirements:

- All virtual machines in the cluster that are running on hosts with a feature set greater than the EVC mode you intend to enable must be powered off or migrated out of the cluster before EVC is enabled.
- All hosts in the cluster must have CPUs from a single vendor, either AMD or Intel.
- All hosts in the cluster must be running ESX/ESXi 3.5 Update 2 or later.
- All hosts in the cluster must be connected to the vCenter Server system.
- All hosts in the cluster must have advanced CPU features, such as hardware virtualization support (AMD-V or Intel VT) and AMD No eXecute (NX) or Intel eXecute Disable (XD), enabled in the BIOS if they are available.
- All hosts in the cluster must have supported CPUs for the EVC mode you want to enable. *Table 12-1* lists the processor families supported for each EVC mode. To check EVC support for a specific processor or server model, see the *VMware Compatibility Guide* at http://www.vmware.com/resources/compatibility/search.php.

Any host added to an existing EVC-enabled cluster must also meet the requirements

**Note** Hardware vendors sometimes disable particular CPU features in the BIOS by default. This can cause problems in enabling EVC, because the EVC compatibility checks detect the absence of features that are expected to be present for a particular CPU. If you cannot enable EVC on a system with a compatible processor, ensure that all features are enabled in the BIOS.

*Table 12-1* lists the processors supported in EVC Clusters.

**Table 12-1. Processors Supported in EVC Clusters**

<table>
<thead>
<tr>
<th>Vendor</th>
<th>EVC Mode</th>
<th>Processors Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMD</td>
<td>AMD Opteron Generation 1 (“Rev. E”)</td>
<td>AMD Opteron Generation 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AMD Opteron Generation 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AMD Opteron Generation 3</td>
</tr>
<tr>
<td></td>
<td>AMD Opteron Generation 2 (“Rev. F”)</td>
<td>AMD Opteron Generation 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AMD Opteron Generation 3</td>
</tr>
<tr>
<td></td>
<td>AMD Opteron Generation 3 (“Greyhound”)</td>
<td>AMD Opteron Generation 3</td>
</tr>
<tr>
<td></td>
<td>AMD Opteron Generation 3 (No 3DNow!) (“Greyhound” without 3DNow! support)</td>
<td>AMD Opteron Generation 3</td>
</tr>
<tr>
<td>Intel</td>
<td>Intel® “Merom” Generation (Xeon® Core™2)</td>
<td>Intel Xeon Core 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon 45nm Core 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon Core i7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel Xeon 32nm Core i7</td>
</tr>
<tr>
<td>Vendor</td>
<td>EVC Mode</td>
<td>Processors Supported</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Intel® “Penryn” Generation (Xeon® 45nm Core™2)</td>
<td>Intel Xeon 45nm Core 2</td>
<td></td>
</tr>
<tr>
<td>Intel® “Penryn” Generation (Xeon® 45nm Core™2)</td>
<td>Intel Xeon Core i7</td>
<td></td>
</tr>
<tr>
<td>Intel® “Penryn” Generation (Xeon® 45nm Core™2)</td>
<td>Intel Xeon 32nm Core i7</td>
<td></td>
</tr>
<tr>
<td>Intel® “Nehalem” Generation (Xeon® Core™ i7)</td>
<td>Intel Xeon Core i7</td>
<td></td>
</tr>
<tr>
<td>Intel® “Nehalem” Generation (Xeon® Core™ i7)</td>
<td>Intel Xeon 32nm Core i7</td>
<td></td>
</tr>
<tr>
<td>Intel® “Westmere” Generation (Xeon® 32nm Core™ i7)</td>
<td>Intel Xeon 32nm Core i7</td>
<td></td>
</tr>
<tr>
<td>Intel® “Sandy Bridge” Generation</td>
<td>Intel E3-1200 series</td>
<td></td>
</tr>
<tr>
<td>Intel® “Sandy Bridge” Generation</td>
<td>Intel E5-1600 series</td>
<td></td>
</tr>
<tr>
<td>Intel® “Sandy Bridge” Generation</td>
<td>Intel E5-2400 series</td>
<td></td>
</tr>
<tr>
<td>Intel® “Sandy Bridge” Generation</td>
<td>Intel E5-2600 series</td>
<td></td>
</tr>
<tr>
<td>Intel® “Sandy Bridge” Generation</td>
<td>Intel E5-4600 series</td>
<td></td>
</tr>
</tbody>
</table>

Create an EVC Cluster

Create an EVC cluster to help ensure vMotion compatibility between the hosts in the cluster.

When you create an EVC cluster, use one of the following methods:

- Create an empty cluster, enable EVC, and move hosts into the cluster.
- Enable EVC on an existing cluster.

VMware recommends creating an empty EVC cluster as the simplest way of creating an EVC cluster with minimal disruption to your existing infrastructure.

Prerequisites

Before you create an EVC cluster, ensure that the hosts you intend to add to the cluster meet the requirements listed in “EVC Requirements,” on page 119.

Procedure

1. Create an empty cluster, and enable EVC.
   
   Select the CPU vendor and EVC mode appropriate for the hosts you intend to add to the cluster. For information on configuring EVC, see the vSphere Client online Help.

   Other cluster features such as vSphere DRS and vSphere HA are fully compatible with EVC. You can enable these features when you create the cluster. For information on specific cluster options, see the vSphere Client online Help.

2. Select a host to move into the cluster.

3. If the host feature set is greater than the EVC mode that you have enabled for the EVC cluster, ensure that the cluster has no powered-on virtual machines.
   - Power off all the virtual machines on the host.
   - Migrate the host’s virtual machines to another host using vMotion.
4 Move the host into the cluster. You can power on the virtual machines on the host, or migrate virtual machines into the cluster with vMotion, if the virtual machines meet CPU compatibility requirements for the cluster’s EVC mode. Virtual machines running on hosts with more features than the EVC mode must be powered off before migration into the cluster.

5 Repeat Step 3 and Step 4 for each additional host that you want to move into the cluster.

Enable EVC on an Existing Cluster

Enable EVC on an existing cluster to help ensure vMotion compatibility between the hosts in the cluster.

Prerequisites

Before you enable EVC on an existing cluster, ensure that the hosts in the cluster meet the requirements listed in “EVC Requirements,” on page 119.

Procedure

1 Select the cluster for which you want to enable EVC.

2 If virtual machines are running on hosts that have feature sets greater than the EVC mode you intend to enable, ensure that the cluster has no powered-on virtual machines.

   ■ Power off all the virtual machines on the hosts with feature sets greater than the EVC mode
   ■ Migrate the cluster’s virtual machines to another host using vMotion.

   Because these virtual machines are running with more features than the EVC mode you intend to set, power off the virtual machines to migrate them back into the cluster after enabling EVC.

3 Ensure that the cluster contains hosts with CPUs from only one vendor, either Intel or AMD.

4 Edit the cluster settings and enable EVC.

   Select the CPU vendor and feature set appropriate for the hosts in the cluster.

5 If you powered off or migrated virtual machines out of the cluster, power on the virtual machines in the cluster, or migrate virtual machines into the cluster.

   Any virtual machines running with a larger feature set than the EVC mode you enabled for the cluster must be powered off before they can be moved back into the cluster.

Change the EVC Mode for a Cluster

If all the hosts in a cluster are compatible with the new mode, you can change the EVC mode of an existing EVC cluster. You can raise the EVC mode to expose more CPU features, or lower the EVC mode to hide CPU features and increase compatibility.

To raise the EVC mode from a CPU baseline with fewer features to one with more features, you do not need to turn off any running virtual machines in the cluster. Virtual machines that are running do not have access to the new features available in the new EVC mode until they are powered off and powered back on. A full power cycling is required. Rebooting the guest operating system or suspending and resuming the virtual machine is not sufficient.

To lower the EVC mode from a CPU baseline with more features to one with fewer features, you must first power off any virtual machines in the cluster that are running at a higher EVC mode than the one you intend to enable, and power them back on after the new mode has been enabled.
Prerequisites

If you intend to lower the EVC mode, power off any currently running virtual machines with a higher EVC mode than the one you intend to enable. See “Determine EVC Modes for Virtual Machines,” on page 122.

The cluster cannot contain a disconnected host. All hosts in the cluster must be connected and registered on the vCenter Server.

Procedure

1. Display the cluster in the inventory.
2. Right-click the cluster and select Edit Settings.
3. In the left panel, select VMware EVC.
   The dialog box displays the current EVC settings.
4. To edit the EVC settings, click Change.
5. From the VMware EVC Mode drop-down menu, select the baseline CPU feature set you want to enable for the cluster.
   If the selected EVC Mode cannot be selected, the Compatibility pane displays the reason or reasons why, along with the relevant hosts for each reason.
6. Click OK to close the EVC Mode dialog box, and click OK to close the cluster settings dialog box.

Determine EVC Modes for Virtual Machines

The EVC mode of a virtual machine defines the CPU features that the virtual machine can access. The virtual machine’s EVC mode is determined when it is powered on in an EVC-enabled cluster.

When a virtual machine is powered on, it determines the EVC mode of the cluster in which it is running. If the EVC mode of the cluster is subsequently raised, the virtual machine does not change its EVC mode until it is powered off and powered on again. This means that the virtual machines does not make use of any additional CPU features exposed by the new EVC mode of the cluster until the virtual machine has been powered off and powered on again.

For example, consider a cluster containing hosts with Intel Xeon 45nm Core™ 2 processors that has been set to the Intel® “Merom” Generation (Xeon® Core™ 2) EVC mode. A virtual machine powered on in this cluster runs in the Intel “Merom” Generation (Xeon Core 2) EVC mode. If the cluster EVC mode is raised to Intel “Penryn” Generation (Xeon 45nm Core 2), the virtual machine remains at the lower Intel “Merom” Generation (Xeon Core 2) EVC mode. To use any of the features exposed by the higher cluster EVC mode, such as SSE4.1, you must power off the virtual machine and power it on again.

You can use the Virtual Machines tab for a cluster or a host to determine the EVC modes of the running virtual machines.

Procedure

1. Select the cluster or host in the inventory.
2. Click the Virtual Machines tab.
3. If the EVC Mode column is not displayed, right-click on the column titles and select EVC Mode.
   The EVC modes of all running or suspended virtual machines are displayed in the EVC Mode column. Powered off virtual machines and virtual machines that are not in EVC clusters show N/A as the EVC mode.
Prepare Clusters for AMD Processors Without 3DNow!

Future generations of AMD processors might not include 3DNow!™ CPU instructions. vCenter Server provides an EVC mode that masks the 3DNow! instructions from virtual machines, allowing you to prepare clusters for the introduction of AMD hosts without 3DNow! instructions.

Processors without the 3DNow! instructions will not be vMotion-compatible with older processors that have the 3DNow! instructions, unless an EVC mode or CPU compatibility mask is used to mask these instructions.

The **AMD Opteron Gen. 3 (no 3DNow!)** EVC mode masks the 3DNow! instructions from virtual machines. You can apply this EVC mode to EVC clusters containing only AMD Opteron Generation 3 hosts to allow these clusters to maintain vMotion compatibility with future AMD Opteron hosts that might not have 3DNow! instructions. Clusters containing AMD Opteron Generation 1 or AMD Opteron Generation 2 hosts cannot be made vMotion-compatible with hosts that do not have 3DNow! instructions.

**Prerequisites**

Ensure that the cluster contains only hosts with AMD Opteron Generation 3 or newer processors.

**Procedure**

◆ Enable the **AMD Opteron Gen. 3 (no 3DNow!)** EVC mode for your EVC cluster.

The steps to enable the EVC mode differ depending on whether you are creating a cluster or enabling the mode on an existing cluster, and on whether the existing cluster contains powered-on virtual machines.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a new cluster</td>
<td>In the New Cluster wizard, enable EVC for AMD hosts and select the <strong>AMD Opteron Gen. 3 (no 3DNow!)</strong> EVC mode.</td>
</tr>
<tr>
<td>Editing a cluster without powered-on</td>
<td>In the Cluster Settings dialog box, edit the <strong>VMware EVC</strong> settings and select the <strong>AMD Opteron Gen. 3 (no 3DNow!)</strong> EVC mode.</td>
</tr>
<tr>
<td>virtual machines</td>
<td>The <strong>AMD Opteron Gen. 3 (no 3DNow!)</strong> EVC mode cannot be enabled while there are powered-on virtual machines in the cluster.</td>
</tr>
<tr>
<td></td>
<td>a Power-off any running virtual machines in the cluster, or migrate them out of the cluster using vMotion.</td>
</tr>
<tr>
<td></td>
<td>b Migrating the virtual machines out of the cluster with vMotion allows you to delay powering off the virtual machines until a more convenient time.</td>
</tr>
<tr>
<td></td>
<td>c If you migrated virtual machines out of the cluster, power them off and cold migrate them back into the cluster.</td>
</tr>
<tr>
<td>Editing a cluster with powered-on</td>
<td>In the Cluster Settings dialog box, edit the <strong>VMware EVC</strong> settings and select the <strong>AMD Opteron Gen. 3 (no 3DNow!)</strong> EVC mode.</td>
</tr>
<tr>
<td>virtual machines</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d Power on the virtual machines.</td>
</tr>
</tbody>
</table>

You can now add hosts with AMD processors without 3DNow! instructions to the cluster and preserve vMotion compatibility between the new hosts and the existing hosts in the cluster.

**CPU Compatibility Masks**

CPU compatibility masks allow per-virtual machine customization of the CPU features visible to a virtual machine.

vCenter Server compares the CPU features available to a virtual machine with the CPU features of the destination host to determine whether to allow or disallow migrations with vMotion.

Default values for the CPU compatibility masks are set by VMware to guarantee the stability of virtual machines after a migration with vMotion.
In some cases, where a choice between CPU compatibility or guest operating system features (such as NX/XD) exists, VMware provides check-box options to configure individual virtual machines through the virtual machine’s Advanced Settings option. For more control over the visibility of CPU features, you can edit the virtual machine’s CPU compatibility mask at the bit level.

⚠️ CAUTION  This is an experimental feature. Manual edit of the CPU compatibility masks without the appropriate documentation and testing might lead to an unsupported configuration.

CPU compatibility masks cannot prevent virtual machines from accessing masked CPU features in all circumstances. In some circumstances, applications can detect and use masked features even though they are hidden from the guest operating system. In addition, on any host, applications that use unsupported methods of detecting CPU features rather than using the CPUID instruction can access masked features. Virtual machines running applications that use unsupported CPU detection methods might experience stability problems after migration.

**About Migration Compatibility Checks**

During migration, the Migrate Virtual Machine wizard checks the destination host for compatibility with the migrating virtual machine using a number of criteria.

When you select a host, the **Compatibility** panel at the bottom of the Migrate Virtual Machine wizard displays information about the compatibility of the selected host or cluster with the virtual machine’s configuration.

If the virtual machine is compatible, the panel displays the message, *Validation succeeded*. If the virtual machine is not compatible with either the host’s or cluster’s configured networks or datastores, the compatibility window can display both warnings and errors:

- Warning messages do not disable migration. Often the migration is justified and you can continue with the migration despite the warnings.

- Errors can disable migration if there are no error-free destination hosts among the selected destination hosts. In this case, the **Next** button is disabled.

For clusters, the network and datastore configurations are taken into account when checking compatibility issues. For hosts, the individual host’s configuration is used. A possible problem might be that vMotion is not enabled on one or both hosts.

A specific host CPU feature’s effects on compatibility are dependent on whether ESXi exposes or hides them from virtual machines.

- Features that are exposed to virtual machines are not compatible when they are mismatched.

- Features that are not exposed to virtual machines are compatible regardless of mismatches.

Specific items of virtual machine hardware can also cause compatibility issues. For example, a virtual machine using an enhanced vmxnet virtual NIC cannot be migrated to a host running a version of ESXi that does not support enhanced vmxnet.

**Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Client**

You can use the Migration wizard to migrate a powered-off virtual machine or suspended virtual machine.

**Procedure**

1. Select the virtual machine that you want to migrate in the inventory.
2. Right-click on the virtual machine and select **Migrate** from the pop-up menu.
3 Select the migration type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change host</td>
<td>Move the virtual machine to another host.</td>
</tr>
<tr>
<td>Change datastore</td>
<td>Move the virtual machine's configuration file and virtual disks.</td>
</tr>
<tr>
<td>Change both host and datastore</td>
<td>Move the virtual machine to another host and move its configuration file and virtual disks. (This option is not available for a powered-on virtual machine.)</td>
</tr>
</tbody>
</table>

4 To move the virtual machine to another host, select the destination host or cluster for this virtual machine migration and click **Next**.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or cluster.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS enabled, select a specific host in the cluster rather than selecting the cluster itself.

5 Select the destination resource pool for the virtual machine migration and click **Next**.

6 If you chose to move the virtual machine’s configuration file and virtual disks, select a disk format.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as Source</td>
<td>Use the format of the original virtual disk.</td>
</tr>
<tr>
<td></td>
<td>If you select this option for an RDM disk in physical compatibility mode, only the mapping file is migrated. If you select this option for an RDM disk in virtual compatibility mode, the RDM is converted to a virtual disk.</td>
</tr>
<tr>
<td>Thin provisioned</td>
<td>Use the thin format to save storage space. The thin virtual disk uses just as much storage space as it needs for its initial operations. When the virtual disk requires more space, it can grow in size up to its maximum allocated capacity. This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a thin virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
<tr>
<td>Thick</td>
<td>Allocate a fixed amount of hard disk space to the virtual disk. The virtual disk in the thick format does not change its size and from the beginning occupies the entire datastore space provisioned to it. This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
</tbody>
</table>

Disks are converted from thin to thick format or thick to thin format only when they are copied from one datastore to another. If you leave a disk in its original location, the disk format is not converted, regardless of the selection made here.
7 Select the datastore location where you want to store the virtual machine files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store all virtual machine files in the same location on a datastore.</td>
<td>a (Optional) Apply a virtual machine storage profile for the virtual machine home files and the virtual disks from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. b Select a datastore and click Next.</td>
</tr>
<tr>
<td>Store all virtual machine files in the same datastore cluster.</td>
<td>a (Optional) Apply a virtual machine storage profile for the virtual machine home files and the virtual disks from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. b Select a datastore cluster. c (Optional) If you do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the datastore cluster. d Click Next.</td>
</tr>
<tr>
<td>Store virtual machine configuration files and disks in separate locations.</td>
<td>a Click Advanced. b For the virtual machine configuration file and for each virtual disk, click Browse and select a datastore or datastore cluster. c (Optional) Apply a virtual machine storage profile from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. d (Optional) If you selected a datastore cluster and do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the datastore cluster. e Click Next.</td>
</tr>
</tbody>
</table>

8 Review the page and click Finish.

vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data displayed on the Summary tab shows the status and state throughout the migration. If errors occur during migration, the virtual machines revert to their original states and locations.

### Migrate a Powered-On Virtual Machine with vMotion in the vSphere Client

You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using Storage vMotion.

#### Prerequisites

Before migrating a virtual machine with vMotion, ensure that your hosts and virtual machines meet the requirements for migration with vMotion.

- “Host Configuration for vMotion,” on page 113
- “Virtual Machine Configuration Requirements for vMotion,” on page 114

#### Procedure

1 Select the virtual machine that you want to migrate in the inventory.
2 Right-click on the virtual machine and select Migrate from the pop-up menu.
3 Select **Change host** and click **Next**.

4 Select a destination host or cluster for the virtual machine.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a non-automated cluster as a target. You are prompted to select a host within the non-automated cluster.

5 Select a resource pool and click **Next**.

6 Select the migration priority level and click **Next**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Priority</strong></td>
<td>On hosts running ESX/ESXi version 4.1 or later, vCenter Server attempts to reserve resources on both the source and destination hosts to be shared among all concurrent migrations with vMotion. vCenter Server grants a larger share of host CPU resources to high priority migrations than to standard priority migrations. Migrations always proceed regardless of the resources that have been reserved. On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts to reserve a fixed amount of resources on both the source and destination hosts for each individual migration. High priority migrations do not proceed if resources are unavailable.</td>
</tr>
<tr>
<td><strong>Standard Priority</strong></td>
<td>On hosts running ESX/ESXi version 4.1 or later, vCenter Server reserves resources on both the source and destination hosts to be shared among all concurrent migration with vMotion. vCenter Server grants a smaller share of host CPU resources to standard priority migrations than to high priority migrations. Migrations always proceed regardless of the resources that have been reserved. On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts to reserve a fixed amount resources on the source and destination hosts for each migration. Standard priority migrations always proceed. However, the migration might proceed more slowly or fail to complete if sufficient resources are not available.</td>
</tr>
</tbody>
</table>

7 Review the page and click **Finish**. A task is created that begins the virtual machine migration process.

**Migrate a Virtual Machine with Storage vMotion in the vSphere Client**

Use migration with Storage vMotion to relocate a virtual machine’s configuration file and virtual disks while the virtual machine is powered on.

You cannot change the virtual machine’s execution host during a migration with Storage vMotion.

**Procedure**

1 Select the virtual machine that you want to migrate in the inventory.

2 Right-click on the virtual machine and select **Migrate** from the pop-up menu.

3 Select **Change datastore** and click **Next**.
4 Select a disk format.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as Source</td>
<td>Use the format of the original virtual disk.</td>
</tr>
<tr>
<td></td>
<td>If you select this option for an RDM disk in physical compatibility mode, only the mapping file is migrated. If you select this option for an RDM disk in virtual compatibility mode, the RDM is converted to a virtual disk.</td>
</tr>
<tr>
<td>Thin provisioned</td>
<td>Use the thin format to save storage space. The thin virtual disk uses just as much storage space as it needs for its initial operations. When the virtual disk requires more space, it can grow in size up to its maximum allocated capacity. This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a thin virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
<tr>
<td>Thick</td>
<td>Allocate a fixed amount of hard disk space to the virtual disk. The virtual disk in the thick format does not change its size and from the beginning occupies the entire datastore space provisioned to it. This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
</tbody>
</table>

5 Select the datastore location where you want to store the virtual machine files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store all virtual machine files in the same location on a datastore.</td>
<td>a (Optional) Apply a virtual machine storage profile for the virtual machine home files and the virtual disks from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. b Select a datastore and click Next.</td>
</tr>
<tr>
<td>Store all virtual machine files in the same datastore cluster.</td>
<td>a (Optional) Apply a virtual machine storage profile for the virtual machine home files and the virtual disks from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. b Select a datastore cluster. c (Optional) If you do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the datastore cluster. d Click Next.</td>
</tr>
<tr>
<td>Store virtual machine configuration files and disks in separate locations.</td>
<td>a Click Advanced. b For the virtual machine configuration file and for each virtual disk, click Browse and select a datastore or datastore cluster. c (Optional) Apply a virtual machine storage profile from the VM Storage Profile drop-down menu. The list of datastores shows which datastores are compatible and which are incompatible with the selected virtual machine storage profile. d (Optional) If you selected a datastore cluster and do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the datastore cluster. e Click Next.</td>
</tr>
</tbody>
</table>

6 Review the page and click Finish.
Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Web Client

You can use the Migration wizard to migrate a powered-off virtual machine or suspended virtual machine.

Procedure

1. Select a virtual machine.
   - In the virtual machines and templates inventory tree, select a group of virtual machines and select a virtual machine from the list on the right.
   - Search for a virtual machine and select it from the search results list.
2. Right-click the virtual machine and select *Inventory > Migrate*.
3. Select the migration type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change host</td>
<td>Move the virtual machine to another host.</td>
</tr>
<tr>
<td>Change datastore</td>
<td>Move the virtual machine's configuration file and virtual disks.</td>
</tr>
<tr>
<td>Change both host and datastore</td>
<td>Move the virtual machine to another host and move its configuration file and virtual disks. (This option is not available for a powered-on virtual machine.)</td>
</tr>
</tbody>
</table>

4. Select the destination resource pool for the virtual machine migration and click *Next*.
5. In the Host Name column, select the destination host or cluster for this virtual machine migration and click *Next*.

- Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or cluster.
- Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS enabled, select a specific host in the cluster rather than selecting the cluster itself.
6. Select the datastore location where you want to store the virtual machine files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store all virtual machine files in the same location on a datastore.</td>
<td>Select a datastore and click <em>Next</em>.</td>
</tr>
<tr>
<td>Store all virtual machine files in the same Storage DRS cluster.</td>
<td>a Select a Storage DRS cluster.</td>
</tr>
<tr>
<td></td>
<td>b (Optional) If you do not want to use Storage DRS with this virtual machine, select <em>Disable Storage DRS for this virtual machine</em> and select a datastore within the Storage DRS cluster.</td>
</tr>
<tr>
<td></td>
<td>c Click <em>Next</em>.</td>
</tr>
<tr>
<td>Store virtual machine configuration files and disks in separate locations.</td>
<td>a Click <em>Advanced</em>.</td>
</tr>
<tr>
<td></td>
<td>b For the virtual machine configuration file and for each virtual disk, click the datastore name, select <em>Browse</em>, and select a datastore or Storage DRS cluster.</td>
</tr>
<tr>
<td></td>
<td>c (Optional) If you selected a Storage DRS cluster and do not want to use Storage DRS with this virtual machine, select <em>Disable Storage DRS for this virtual machine</em> and select a datastore within the Storage DRS cluster.</td>
</tr>
<tr>
<td></td>
<td>d Click <em>Next</em>.</td>
</tr>
</tbody>
</table>
If you chose to move the virtual machine’s configuration file and virtual disks, select a disk format.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same as Source</td>
<td>Use the format of the original virtual disk.</td>
</tr>
<tr>
<td></td>
<td>If you select this option for an RDM disk in physical compatibility mode, only the mapping file is migrated. If you select this option for an RDM disk in virtual compatibility mode, the RDM is converted to a virtual disk.</td>
</tr>
<tr>
<td>Thin provisioned</td>
<td>Use the thin format to save storage space. The thin virtual disk uses just as much storage space as it needs for its initial operations. When the virtual disk requires more space, it can grow in size up to its maximum allocated capacity.</td>
</tr>
<tr>
<td></td>
<td>This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a thin virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
<tr>
<td>Thick</td>
<td>Allocate a fixed amount of hard disk space to the virtual disk. The virtual disk in the thick format does not change its size and from the beginning occupies the entire datastore space provisioned to it.</td>
</tr>
<tr>
<td></td>
<td>This option is not available for RDMs in physical compatibility mode. If you select this option for a virtual compatibility mode RDM, the RDM is converted to a virtual disk. RDMs converted to virtual disks cannot be converted back to RDMs.</td>
</tr>
</tbody>
</table>

Disks are converted from thin to thick format or thick to thin format only when they are copied from one datastore to another. If you leave a disk in its original location, the disk format is not converted, regardless of the selection made here.

Review the information on the Review Selections page and click Finish.

vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data displayed on the Summary tab shows the status and state throughout the migration. If errors occur during migration, the virtual machines revert to their original states and locations.

Migrate a Powered-On Virtual Machine with vMotion in the vSphere Web Client

You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using Storage vMotion.

Prerequisites

Before migrating a virtual machine with vMotion, ensure that your hosts and virtual machines meet the requirements for migration with vMotion.

- “Host Configuration for vMotion,” on page 113
- “Virtual Machine Configuration Requirements for vMotion,” on page 114

Procedure

1. Select a virtual machine.
   - In the virtual machines and templates inventory tree, select a group of virtual machines and select a virtual machine from the list on the right.
   - Search for a virtual machine and select it from the search results list.
2. Right-click the virtual machine and select Inventory > Migrate.
3. Select Change host and click Next.
4. Select the destination resource pool for the virtual machine migration and click Next.
5 Select a destination host or cluster for the virtual machine.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a non-automated cluster as a target. You are prompted to select a host within the non-automated cluster.

6 Select the migration priority level and click Next.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserve CPU for optimal VMotion performance</td>
<td>vCenter Server attempts to reserve resources on both the source and destination hosts to be shared among all concurrent migrations with VMotion. vCenter Server grants a larger share of host CPU resources. If sufficient CPU resources are not immediately available, VMotion is not initiated.</td>
</tr>
<tr>
<td>Perform with available CPU resources</td>
<td>vCenter Server reserves resources on both the source and destination hosts to be shared among all concurrent migration with VMotion. vCenter Server grants a smaller share of host CPU resources. If there is a lack of CPU resources, the duration of VMotion can be extended.</td>
</tr>
</tbody>
</table>

7 Review the page and click Finish.

**Migrate a Virtual Machine with Storage VMotion in the vSphere Web Client**

Use migration with Storage VMotion to relocate a virtual machine’s configuration file and virtual disks while the virtual machine is powered on.

You cannot change the virtual machine’s execution host during a migration with Storage VMotion.

**Procedure**

1 Select a virtual machine.
   - In the virtual machines and templates inventory tree, select a group of virtual machines and select a virtual machine from the list on the right.
   - Search for a virtual machine and select it from the search results list.
2 Right-click the virtual machine and select Inventory > Migrate.
3 Select Change datastore and click Next.
4. Select the datastore location where you want to store the virtual machine files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store all virtual machine files in the same location on a datastore.</td>
<td>Select a datastore and click Next.</td>
</tr>
</tbody>
</table>
| Store all virtual machine files in the same Storage DRS cluster. | a Select a Storage DRS cluster.  
  b (Optional) If you do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the Storage DRS cluster.  
  c Click Next. |
| Store virtual machine configuration files and disks in separate locations. | a Click Advanced.  
  b For the virtual machine configuration file and for each virtual disk, click the datastore name, select Browse, and select a datastore or Storage DRS cluster.  
  c (Optional) If you selected a Storage DRS cluster and do not want to use Storage DRS with this virtual machine, select Disable Storage DRS for this virtual machine and select a datastore within the Storage DRS cluster.  
  d Click Next. |

5. Review the page and click Finish.

Storage vMotion Command-Line Syntax

In addition to using the Migration wizard, you can initiate migrations with Storage vMotion from the vSphere Command-Line Interface (vSphere CLI) using the svmotion command.

For more information about installing and using the vSphere CLI, see vSphere Command-Line Interface Installation and Scripting Guide and vSphere Command-Line Interface Reference.

You can run the svmotion command in either interactive or noninteractive mode.

- To use the command in interactive mode, type svmotion --interactive. You are prompted for all the information necessary to complete the storage migration. When the command is invoked in interactive mode, all other parameters given are ignored.
- In noninteractive mode, the svmotion command uses the following syntax:

  svmotion [Standard CLI options] --datacenter=datacenter_name --vm 'VM_config_datastore_path:new_datastore' [--disks 'virtual_disk_datastore_path:new_datastore, virtual_disk_datastore_path:new_datastore']

Square brackets indicate optional elements.

On Windows systems, use double quotes instead of single quotes around the values specified for the --vm and --disks options.

For more information on the standard CLI options, see the vSphere Command-Line Interface Installation and Scripting Guide and vSphere Command-Line Interface Reference.

Table 12-2 describes the parameters for the svmotion command.

<table>
<thead>
<tr>
<th>Table 12-2. svmotion Command Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>datacenter</td>
</tr>
<tr>
<td>VM_config_datastore path</td>
</tr>
</tbody>
</table>
### Table 12-2. `svmotion` Command Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>new_datastore</code></td>
<td>The name of the new datastore to which the virtual machine configuration file or disk is to be moved. Do not include brackets around the name of the new datastore.</td>
</tr>
<tr>
<td><code>--disks</code></td>
<td>If you do not specify this parameter, all virtual disks associated with a virtual machine are relocated to the same datastore as the virtual machine configuration file. By specifying this parameter, you can choose to locate individual virtual disks to different datastores. To keep a virtual disk on its current datastore, use the <code>--disk</code> option for that disk with its current datastore as the <code>new_datastore</code>.</td>
</tr>
<tr>
<td><code>virtual_disk_datastore_path</code></td>
<td>The datastore path to the virtual disk file.</td>
</tr>
</tbody>
</table>

### Determine the Path to a Virtual Machine Configuration File

The path to the virtual machine configuration file is a necessary argument to the `svmotion` command.

You must specify the datastore path to the virtual machine’s configuration file in the `VM_config_datastore_path` `svmotion` command.

**Procedure**

1. In the vSphere Client inventory, select the virtual machine and click the Summary tab.
2. Click Edit Settings to display the Virtual Machine Properties dialog box.
3. Click the Options tab, and select General Options.

The path to the virtual machine configuration file appears in the Virtual Machine Configuration File text box.

### Determine the Path to a Virtual Disk File

You must specify the virtual disk datastore path as part of the `svmotion` command.

**Procedure**

1. In the vSphere Client inventory, select the virtual machine to which the virtual disk belongs, and click the Summary tab.
2. Click Edit Settings to display the Virtual Machine Properties dialog box.
3. Click the Hardware tab, and select the virtual disk from the list of devices.

The path to the virtual disk file appears in the Disk File text box.

### Storage vMotion Examples

The examples show how to use the Storage vMotion command-line interface to relocate a virtual machine and all its disks, or to relocate the virtual machine configuration file while leaving the disks in place.

The examples in this section are formatted on multiple lines for readability. The command should be issued on a single line.
An example of relocating all of a virtual machine’s disks to a datastore named `new_datastore`:

```bash
svmotion --url=https://myvc.mycorp.com/sdk
    --username=me
    --password=secret
    --datacenter=DC1
    --vm='[old_datastore] myvm/myvm.vmx: new_datastore'
```

An example of relocating a virtual machine to `new_datastore`, while leaving the disks, `myvm_1.vmdk` and `myvm_2.vmdk` on `old_datastore`:

```bash
svmotion --datacenter='My DC'
    --vm='[old_datastore] myvm/myvm.vmx: new_datastore'
    --disks='[old_datastore] myvm/myvm_1.vmdk: old_datastore,'
    '[old_datastore] myvm/myvm_2.vmdk: old_datastore'
```

## Limits on Simultaneous Migrations

vCenter Server places limits on the number of simultaneous virtual machine migration and provisioning operations that can occur on each host, network, and datastore.

**Note** Simultaneous migrations with vMotion can only occur if the virtual machine is moving between hosts in the same cluster and is not changing its resource pool.

Each operation, such as a migration with vMotion or cloning a virtual machine, is assigned a resource cost. Each type of resource, such as host, datastore, or network, has a maximum cost that it can support at any one time. Any new migration or provisioning operation that would cause a resource to exceed its maximum cost does not proceed immediately, but is queued until other operations complete and release resources. Each of the network, datastore, and host limits must be satisfied in order for the operation to proceed.

### Network Limits

Network limits apply to migrations with vMotion only. Network limits depend on both the version of ESXi and the network type.

**Table 12-3** lists network limits for migration with vMotion.

**Table 12-3. Network Limits for Migration with vMotion**

<table>
<thead>
<tr>
<th>Operation</th>
<th>ESX/ESXi Version</th>
<th>Network Type</th>
<th>Maximum Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>vMotion</td>
<td>3.x</td>
<td>1GigE and 10GigE</td>
<td>2</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.0</td>
<td>1GigE and 10GigE</td>
<td>2</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.1, 5.0</td>
<td>1GigE</td>
<td>4</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.1, 5.0</td>
<td>10GigE</td>
<td>8</td>
</tr>
</tbody>
</table>

All migrations with vMotion have a network resource cost of 1.

### Datastore Limits

Datastore limits apply to migrations with vMotion and with Storage vMotion. A migration with vMotion involves one access to the datastore. A migration with storage vMotion involves one access to the source datastore and one access to the destination datastore.
Table 12-4 lists datastore limits for migration with vMotion and Storage vMotion. Table 12-5 lists the datastore resource costs for migration with vMotion and Storage vMotion.

**Table 12-4. Datastore Limits for Migration with vMotion and Storage vMotion**

<table>
<thead>
<tr>
<th>Operation</th>
<th>ESX/ESXi Version</th>
<th>Maximum Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>vMotion/Stor age vMotion</td>
<td>3.x</td>
<td>8</td>
</tr>
<tr>
<td>vMotion/Stor age vMotion</td>
<td>4.0</td>
<td>8</td>
</tr>
<tr>
<td>vMotion/Stor age vMotion</td>
<td>4.1, 5.0</td>
<td>128</td>
</tr>
</tbody>
</table>

**Table 12-5. Datastore Resource Costs for vMotion and Storage vMotion**

<table>
<thead>
<tr>
<th>Operation</th>
<th>ESX/ESXi Version</th>
<th>Datastore Resource Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>vMotion</td>
<td>3.x</td>
<td>1</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.0</td>
<td>1</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.1</td>
<td>1</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>3.x</td>
<td>1</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>4.0</td>
<td>1</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>4.1, 5.0</td>
<td>16</td>
</tr>
</tbody>
</table>

**Host Limits**

Host limits apply to migrations with vMotion, Storage vMotion, and other provisioning operations such as cloning, deployment, and cold migration.

Table 12-6 lists the host limits for migrations with vMotion, migrations with Storage vMotion, and provisioning operations. Table 12-7 lists the host resource cost for these operations.

**Table 12-6. Host Limits for vMotion, Storage vMotion, and Provisioning Operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>ESX/ESXi Version</th>
<th>Maximum Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>vMotion</td>
<td>3.x, 4.0, 4.1, 5.0</td>
<td>2, 2, 8, 8, respectively</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>3.x, 4.0, 4.1, 5.0</td>
<td>2</td>
</tr>
<tr>
<td>other provisioning operations</td>
<td>3.x, 4.0, 4.1, 5.0</td>
<td>8</td>
</tr>
</tbody>
</table>

**Table 12-7. Host Resource Costs for vMotion, Storage vMotion, and Provisioning Operations**

<table>
<thead>
<tr>
<th>Operation</th>
<th>ESX/ESXi Version</th>
<th>Host Resource Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>vMotion</td>
<td>3.x</td>
<td>4</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.0</td>
<td>4</td>
</tr>
<tr>
<td>vMotion</td>
<td>4.1, 5.0</td>
<td>1</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>3.x</td>
<td>4</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>4.0</td>
<td>4</td>
</tr>
<tr>
<td>Storage vMotion</td>
<td>4.1, 5.0</td>
<td>4</td>
</tr>
<tr>
<td>other provisioning operations</td>
<td>3.x, 4.0, 4.1, 5.0</td>
<td>1</td>
</tr>
</tbody>
</table>
A vCenter map is a visual representation of your vCenter Server topology. Maps show the relationships between the virtual and physical resources available to vCenter Server.

Maps are available only when the vSphere Client is connected to a vCenter Server system.

The maps can help you determine such things as which clusters or hosts are most densely populated, which networks are most critical, and which storage devices are being utilized. vCenter Server provides the following map views.

- **Virtual Machine Resources**: Displays virtual machine-centric relationships.
- **Host Resources**: Displays host-centric relationships.
- **Datastore Resources**: Displays datastore-centric relationships.
- **vMotion Resources**: Displays hosts available for vMotion migration.

You can use a map view to limit or expand the scope of a map. You can customize all map views, except vMotion Resources maps. If you are accessing map views using the navigation bar, all vCenter Server resources are available for display. If you are using the Maps tab of a selected inventory item, only items related to that item are displayed. For virtual machine inventory items, the vMotion Resources view is the only map view available on the Maps tab.

You can customize a map view by selecting or deselecting objects in the inventory pane or by selecting or deselecting options in the Map Relationships area.

You can reposition the map by dragging it (click and hold anywhere on the map and drag the map to the new location). A grey box in the overview area represents the section of the total map that is viewable and moves as you drag the map. You can resize the grey box to zoom in or out of a section of the map.

You can double-click any object in a map to switch to the Map tab for that item (providing a Map tab is available for that type of object).

Right-click on any object in a map to access its context menu.

This chapter includes the following topics:

- “Set the Maximum Number of Map Objects,” on page 138
- “vCenter vMotion Maps,” on page 138
- “vCenter Map Icons and Interface Controls,” on page 138
- “View vCenter Maps,” on page 139
- “Print vCenter Maps,” on page 140
- “Export vCenter Maps,” on page 140
Set the Maximum Number of Map Objects

In large environments, maps can be slow to load and difficult to read. You can set the maximum number of objects maps can display so that maps load more quickly and are easier to read.

**Procedure**

1. In the vSphere Client, select Edit > Client Settings > Maps tab.
2. Enter the maximum number of objects you want maps to display.
3. Click OK.

When a user attempts to view a map that has more objects than the specified limit, the user encounters a message that provides the option to cancel the map or to proceed with displaying it.

vCenter vMotion Maps

vMotion resource maps provide a visual representation of hosts, datastores, and networks associated with the selected virtual machine.

vMotion resource maps also indicate which hosts in the virtual machine’s cluster or datacenter are compatible with the virtual machine and are potential migration targets. For a host to be compatible, it must meet the following criteria.

- Connect to all the same datastores as the virtual machine.
- Connect to all the same networks as the virtual machine.
- Have compatible software with the virtual machine.
- Have a compatible CPU with the virtual machine.

**NOTE** The vMotion map provides information as to whether vMotion might be possible, and if not, what an administrator might do to remedy the situation. It does not guarantee that a particular vMotion migration will be successful.

Hosts marked with a red X are unsuitable candidates for migration. A lack of edges connecting that host and the virtual machine’s networks and datastores indicate that the host is unsuitable because of networking or datastore incompatibility. If the unsuitability is because of CPU or software incompatibility, the information appears in a tooltip when the pointer hovers over the host in question.

It might take a few seconds for the map to retrieve load, CPU, and software information. The state of the map’s information retrieval process appears in the lower-left corner of the map. As information arrives, the map is updated. A host that looks like a good vMotion candidate (displayed as green) might become a bad candidate (displayed as red) as information is collected.

vCenter Map Icons and Interface Controls

Resource maps are visual representations of your datacenter topology. Each icon in a resource map represents a managed object or its current state. Controls in the Maps tab enable you to work with the current resource map.

**Map Icons**

The icons in a resource map represent the objects in the inventory and their current state. Table 13-1 describes the map icons.
### Table 13-1. Resource Map Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Host icon" /></td>
<td>Host icon.</td>
</tr>
<tr>
<td><img src="image" alt="Host icon" /></td>
<td>A host that is compatible for vMotion migration. The color of the circle varies in intensity based on the load of the current host. Heavily used hosts are pale; low-load hosts are saturated green.</td>
</tr>
<tr>
<td><img src="image" alt="Host icon" /></td>
<td>A host that is not compatible for vMotion migration.</td>
</tr>
<tr>
<td><img src="image" alt="Virtual machine icon" /></td>
<td>Virtual machine icon. When the virtual machine is powered on, the icon contains a green triangle.</td>
</tr>
<tr>
<td><img src="image" alt="Network icon" /></td>
<td>Network icon.</td>
</tr>
<tr>
<td><img src="image" alt="Datastore icon" /></td>
<td>Datastore icon.</td>
</tr>
</tbody>
</table>

### Map Interface Controls

Use the controls in the Maps tab to customize map relationships, refresh map views, and move the focus of the current map. Table 13-2 describes the controls located on the Maps tab.

<table>
<thead>
<tr>
<th>Map Interface Panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview panel</td>
<td>Thumbnail graphic of the full-scale map.</td>
</tr>
<tr>
<td>Map Relationships panel</td>
<td>Displayed when more than one map view is available. The Map Relationships panel lets you customize map relationships for hosts and virtual machines. Use the checkboxes to enable or disable relationships for the selected object and display them in the current resource map.</td>
</tr>
<tr>
<td>Refresh link</td>
<td>Maps do not auto-refresh. Click Refresh to synchronize your map with the current state of the inventory and to center the map view.</td>
</tr>
<tr>
<td>Inventory panel</td>
<td>When selecting through the Inventory navigation bar, a selected item stays highlighted to indicate map focus. When selecting through the Maps navigation bar, all items in the inventory are listed with a check box. You can select or deselect any inventory items you do not want included in the map.</td>
</tr>
</tbody>
</table>

### View vCenter Maps

Resource maps enable you to view the relationships among hosts, clusters, and virtual machines. You can view a resource map for an entire vCenter Server system or for a specific object, such as a datacenter or cluster. Maps for specific objects show only the object relationships for that object.

**Procedure**

1. Display the object in the inventory.
2 Select the object and click the Maps tab.

For example, to display the resource map for your entire vCenter Server system, select the vCenter Server in the inventory panel. To display the resource map for a host, select the host in the inventory panel.

Print vCenter Maps

You can print resource maps to any standard printer.

Perform this procedure on the vSphere Client Map tab.

Procedure

1 Select File > Print Maps > Print.
2 In the printer Name list, select the printer.
3 Click Print.

Export vCenter Maps

Exporting a resource map saves the map to an image file.

Perform this procedure on the vSphere Client Map tab.

Procedure

1 If necessary, view the resource map.
2 Select File > Export > Export Maps.
3 Navigate to the location to save the file.
4 Type a name for the file and select a file format.
5 Click Export.
Index

Numerics
3DNow!, EVC modes 123

A
abbreviations 7
Active Directory
configuring settings 38
server 38
Active Directory Application Mode 51
active sessions, send messages 31
ADAM 51
adding
distributed port groups 65
license keys 76, 77
adding hosts 58
admin contact info 64
advanced search 26
advanced settings, vCenter Server 42
alarms
triggering on events 103
viewing 24
annotations 27
Asset 68
Assign license 69
assigning license keys 78

B
baselines, security 18
binding on host, distributed port groups 66

C
Cisco Discovery Protocol 64
clusters
creating 59
EVC 120, 121
removing hosts 108
requirements for enabling EVC 119
shared storage 113
cold migration 111, 112
Collection Intervals 35
combining license keys 74
community string 39
components
ESXi 13
host agent 13
managed 15
vCenter Server 13
vCenter Server agent 13
vCenter Server database 13
vSphere 13
config reset at disconnect, distributed port
groups 66
configuration files, virtual machines 133
configure vCenter Server, using license server 81
consoles, virtual machines 25
core dumps 93
CPU capacity 69
CPU compatibility
EVC 118
for vMotion 117
masks 123
CPU families 118
CPU features
kernel level 117
user-level 117
virtual machines 122
creating
clusters 59
datastores 61
folders 61
resource pools 60
creating datacenter-wide networks 63
creating datacenters 58
creating host-wide networks 62
custom attributes
adding 28
editing 28

D
database
configuring number of connections 41
impact of statistics on 37
limiting size 41
retention policy 41
vCenter Server 13
databases, preparing 51
datacenters
creating 58
creating datacenter-wide networks 63
topology maps 137
datastores
about 15
creating 61
relocate virtual machine files 116
determining which features are licensed 80
diagnostic bundles, generating 90
diagnostic data
creating report 90
export 90
exporting 90
Directory Services 54
disconnecting from vCenter Server 22
distributed port groups
adding 65
binding on host 66
cfg config reset at disconnect 66
description 65
diagnostic data
creating report 90
export 90
exporting 90
domains, changing for vCenter Server 54
downgrading license keys 74
downloading, diagnostic bundles 90
downloading license keys 74
port group type 65
port name format 66
distributed switch
adding a host to 64
admin contact info 64
Cisco Discovery Protocol 64
IP address 64
maximum MTU 64
maximum number of ports 64
dividing license keys 74
domain, changing for vCenter Server 54
downgrading license keys 74
downloading, diagnostic bundles 90

E
early binding port groups 65
Email messages 38
Enhanced vMotion Compatibility, See EVC
error logs, VMkernel 93
error reports, reporting problems to VMware 104
ESXi
about 13
rebooting 105
shutdown 105
syslog service 91
ESXi Dump Collector, Linux 48
ESXi hosts, start 105
ESXi services
start 46
stop 46
EVC
configuring 121
creating a cluster 120
enabling on a cluster 121
requirements 119
supported processors 119
EVC modes
virtual machines 122
without 3DNow! 123
events
about 101
configuring retention policy 41
exporting 103
filtering for hosts and datacenters 102
filtering using keywords 102
viewing 101, 102
export license data 78
Exported license usage report 85
exporting
diagnostic data 90
lists 27
vCenter Server data 30
extensions, troubleshooting 30

F
Feature 68
feedback 7
filtering, lists 27
firewall, configure communication 50
folders, creating 61

G
Getting Started tabs
disabling 24
restoring 24
global data 53, 54
Global.licenses permission 74
groups, requirements 51

H
host certificates, verifying 42
hosts
about 15
adding 58
adding to a vSphere distributed switch 64
configuring 33
configuring licensing 79
connecting to vCenter Server 107
custom attributes 27
definition 15
disconnecting 107
disconnecting from vCenter Server 107
ESXi 105
managing 107
reconnecting 108
removing from cluster 108
removing from vCenter Server 109, 110
requirements 119
supported processors 119
EVC modes
virtual machines 122
without 3DNow! 123
events
about 101
configuring retention policy 41
exporting 103
filtering for hosts and datacenters 102
filtering using keywords 102
viewing 101, 102
export license data 78
Exported license usage report 85
exporting
diagnostic data 90
lists 27
vCenter Server data 30
extensions, troubleshooting 30

F
Feature 68
feedback 7
filtering, lists 27
firewall, configure communication 50
folders, creating 61

G
Getting Started tabs
disabling 24
restoring 24
global data 53, 54
Global.licenses permission 74
groups, requirements 51

H
host certificates, verifying 42
hosts
about 15
adding 58
adding to a vSphere distributed switch 64
configuring 33
configuring licensing 79
connecting to vCenter Server 107
custom attributes 27
definition 15
disconnecting 107
disconnecting from vCenter Server 107
ESXi 105
managing 107
reconnecting 108
removing from cluster 108
removing from vCenter Server 109, 110
hypervisor 11

information panels 24
installing plug-ins 29
VirtualCenter Server 51
interfaces 19
inventory organize 57
searching 25
selecting objects 28
topology maps 137
inventory panels 24
IP address, vCenter Server 37

kernel-level CPU features 117

late binding port groups 65
LDAP 53
License capacity 68, 81, 83, 84
License compliance 71
License details 84
license inventory 73
license key, applying 79
License key 68, 69, 73, 84
License key details 84
license keys assigning 79
change history 74
combining 74
dividing 74
License management 75, 79
license portal 74
license report, export data 78
License reporting 81, 85
License Server 73
license settings, configuring 34
License usage 81–84
License usage for a product 82
License usage snapshot 85
License usage threshold 86
License use 68
licensed features 80
licenses, viewing 76
licensing adding license keys 76, 77
assigning 78
per-processor 78
vCenter Server 34
Licensing details 82, 83
Licensing ESXi 69
Licensing reporting 81
limiting users or groups 38
limits migration operations 134
provisioning operations 134
Storage vMotion 134
vMotion 134
Linked Mode affect on license inventory 73
and databases 51, 52
and permissions 51, 52
groups 51
reachability 55
requirements 51
roles 54
Linux-based VMware vCenter Server Appliance 43
lists exporting 27
filtering 27
live port moving, distributed port groups 66
load balancing 17
log detail, setting the log level 40
log files collecting 92, 93
ESXi 93
export 90
external 90
turning off compression 93
logging in, vSphere Client 20
logging in to vCenter Server 21
Logging options, configuring 40
logging out, vSphere Client 20
logs collecting 93
ESXi 90
vSphere Client 90
Long operations 40
Mail Sender settings, configuring 38
managed components 15
maps 137
maximum MTU 64
maximum number of ports 64
migrating powered-off virtual machines 124, 129
powered-on virtual machines 126, 130
suspended virtual machines 124, 129
virtual machine disks 127, 131
virtual machines 111
virtual machines with Storage vMotion 127, 131
  with vMotion 126, 130
  migration about 111
  compatibility checks 124
  limits 134
  of suspended virtual machines 112
  relocate virtual machine files 116
  Storage vMotion 116
  with snapshots 115
  with vMotion 113
  modules, See plug-ins

N
  networks, requirements for vMotion 114
  NFS, VMware vCenter Server Appliance 49
  Normal operations 40

O
  objects, selecting 28
  override settings, distributed port groups 66

P
  panels 24
  per-processor licensing 78
  permissions
    Global.licenses 74
    Read-only 74
    search 25
  physical topology
    computing servers 12
    desktop clients 12
    IP networks 12
  storage networks and arrays 12
  vCenter Server 12
  plug-ins
    disabling 29
    downloading 29
    enabling 29
    installing 29
    managing 29
    removing 29
    troubleshooting 30
    viewing installed 29
  port name format, distributed port groups 66
  ports, vSphere distributed switch 63
  power management 17
  printing, vSphere Client window 30
  Product 68
  Product edition 68

Q
  query limit 38

R
  raw device mappings, migrating 116
  RDMs, See raw device mappings
  Read-only permission 74
  receiver URL 39
  reconnecting hosts 108
  registering, vCenter Server 20
  removing, plug-ins 29
  reporting errors 104
  resource maps
    exporting 140
    icons 138
    interface controls 138
    printing 140
    setting maximum number of map objects 138
    viewing 139
  vMotion resources 138
  resource pools
    configuring 60
    creating 60
    resources
      definition 15
      management 17
    restart, vCenter Server 106
    roles, in linked mode groups 54
    Runtime Settings, configuring 37

S
  scheduled tasks
    about 97
    about canceling 99
    canceling 97
    creating 98
    process rules 100
    removing 100
    rules 100
  SDK 55
  searching
    advanced search 26
    inventory objects 25, 26
    simple search 25
  searching inventory, permissions 25
  security, baselines 18
  services
    syslogd 91
  vCenter Server 55
  sessions
    viewing 30
    vSphere Client, terminating 30
  set host to evaluation mode 80
  settings, vCenter Server 33
  simple search 25
SMTP notification 38
server 38
snapshots, virtual machines, migrate 115
SNMP
community string 39
receiver URL 39
settings 39
traps 39
Solution 68
Solution licensing 72
solutions, licensing 67
SSH 47
SSL certificate 108
SSL settings, configuring 42
starting, vSphere Client 20
statistics, impact on the database 37
Statistics, Collection Intervals 35
statistics intervals
  disabling 36
  enabling 36
Statistics settings, configuring 35
status bar 24
storage, VMware vCenter Server Appliance 49
Storage vMotion
  command-line syntax 132
  examples 133
  limitations 116
  limits 134
  requirements 116
support 7
syslog 91
system log files, downloading 90
system logs
  configuring 92
ESXi 90
VMkernel 93

T
tabs, Getting Started 23
tasks
  about 95
  canceling 97
  configuring retention policy 41
  filtering on hosts and datacenters 96
  filtering with keywords 96
  guidelines 100
  removing scheduled tasks 100
  rescheduling 100
  rules 100
  scheduled, about 97
  scheduling 98
  viewing 24, 95
  viewing all tasks 95
viewing recent tasks 96
viewing scheduled tasks 96
time zones 100
Timeout, interval 40
timeout interval, setting 38
Timeout settings, configuring 40
Tomcat Web server 13
troubleshooting
extensions 30
Linked Mode 55
log files 89, 92
plug-ins 30

U
updated information 9
URLs, configuring 55
user-level CPU features 117
using license server features to manage hosts, about 80

V
validation
  enabling 38
  of users or groups 38
  period 38
vCenter Linked Mode 51
vCenter Server
  about 13
  active sessions, view 30
  advanced settings 42
  agent 13
  changing domain 54
  communication through firewall 50
  configure to use license server 81
  configuring 33
  configuring URLs 55
  custom attributes 27
  database 13
  database connections 41
  disconnecting from 22
  events 101
  ID 37
  IP address 37
  joining a group 53, 54
  licensing 67
  logging in to 21
  name 37
  plug-ins 13, 18
  registering 20
  removing hosts 109
  requirements for joining a group 51
  restarting 106
  start 106
stop 106
verify on Windows 106
vCenter Server license 72
vCenter Server services, monitoring 55
vCenterServer.VimApiUrl 55
vCenterServer.VimWebServicesUrl 55
verbose logging, configuring 92
verifying, host certificates 42
virtual disks
determining path 133
migrating 133
virtual machines
collection files 133
convert 18
CPU compatibility masks 123
custom attributes 27
definition 15
EVC modes 122
migrating 111, 112, 124, 127, 129, 131
migrating with vMotion 113
migration 111
requirements for vMotion 114
security compliance 18
view console 25
virtual disks 133
virtualization 11
VLAN ID 65
VLAN Trunking 65
VMkernel, logs 93
vMotion
3DNow! 123
compatibility checks 117, 124
limits 134
migrating virtual machines with 126, 130
network requirements 114
requirements 113
resource maps 138
storage requirements 113
swapfile considerations 115
virtual machine requirements 114
VMware vCenter Server Appliance
Active Directory 50
Auto Deploy 48
configuration 43
database 44
DNS server 45
dump collector 48
ESXi services 46
hosts 47
instance 44
inventory size 47
IP address 45
log in 44
login configuration 44
NFS 49
NIS 50
password 46
proxy server 45
SSH 47
start vCenter 46
stop vCenter 46
storage 49
syslog 49
virtual machines 47
vpxd, log files 93
vRAM
entitlement 70
extend a pool 72
pool 72
pooling 70
usage 71
vRAM pool 69
vSphere
components 105
components of 13
introduction 11
vSphere Client
about 23
communication through firewall 50
logging in 20
logging out 20
logs 90
panels 24
printing data 30
sessions 30
starting 20
stop 20
vSphere distributed switch
adding a host to 64
admin contact info 64
Cisco Discovery Protocol 64
IP address 64
maximum MTU 64
maximum number of ports 64
vSphere DRS 17
vSphere High Availability (HA) 17
vSphere license 69
vSphere Update Manager 18
VWS 55
W
Web Service settings 39